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PREFACE

About This Guide

This guide is intended to be used by those already familiar with the features covered in the Intelligent Search
Language Tuning Guide, and want to use the Oracle Knowledge Language Workbench to further optimize the
features of Oracle Knowledge Intelligent Search.

In This Guide

The Optimizing Oracle Knowledge Intelligent Search Guide is divided into the following sections:

Chapter 1, Dictionary Manager Describes how to use the advanced features of the

Advanced Features Dictionary Manager. See Chapter 2, Dictionary Manager in
the Intelligent Search Language Tuning Guide for
information how to use the basic features of the Dictionary

Manager.
Chapter 2, Process Wizards Describes how to create Process Wizards that respond to
specific questions with preconfigured dialogs.
Chapter 3, Personalized Describes how to implement the Oracle Knowledge
Navigation Setup Personalized Navigation feature to categorize application

content and display a hierarchy of the results, such as
products and models, services, and prices, in the User
Interface.

Chapter 4, User Manager Describes the Oracle Knowledge User Manager component
accessed from within the Language Workbench that allows
you to create and set permissions for Language Workbench
users.

Appendix A, Configuring Access to Describes the Preference Service that accesses and stores
Business Data business data items obtained from configured data sources.

Examples of Product Screens and Text

The product screens, screen text, and file contents depicted in the documentation are examples. We attempt
to convey the product's appearance and functionality as accurately as possible; however, the actual product
contents and displays may differ from the published examples.
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12 OPERATING SYSTEM VARIATIONS IN EXAMPLES

Operating System Variations in Examples and Procedures

We generally use Linux screen displays and naming conventions in our examples and procedures. We
include other operating system-specific procedures or steps as noted in section headings, or within topics, as
appropriate.

We present command syntax, program output, and screen displays:
* in Linux format first

« in other Unix-specific variants only when necessary for proper operation or to clarify functional
differences

* in Windows format only when necessary for clarity

References to Web Content

For your convenience, this guide refers to Uniform Resource Locators (URLS) for resources published on the
World Wide Web, when appropriate. We attempt to provide accurate information; however, these resources
are controlled by their respective owners and are therefore subject to change at any time.
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CHAPTER 1

Dictionary Manager Advanced
Features

The Oracle Knowledge Dictionary Manager is a component accessed from within the Language Workbench
that allows you to customize and maintain the Dictionary Objects used by Oracle Knowledge Intelligent
Search to return the best possible answers.

Note: Before using the information in this chapter, it is advised that you familiarize yourself with the
Intelligent Search Language Tuning Guide.

In addition to the Advanced Features of Concepts on page 4 and Advanced Features of Rules on page 5,
this chapter describes the following Dictionary Objects:

Answer Action Methods for Rules on page 11
Alias Lists on page 16

Exception Lists on page 19

Intent Hierarchy on page 23

User Profiles on page 25

Show Concepts Tree on page 27

Subject Maps on page 28

For information on Dictionary Objects not included, please see the Intelligent Search Language Tuning
Guide.

This chapter also describes:

» Oracle Knowledge Language Analysis on page 30

» The Scoring Process on page 33

ORACLE KNOWLEDGE INTELLIGENT SEARCH OPTIMIZATION GUIDE ORACLE"



14 ADVANCED FEATURES OF CONCEPTS

Advanced Features of Concepts

This section explains how to use the advanced features of Concepts. For more information on Concepts
please see Intelligent Search Language Tuning Guide
Select Advanced from the Concept window. The following options are displayed:
- Indexed Concept on page 4 (Checked by default.)
- Openclass on page 4,(Unchecked by default.)
- Subsumes on page 4 (Checked by default.)

Indexed Concept

The Indexed Concept option located in the Advanced menu of the Concept window is checked by default.
When the Indexed Concept option is checked, the System Manager reindexes the Concept upon running an
indexing job. For more information on Indexing, please see Oracle Knowledge Intelligent Search
Administration Guide.

If the Index job is too slow, you may uncheck the Indexed Concept option. To uncheck the Indexed Concept
option from multiple Concepts use the Dictionary Find Tool to find Concepts with Indexed Concept set.

Once all the Concepts with IML indexing are displayed:
» Select All Concepts.

 ‘Right-click’, and select Unset Indexed Concept.

Openclass

The Openclass option located in the Advanced menu of the Concept window allows you to manually classify
a Concept as openclass. This option is only applicable for Concepts that include a suitable IML pattern, such
as those that end in "Openclass”, like date Openclass. An Openclass Concept defines an open-ended
class of strings which fit a particular pattern, but which do not have interchangeable meanings. Typical
examples are email addresses and dates. Openclass Concepts must be defined with IML.

The Openclass option is unchecked by default. Upon checking the Openclass option, the query containing
the Openclass Concept is annotated with an #OPENCLASS label on the string. This #OPENCLASS label
prevents Concept-related Search Component Rules (for example, Required Concept SC) from firing. Instead
Oracle Knowledge Intelligent Search uses a set of specific Openclass Search Component Rules that match
on the string-form representation, and do not match on synonyms or clusters. .

For example, a query containing the string “1/12/10" is annotated with the openclass <Date Openclass>
Concept. This Concept triggers Oracle Knowledge Intelligent Search to find the numbers in a string, versus
finding the numbers individually.

Subsumes

The Subsumes option, located in the Advanced menu of the Concept window, is checked by default.

When the Subsumes option is checked, strings that match overlapping sets of synonyms will index only the
longest match. If unchecked, strings that match overlapping sets of synonyms will index all matches.

1. One exception to this is the concept <swearword Openclasss>, which includes a Synset of swear words for each language.

ORACLE KNOWLEDGE INTELLIGENT SEARCH OPTIMIZATION GUIDE ORACLE



15 ADVANCED FEATURES OF RULES

For example, if the Subsumes option is checked, the phrase "information manager" is indexed with only the
Concept <information managers. If the Subsumes option is unchecked, “information manager” is
indexed with the Concepts <information manager>, <informations>, and <manager>. Queries are
always annotated with Subsumes on, the checkbox only affects document indexing

Another example, in a document with the sentence:
Click here to get started by opening a free checking account.

With <free checking accounts> and <checking accounts> concepts set to subsume, the phrase "free
checking account” is indexed only with the concept <free checking accounts. If there were no <free
checking accounts> concept (or synonym) then it would be indexed with <checking accounts>, and
only if there were no <checking account> concept it would be indexed with <account>.

With subsume turned off, the phrase "free checking account" would be indexed with the <free checking
account> concept; "checking account” with the <checking account> concept; and "account” with the
<account> concept. In either case, a user query with the phrase "free checking account" annotates the
concept <free checking accounts.

The result in these cases is that if subsume is on, and a user searches for "open an account", there would be
a stem/string match but not a concept match on that document, resulting in a different score; and any custom
search components that look for a concept annotation won't match. With subsume off, that document/
sentence would be matched with both a stem/string match and the concept annotation.

Advanced Features of Rules

This section explains how to use the advanced features of Rules. For more information on Rules please see
Intelligent Search Language Tuning Guide.

Select Advanced from the Rule window. The following options are displayed:
» Add Business Conditions on page 5
» Add Answer Action on page 7
» Add Search Component on page 7
» Add Facet Restriction on page 7
* Add Set Attribute on page 7
» Add Relative Weights on page 8
» Add Scope Weights on page 9
* Add Suppress Rules on page 10

This section also provides Answer Action Methods for Rules on page 11.

Add Business Conditions

Business Conditions enable you to tailor search results based on context, such as the user’s identity, location,
or date and time of the query. You can configure Business Conditions to access information from the user’s
current Oracle Knowledge session, as well as from external sources of user and session information.

Business Conditions make use of Context Variables. Context Variables are properties that correspond to
configured preferences within Oracle Knowledge. With the exception of date- and time- parameters, you must
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16 ADVANCED FEATURES OF RULES

configure providers for all preferences. For more information, please see Chapter A, Configuring Access to
Business Data.

Add Business Conditions

To add a Business Condition:

1 Select Add Business Conditions from the Advanced menu of the Rule window. A Business
Conditions tab displays:

2 Click Add new condition. The Business Condition window displays:

= - -
M Busziness Condition

date:today

3 Select the Context Variable from the first drop down menu. For more information please see The
Context Variables Page on page 187.

4  Select a Condition Operator from the middle drop down menu. .

5 Enter the value that the Rules Engine uses to compare the current value of the context variable, as
specified by the condition operator.

6 Click Add aline, if you want to add alternate Business Conditions to a Rule.
7 Click Add new condition, if you want to add multiple Business Conditions.

Note: Use Add aline to create a single Business Condition which is true if any of multiple variable
comparisons are true. The rule is triggered only if all of the Business Conditions are true.

8 Click OK. The Business Condition appears in the Business Conditions tab.
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17 ADVANCED FEATURES OF RULES

If the created Business Condition is currently satisfied, the Business Conditions tab displays “Current
evaluation: true.” If the Business Condition is not satisfied, meaning the Rule is not triggered for
response, the tab displays, “Current evaluation: fail.”

To remove a Business Condition:
1 Right-click on the Business Condition.

2 Click Remove.

If you do not see a Remove link, click the Delete Business Conditions X icon in the upper-right corner
of the Business Conditions tab.

Confirm that you would like to delete the Business Condition.

3 Select Save from the File menu.

Add Answer Action

A Managed Answer Rule may have multiple Answer Actions. For more information on Answer Actions, please
see Intelligent Search Language Tuning Guide.

Add Search Component

For more information on Search Component, please see Intelligent Search Language Tuning Guide.

Add Facet Restriction

You can restrict the scope of Search Actions by adding Facet Restrictions. Facets are created using the
Personalized Navigation Setup. For more information, please see Personalized Navigation Setup.

To add a Facet Restriction:

1 Select Add Facet Restriction from the Advanced menu of the Rule window. The Facet Restriction
tab displays:

Default

[ ] Languages
[+ | DocTypes
+--[ ] Collections

2 Select a facet from the tree structure. Using a comma to separate facets, you may select more than
one facet.

3 Select Save from the File file menu of the Rules window.
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Add Set Attribute

The Set Attribute option allows you to use Business Condition context variables for use within subsequent
Rules. In order to test Dictionary Objects that make use of Business Conditions using Test Drive, it is
necessary to establish Rules with Set Attributes. Using a Rule with a Set Attribute action allows you to
simulate the passing of a context variable through the User Interface. For more information on context
variables, please see Chapter A, Configuring Access to Business Data.

To add a Set Attribute:

1 Select Add Set Attribute from the Advanced menu of the Rule window. The Set Attribute tab
displays:

result_language l_

2 Select a context variable from the drop down menu.
3 Enter the value of the context variable.

4  Select Save from the File file menu of the Rules window."

Add Relative Weights

You can specify custom values for weighting the score components used to rank unstructured search results
by adding Relative Weights.

You can apply relative weights to the current Rule (local), or to all Rules that specify the Search method
(global).

In order to specify local relative weights the Rule must contain an Answer Action using the Search method.
For more information, please see Search Answer Action Method on page 12.

To specify global relative weights create a Relative Weights action without an accompanying Search Action.
For example, create a new Rule named "Relative Weights" with a question pattern and no action other than
"Scope Weights". The Relative Weights parameters apply to all unstructured search results, unless they result
from a Rule with specific Relative Weights settings.

You can specify Relative Weights based on any language conditions and available Business Conditions. For
more information, please see Add Business Conditions on page 5.
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To add Relative Weights:

1 Select Add Relative Weights from the Advanced menu of the Rule window. The Relative Weights tab
displays:

Question Patterns

Enter IML condition for matching questions;

# Matches: | Default

BEGIN {+)}=A END

ACTIONS

Answer: Search | Relative Weights

|0.000001 |% Relevance of documents

o |% Recency of documents
[9.999099 % )
Total: 100 | %
I [} Dictionary Find Tool “ [ Find All Types Results ”‘D Launch Document Search‘

2 Enter a percentage to weight the Search Component score relative to the Relevance and Recency
scores in the % Search Components field. Default is 100%.

3 Inthe Relevance of documents field, specify a percentage to weight the relevance score relative to
the Search Component, Recency, and Proximity scores. Default is 0.0%.

4 Inthe Recency of documents field, specify a percentage to weight the Recency score relative to the
Search Component, Relevance, and Proximity scores. The Recency score relies on the date/time
stamp of a file. Default is 0%.

5 Inthe Proximity of search terms field, specify a percentage to weight the proximity of search terms
score relative to the Search Component, Relevance and Recency scores. Proximity is only calculated
for the configured number of results. returned. Default is 0.0%.

Note: The combination of all scores must equal 100%.

For more information on Search Component Scores and Document Relevance and Recency scores, please
see Chapter A, Configuring Access to Business Data.

Add Scope Weights

You can specify custom values for weighting the document scope in which an answer is located using the Add
Scope Weights option. The Rules Engine uses scope weights to calculate the total score for a response
during scoring process.

You can apply scope weights to the current Rule (local), or to all Rules that specify the Search method
(global).

You specify weights only for the current Rule by including a Scope Weights action and an Answer Action
using the Search method in the same Rule. For more information, please see Search Answer Action Method
on page 12.

You specify global scope weights by specifying the Scope Weights action without an accompanying Search
Action. The Scope Weights parameters applies to all unstructured search results, unless they result from a
Rule with specific scope weight settings.
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To add a Scope Weight:

1 Select Add Scope Weights from the Advanced menu of the Rule window. The Scope Weights tab
displays:

I:l% Sentence

2 Inthe % Document field, specify a percentage to weight the score when an answer is located
anywhere within the document.

3 Specify a percentage to weight the score when an answer is located within a section of the document
in the % Section field.

4  Specify a percentage to weight the score when an answer is located within a sentence in a document
in the % Sentence field.

Note: The combination of all scores must equal 100%.

Add Suppress Rules
You can specify the suppression of subsequent Rules using the Suppress Rules option. The Suppress Rules
tab provides options to:
* Suppress processing of all subsequent Rules
e Suppress processing for only the specified Rules
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To suppress Rule processing:

1 Select Add Suppress Rules from the Advanced menu of the Rule window. The Suppress Rules tab
displays:

(2% BA Information Manager _ | O] x|

BA Information Manager

Should return link when user queries install IM or Install information
manager

Base Standard -

berak__ o]

<sgt up:>, <information manager =

2 Specify to terminate Rule matching or Rules to exclude from processing.
- To terminate Rule matching, check the Stop looking for more Rules box.

- To exclude a Rule from processing after this Rule has fired, drag and drop the Rule icon from within

the Rule's window or from a Dictionary Find Tool result list, to the list at the bottom of the Suppress
Rules tab.

You can delete Rules from the suppression list by right-clicking and selecting Remove from List,
doing so prevents further answers from being displayed.

Answer Action Methods for Rules

The following section explains Rules using the following Answer Action Methods:
¢ Specific Excerpt Answer Action Method on page 12
e Search Answer Action Method on page 12

e Structured Query Answer Action Method on page 13
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e Glossary Answer Action Method on page 14
¢ Plug-in Answer Action Method on page 15
¢ Process Wizard Answer Action Method on page 16

For more information on creating Rules, please see Intelligent Search Language Tuning Guide.

Specific Excerpt Answer Action Method

The Specific Excerpt Answer Action is used to display specific excerpts within the Content Store.

To use the Specific Excerpt Answer Action:

1 Select Specific Excerpt from the drop down menu of the Method field of the Rule window. The
Answer: Specific Excerpt tab displays:

2 Enter text in the Custom Link Text to display as the actual text of the link to the answer. For example
to display the link text Oracle Knowledge Customer Support instead of www.inquira.com/support/
index.htm.

Note: The Custom Link Text field is only valid when used with the Link Excerpt and Raw Excerpt
algorithms. For more information please see Oracle Knowledge Intelligent Search Administration
Guide.

3 Inthe Title field, enter text to match within excerpt titles.
4 In the Specific Excerpt field, enter text to match within excerpts.

5 Select Save from the File menu in the Rule window.

Search Answer Action Method

The Search Answer Action is used to search within indexed unstructured content.

An example of a Search Answer Action is the Launch Document Search Rule. The Launch Document Search
Rule does not use any IML, but retrieves all unstructured search results using default ranking.

Note: If you create additional Rules with the Search Answer Action Method, you need to suppress the
Launch Document Search Rule. Otherwise, you may see the same document retrieved multiple times by
different Search Component Rules.
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To use the Search Answer Action:

1 Select Search from the drop down menu of the Method field of the Rule window. The Answer: Search
tab displays

2 Enter valid IML to specify matching criteria for the excerpts generated by the Rules Engine in the
Retrieve document excerpts using this IML.

3 (Optional.) Check the Retrieve document excerpts using default ranking to return results using the
standard Search Component assignment and scoring process.

Note: You can use either the IML field or the Default Ranking option independently but, they do not
work in conjunction with one another.

4  Select a value from the Number of results must not exceed drop down menu.

5 Select Save from the File menu in the Rule window.

Structured Query Answer Action Method

The Structured Query Answer Action is used to specify retrieval from configured sources of structured data.
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To use the Structured Query Answer Action:

1 Select Structured Query from the drop down menu of the Method field of the Rule window. The

o o1 b~ W

8
9

Answer: Structured Query tab displays

Skructured Query I_

Select a Data Source to query from the drop down menu. Please see the Oracle Knowledge
Intelligent Search Administration Guide for information on configuring data sources for structured
information retrieval.

In the Title of results field, enter text to specify a title under which the query results are displayed.
In the Description field, enter text to specify an optional description for the query results.
In the Structured Query field, enter the SQL query to submit.

(Optional.) Enter IML in the IML to restrict Structured Query to restrict the results of the query. The
Rules Engine filters the query results based on matching the specified IML.

(Optional.) Check the Retrieve structured results using default ranking if you want to return results
using the standard Search Component assignment and scoring process.

Enter the number of Table rows to display with description.

Select a value from the Number of results must not exceed drop down menu.

10 Select Save from the File menu in the Rule window.

Glossary Answer Action Method

The Glossary Answer Action is used to display terms and definitions from prepared glossaries. For more
information, please see Alias Lists on page 16.

Note: Oracle Knowledge provides a preconfigured Rule, “Definition of” to use with the Alias List called
“Glossary.”
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To use the Glossary Answer Action:

1 Select Glossary from the drop down menu of the Method field of the Rule window. The Answer:
Glossary tab displays:

Answer |_
Fighest |

oszary o]

2 Select the alias list from the Glossary Alias List to use drop down menu.

3 Inthe Retrieve a glossary entry for the term referred to by this variable enter the variable set in
the Rule condition that corresponds to the desired glossary entry.

4  Select Save from the File menu in the Rule window.

Plug-in Answer Action Method
The Plug-in Answer Action is used to create a response using an external method.

To use the Plug-in Answer Action:

1 Select Plug-in from the drop down menu of the Method field of the Rule window.
The Answer: Plug-in tab displays:

R
T

Restart Question |_

2 Select a Plugin from the drop down menu.

3 If displayed, enter text in the Question, type, or File field.
The Description field provides an explanation of the plug-in fuctionality. If displayed, enter text in the
field below Description, labelled Question, type, or File, depending on the plug-in. For installed
examples, search for all Rules whose Methods include Plug-in.
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4  Select Save from the File menu in the Rule window.

Process Wizard Answer Action Method

The Process Wizard Answer Action is used to display a Process Wizard in response to a query.
To use the Process Wizard Action:

1 Select Process Wizard from the drop down menu of the Method field of the Rule window. The
Answer: Process Wizard tab displays:

aoswer [ MR rccess v

N

Mavigation Troubleshooter

2 Select the process wizard you want to use from the drop down menu.

3 Select Save from the File menu in the Rule window.

Alias Lists

Alias Lists are Dictionary Objects that provide a means of substituting one term for another. Alias Lists are
transformative where, unlike Concepts, a word or abbreviation in a user query is replaced with an associated
value. For example, the existence of the delivered US State Abbreviations Alias List associates a user query
containing “NY” with “New York.”

Creating Alias Lists in Dictionary Manager allows Oracle Knowledge Intelligent Search to:
« Provide definitions to key terms using the Answer Action Methods for Rules on page 11.
« Identify values for common abbreviations such as, state names or stock symbols.

Note: If you use multiple alias lists to launch glossaries that are restricted to different audiences, the same
term cannot appear in multiple glossaries. Including the same terms in different alias lists results in none of
the alias lists launching on Information Manager.

Create a New Alias List

By creating new Alias Lists, you allow Oracle Knowledge Intelligent Search to recognize terms or
abbreviations as having a set value.

Oracle Knowledge provides the VIL Alias List function. For more information, see ALIAS The Alias Function
in the Intelligent Search Language Reference Guide and Create a Rule to Fire When an Alias List Key is
Matched and Pass User-Selected Facets Through an Alias List in this guide.
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To create a new Alias List:

F New Alias List = [=]

1 In Dictionary Manager, click the New Alias List icon or select New Alias List from the File menu.

The Alias List window displays:

File Edit Tools Advanced
Mame: I
Description: l
¥ Enabled Haes: I
Domain: I.ﬁ.dmin ;I
List Type: ISt.anu:Iaru:I LI
add a line |
Keys J Values J Actions ]

Dele'bel

Enter a descriptive name for the Alias List in the Name field.
(Optional) Fill in the Description field.

The Description field has no impact on Oracle Knowledge Intelligent Search results. It is used to clarify
the intended function of the Alias List among users.

(Optional) Enter any additional information pertinent to the Alias List in the Notes field.

The Notes field has no impact on Oracle Knowledge Intelligent Search results. It is used to track
comments on Rule modification among users.

Check the Enabled box. (This is checked by default.) If the Enabled box is not checked the Alias List
is ignored by Oracle Knowledge Intelligent Search.

Select the Domain from the drop down list. Only Domains you have permission for are displayed. The
Domain field is set to the most recently saved Domain by default. For more information on Domains
see the preceding section in Intelligent Search Language Tuning Guide.

Select a List Type from the drop down menu. Choose from standard, Root Concept Property, or
Context Variable Property.
- Standard is the default.

- Root Concept Alias Lists create a list that contains ONLY children of a root concept defined in the
Root Concept field. For example: Product and Product types.

- Context Variable Alias Lists create a list that corresponds to the context variable defined from the
drop down menu in the Context Variable field. For example: User Location and State Abbreviations.

10 Enter a word, phrase, Concept, or global variable in the Keys column.

Note: To reference a Concept you must use angle brackets, for example, <information manager>.
To reference a Global Variable you must use the pound sign, for example #GLOBALVARIABLE.
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11 Enter a value in the value column for Oracle Knowledge Intelligent Search to associate with the
corresponding key term.

Create a Rule to Fire When an Alias List Key is Matched

To create a rule that fires only when an alias list key is matched, set up a question pattern that matches every key
in the alias list. Due to the potential size an alias list could be, doing this manually will be hard to maintain. Instead,
use a VIL expression in the question pattern box to accomplish this automatically:

{ "dummyString"->ALIAS (LIST="aliasListName", KEYOUTONLY="TRUE") ->STRING (SEP=" OR ") }

This expression populates the question pattern with all the alias list keys separated by the OR operator. The
"dummysString" can be any string; it is required for the VIL expression to work but plays no part in the eventual IML
pattern. The "aliasListName" is the name of whatever alias list contains the desired keys.

This makes maintenance easier now because any additions, deletions, or modifications to the alias list's entries are
automatically updated in the question pattern.

For more information, see ALIAS The Alias Function on page 32 of the Intelligent Search Language Reference
Guide.

Pass User-Selected Facets Through an Alias List

Use the VIL function FACET() to get a string of all the Facets, or a subset of them, that a user has selected and
then pass the output to the alias list function, e.g. {"A->FACET()->ALIAS(LIST="someList")}.

Note: The output of FACET() cannot be used for concept matching, so the keys in the Alias List must be strings.

For more information, see ALIAS The Alias Function on page 32 of the Intelligent Search Language Reference
Guide.

Alias List Tools

Before saving an Alias List, you can verify the function of the Alias List by selecting Validate Alias Lists from the
Tool menu in the Alias List window.

You may also choose to Import Text Files.

Import Text Files

To import existing Alias Lists to be used by your current version of Oracle Knowledge Intelligent Search:

1 From Dictionary Manager, select Import from file from the Tools menu of the Alias Lists window.
The Import Alias Lists file finder displays.

2 Navigate to the directory containing the .xml file containing Alias Lists and select the file.

3 Select Import.
The imported Alias List displays.

Note: Typically, the Import Alias List functionality is used to re-import Alias Lists exported as XML files.
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Validate Alias Lists

After selecting Validate Alias List from the Tools menu, Oracle Knowledge Intelligent Search automatically
checks the validity of your Alias List. If the Alias List is valid the following Alias List is Valid dialog displays.

Aliaz List iz Yalid

o

Advanced Feature of Alias Lists

This section explains how to use the Alias Lists advanced feature, Set Overriding.

Set Overriding

Alias Lists with the same name and values can belong to multiple Dictionary Domains. If Alias Lists with the
same name occur, the default override behavior is determined by the order of Domains in the Domain List.
For more information on Domains and Domain Lists, please see Intelligent Search Language Tuning Guide.

Using the Set Overriding option, you can specify custom override behavior.

¢ Select Set Overriding from the Advanced menu of the Alias Window. The overriding options append to
the Alias List window:

¢ Choose between Entry Overriding or Global Overriding.

Entry Overriding specifies that Keys and Values assigned in the current Alias List are override entries
with the same Keys and Values of Alias Lists of the same name in higher ranked Domains.

Global Overriding specifies that the current Alias List overrides an Alias List with the same name in a
higher ranked Domain for all entries, not just for the Keys and Values the two Alias Lists share.

Exception Lists

Use Exception Lists to create exceptions to the stemming process used by Oracle Knowledge Intelligent
Search. The stem of a word is the root form of the word—the word minus any inflection. For example, "work"
is the stem of "works" "working" and "worked" Stemming accounts for changes in word shape owing to the
context in which words occur without altering the meaning of the word.

In English, stemming covers the relations represented in the following table—for noun, plural; for verbs,
person and tense inflection; for adjectives, comparatives:

Part of Speech Stem Inflected Form
noun dog dogs
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Part of Speech Stem Inflected Form
verb carry carried

verb carry carries

verb carry carrying

adjective nice nicer

Stemming does not cover the relation between the words in columns A and B in the following table. Unlike the
previous list, these are meaning-altering relations: the words in B add some meaning component to those in

A.

A B

love lover
love lovable
Russia Russian
italic italicize

romantic romanticism
stupid stupidity
fool foolish

The LLLA (Low Level Language Analysis) Service of Oracle Knowledge handles stemming.! You can see the
stem of a word in Test Drive, Annotations, Stem.

In some cases, it is necessary to add a stemming exception or modify the basic stemming rules. A typical
case arises with acronyms. For example, the Product name “lkes” is stemmed to “Ik”, as Oracle Knowledge
Intelligent Search recognizes -es as a suffix. To prevent this we must add “lkes” to the Exception List as
described in Edit an Exception List on page 32 and Create a New Exception List on page 33.

Locale-level Stem Exceptions

Intelligent Search provides locale-level stemming exceptions.

| [z New Exception List I [=]

. File Edit | Todls

| ~Select Language
MOTE: Exception Lists are not supporked For all languages!
Mame: Base Locale

IEninsh ;I IGreat Britain ;I

Exception Lists can be created at both a Base language level, such as English, French, Japanese, or at a
Locale level, such as English US, English GB, French Canada, French France. If the language of content
being indexed is specified as a base language, then only the base language Exception List is used. If the
language is specified as a locale language, then the locale Exception list, if one exists, is merged with the
base language Exception List. Where any conflicts arise, the locale values are used. One recommended
usage might be to make exceptions for locale-level products. See the following example.

1. Oracle Knowledge uses third party software to handle stemming for foreign languages.
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Example

Consider the following scenario.
Base Language English Stem Exception List contains:
caught => catch

This stemming exception says that the stem of "caught" in English is "catch”. This is a typical stem exception
entry.

Let's say now that a customer has a product "Heavy Advanced System" with acronym "HAS" or "has". This
motivates adding a stem exception:

has => has
S0 as to prevent acronym "HAS" or "has" to be stemmed and identified with the English verb "have".
This product acronym, let's assume, is only used in localization English-Malaysia (en-MY).

If the stem exception for "has" is added to the 'en' (English) stem exception list, this would create problems
during content processing and at runtime.

SOLUTION

* add the entry "has => has" to the en-MY Stem Exception List

* ensure that the documents containing the product acronym "HAS" or "has" are part of a collection setup with
manual language detection and assigned to language en-MY.

Important! Itis important, when indexing this collection, that it be marked as Base+Localized language,
i.e., en-MY. This causes a merge of the exception lists for 'en’ and for 'en-MY", resulting in the following
differential stemming depending on the language chosen:

Language / Locale Exception List Merge

EN caught => catch
EN has, having, had, have => have
en-MY has => has

So, if the request language at runtime is set to en-MY (English Malaysia), a query for the product "HAS" or
"has" will not match to other forms of the verb to-have, but only to "has".

Important! In order to achieve the best results when indexing a non-IM collection, use Manual Language
detection, rather than Auto, when crawling the content. In the example above, this is necessary also
because, otherwise, this en_MY content will appear in search results in all other EN locales such as

en_ South Africa, en Egypt, etc.
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Edit an Exception List

To edit an Exception List:

aardwolf aardwalves

abacus ' éEuaciJab:acLlses _
abash ' abashed, abashing | Delete |
abducens ‘abducens | Delete |
abecedarian ' abecedarian | Delete |
abet | abets,abetted, abetting | Delete |
abhor ' abhorred,abhorring, abhars | Delete |
abide abided, abides, abiding, abode [ Delete |

1 In Dictionary Manager, select [_|_+_E| to display all exception lists and select the language specific

Exception List to edit. The Exception List displays:

B English

Note: If the language you want to edit does not appear, please see Create a New Exception List on
page 33.

Click Add aline. A new line appends to the bottom of the list.
In the Stems column, enter the preferred stemmed form of the word.

In the Tokens column, enter the word as it appears in a user query. Using a comma to separate the
words, you may enter more than one form per stem. A token consisting of multiple parts may be added
to the Exception List if the associated stem consists of the same number of words.

Stems | Takens | fckions
ikes ike,ikes Dralete

Note: Exception Lists are case sensitive. A token entered using capitals matches only strings with the
same capitalization; however, if the token is entered in lower case it matches a string in any case.

Select Save, from the File menu of the Exception List window. The newly created exception appears
alphabetically.

Note: A stem may only appear once on the Exception List. Upon saving, a stem listed twice gets
condensed to one instance with the associated tokens appearing on one line separated by a comma.

Important! Modfications to an Exception List do not affect live Intelligent Search results until you:
1) Commit the Dictionary changes to your Central Repository (vcroot);

2) perform a full content re-index; and

3) synch the changes to the production environment.

To see the effects of a new or modified Exception List without committing, use Test Drive.
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Create a New Exception List

Note: Exception Lists can be created at both a Base language level, such as English, French, Japanese, or
at a Locale level, such as English US, English GB, French Canada, French France. If the language of
content being indexed is specified as a base language, then only the base language Exception List is used.
If the language is specified as a locale language, then the locale Exception list, if one exists, is merged with
the base language Exception List. Where any conflicts arise, the locale values are used.

To create a new Exception List:

1 In Dictionary Manager, select the icon or New Exception List from the File menu.

The New Exception List window displays.

i New Exception List M [=]

File Edit Tools

~Select Languange-
MOTE: Exception Lists are not supported For all languages!
Marne: Base Locale

Endlish j IGreat Britain ;I

Descripkion:

v Enabled Mokes:

Add aline I

Skems 1 Taokens ] Actions J

Crelets I

Select the Language Base and Locale the Exception List is intended for from the drop down menus in
the Name field. For additional information, see Locale-level Stem Exceptions on page 30.

Note: If the language you desire does not display in the drop down menu, then an Exception List for
the language has been created. Please see Edit an Exception List on page 21.

(Optional.) Enter a definition into the Description field.

Use the Description field to clarify the meaning among users, which can assist in finding dictionary
objects.

(Optional). Enter any information regarding the Exception List in the Notes field.

The Notes field has no impact on Oracle Knowledge Intelligent Search results. It is used to track
comments on dictionary object modification among users.

Select the Enabled box. (This is checked by default.) If the Enabled box is not selected, the Exception
list is ignored by Oracle Knowledge Intelligent Search.

In the Stems column, enter the preferred stemmed form of the word.

In the Tokens column, enter the word as it appears in a user query. Using a comma to separate the
words, you may enter more than one form per stem.

Skems ] Tokens ] Ackions |
ikes ike,ikes Delete |
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8 To add exceptions, select Add a line. A new line appends to the bottom of the list.

9 Select Save, from the File menu of the Exception List window. The newly created exception appears
alphabetically.

Important! Modfications to an Exception List do not affect live Intelligent Search results until you:
1) Commit the Dictionary changes to your Central Repository (vcroot);

2) perform a full content re-index; and

3) synch the changes to the production environment.

To see the effects of a new or modified Exception List without committing, use Test Drive.

Exception List Tools

To export an existing Exception List:
1 In Dictionary Manager, select Edit > Show all Exception Lists to display all exception lists.
2 Select the Exception List to export.
3 Right-click on the highlighted Exception List and select Export.
4

Select or enter the path and name of the folder on your local file-system where the Exception List is to
be exported, as an XML file.

To re-import an Exception List from an exported XML file:
1 Select Tools > Import Dictionary Objects from the main menu in Dictionary Manager.
The Import Dictionary Objects file finder displays.
2 Navigate to the location of the folder containing the Exception List, and select Import.
The Exception List imports.

It is also possible to export (selected portions of) an Exception List as a .csv file (comma-separated values,
delimited by double-quotes); or to import and merge a .csv file into an existing Exception List.

To import and merge a .csv file into an existing Exception List,
1 Open the Exception List and click on the Tools menu of the Exception List.

2 Select Import from file or Export to file.

Important! Importing or exporting from .csv file does not support extended character sets, and therefore
it is not suitable for entries that contain accented characters or non-latin characters.

Intent Hierarchy

Intents are organized as parent, siblings, and child nodes in an Intent Hierarchy. Intent Hierarchies descend
from a single node at the highest level called All Intents. The position of the Intent within the Intent Hierarchy,
plus the score of the closest parent, determine which intent has precedence in firing a configured Intent
Response. The Rules Engine selects the lowest-level matching Intent in the hierarchy as the best possible
response. If a low-level Intent does not satisfy a user query, the Rule Engine works backwards to match on a
higher-level Intent. This process, referred to as degradation, ensures that Oracle Knowledge Intelligent
Search returns the most specific Intent Response to a user query. For more information on Intents, Intent
Responses, please see Intelligent Search Language Tuning Guide.
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Create a new Intent Hierarchy

Oracle Knowledge provides pre-configured Intent Hierarchies for various industries. These can be displayed
using the Find functionality.

To create a new Intent Hierarchy:

1 In Dictionary Manager, select the . icon or New Intent Hierarchy from the File menu. The New
Intent Hierarchy window displays:

Hew Intent Hierarchy

L2 Al Inkents This intent Funckions as. ..

2 Enter a descriptive name for the Intent Hierarchy in the Name field.
3 (Optional.) Fill in the Description field.

4  The Description field has no impact on Oracle Knowledge Intelligent Search results. It is used to clarify
the intended function of the Intent Hierarchy among users.

5 (Optional.) Enter any information regarding the Intent Hierarchy in the Notes field.

6 The Notes field has no impact on Oracle Knowledge Intelligent Search results. It is used to track
comments on Intent Hierarchy modification among users.

7 Check the Enabled box. (This is checked by default.) If the Enabled box is not checked the Intent
Hierarchy is ignored by Oracle Knowledge Intelligent Search.
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Note: When displaying an Intent Hierarchy, all of the intent names will display in red, with the
message *intent not found; name = xxxx, if the Domain of the Intent Hierarchy is not
included in the Active Domain List, displayed in the upper-right corner of the Dictionary Manager. To
fix this, reset the Active Domain List; then close and reopen the Intent Hierarchy.

If a language-specific name for an intent has not been specified for the Language value of the Intent
Hierarchy, the name is displayed in red as *null and its parameters will be displayed as * <no
name >. Fix this by editing the Intent and adding names for the language.

8 Select the Domain from the drop down list. Only Domains you have permission for are displayed. The
Domain field is set to the most recently saved Domain by default. For more information on Domains
see the preceding section Intelligent Search Language Tuning Guide.

9 Select the Language from the drop down menu.
Additionally, you may specify a locale for the language.

10 Select New Child to add Intents to the new Intent Hierarchy. For more information on Intents, please
see Intelligent Search Language Tuning Guide.

11 Select Save, from the File menu of the User Profile window.

User Profiles

User Profiles are a type of Business Condition used to restrict an Intent Response. When using User Profiles,
the set condition(s) must be satisfied by the user query in order to display the associated Intent Response.

For more information on Business Conditions, please see Add Business Conditions on page 5. For more
information on Intent Responses, please see Intelligent Search Language Tuning Guide.
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Create a new User Profile

To create a new User Profile:

1 In Dictionary Manager, select the E icon or New User Profile from the File menu. The New User

9

Profile window displays:
% New User Profile

Intent Library Customerhelp |_

Enter a descriptive name for the User Profile in the Name field.
(Optional.) Fill in the Description field.

The Description field has no impact on Oracle Knowledge Intelligent Search results. It is used to clarify
the intended function of the User Profile among users.

(Optional.) Enter any information regarding the User Profile in the Notes field.

The Notes field has no impact on Oracle Knowledge Intelligent Search results. It is used to track
comments on User Profile modification among users.

Check the Enabled box. (This is checked by default.) If the Enabled box is not checked the User
Profile is ignored by Oracle Knowledge Intelligent Search.

Select the Domain from the drop down list. Only Domains you have permission for are displayed. The
Domain field is set to the most recently saved Domain by default. For more information on Domains
see the preceding section Intelligent Search Language Tuning Guide.

Click Add new condition. The Business Condition window displays.

10 Complete the Business Conditions as described in Add Business Conditions on page 6.

11 Select Save, from the File menu of the User Profile window.

User Profile Tools

Before saving a User Profile, you can verify the function of the User Profile by selecting an Validate Profile on
page 27 from the Tool menu in the User Profile window.
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Validate Profile

After selecting Validate Profile from the Tools menu, Oracle Knowledge Intelligent Search automatically
checks the validity of your User Profile.

Show Concepts Tree

The Concepts tree displays hierarchies of Concept type of or part of relationships defined in the Dictionary.
The hierarchies originate at specified Root Concepts, as described in Specifying the Root Concepts for the

Dictionary Manager. The hierarchy displayed below each Root Concept reflects the Concept relationships
defined below it in the Ontology.

You can edit concepts by selecting them directly from the Concepts tree, and you can add concepts to other
Dictionary objects by dragging and dropping them directly from the Concepts tree.

Subject Maps

Subject Maps are used in conjunction with the language and subject parameters passed with a user query to
determine which Domain List to use in processing the query. Subject Maps are used to associate the pairings
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of a subject area and language with a Domain Lists. For example, the Automotive Subject Map contains the
automotive Domain Lists for each language.

# Automotive =]
File internal\InQuira May 10 2012, 5:12FM
o Name: [Automotive
Description: I
W Enzbled O

Add a line |
Language Domain List I Actions
Default English Automotive Delete
Chinese China Chinese Simplified Automotive China Delete
Chinese Simplified Chinese Simplified Automotive Delete
Chinese Taiwan Chinese Traditional Automotive Taiwan Delete
Chinese Traditional Chinese Traditional Automotive Dkt
English English Automative Delete
English Great Britain English Appliances Great Britain Delete
English United States English Appliances United States Delete
French French Automotive Delete
French France French Automotive France Delete
German German Automotive Delete
German Germany German Automotive Germany Delete
Italian Italian Automotive Delete
Italian Italy Italian Automotive Ttaly Delete
Japanese Japanese Automotive Delete
Japanese Japan Japanese Automotive Japan Delete
Korean Korean Automotive Delete
Korean Korea Korean Automotive Korea Delete
Portuguese Portuguese Automotive Delete
Portuauese Brazil Portuguese Automotive Brazil Delete

ORACLE KNOWLEDGE INTELLIGENT SEARCH OPTIMIZATION GUIDE

ORACLE



40 SUBJECT MAPS

Edit Subject Maps

To edit Subject Maps:

1 In Dictionary Manager, select Edit Subject Maps from the Tools menu. The Subject Maps window
displays:

4 Subject Maps =1

e

Appliances
Automotive
Boolean
_omputer
Zonkack
Cuskomerhelp
Finance
keyword
Telecom
IIkilities

OO

2 Click Add new Subject Map. The New Subject Map displays:

& New Subject Map _ O] =
File
<> MName: I
Description: l
W Ensbled O
Add a line I
Language Domain List I Actions

3 Enter a descriptive name in the Name field.
4 (Optional.) Enter a definition into the Description field.

5 The Description field is used to clarify the meaning among users, and can be used to find dictionary
objects.

6 (Optional). Enter any information regarding the Subject Map in the Notes field.

The Notes field has no impact on Oracle Knowledge Intelligent Search results. It is used to track
comments on Concept modification among users.

7 Check the Enabled box. (This is checked by default.) If the Enabled box is not checked, the Subject
Maps is ignored by Oracle Knowledge Intelligent Search.

8 Select a Language from the drop down menu.

Note: Subjects Map can contain only one Domain List per language.
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9 Select a Domain List from the drop down menu.

10 Click Add aline, to add Domain Lists for other languages.

Change the Default Subject Map

The default Subject Map is used to determine which Domain List is used to process user requests, when the
Subject is not specified for a request. To set the default Subject Map:

1 Select Default subject map from the Instance section of the Advanced Configuration Facility in
System Manager. The Editing: Dictionary screen displays:

Editing: Dictionary

default-subjectmap - ICugtgmerhelpl

2 Enter the name of the Subject Map created in Dictionary Manager in the default-subjectmap field.
3 Click OK. The changes are saved upon closing.
4 Restart Oracle Knowledge.

For more information on the Advanced Configuration Facility, please see Oracle Knowledge Intelligent
Search Administration Guide.

Oracle Knowledge Language Analysis

Oracle Knowledge performs language analysis during both content processing and request processing.
Content processing is the means by which Oracle Knowledge collects, standardizes, and indexes the
application content. Request processing is the means by which Oracle Knowledge Intelligent Search
processes and responds to user requests.

During content processing, Intelligent Search identifies the concepts that occur in the application content,
performs additional semantic analysis, and records the resulting information as a set of indexes.

During request processing, Intelligent Search determines the context, conditions, and concepts that occur in
user requests by matching the content of the request against the information in the Dictionary. It uses that
information to construct a set of criteria that defines the best possible responses to the request. It then
matches the best answer criteria to the content indexes, and retrieves the corresponding documents from the
Content Store for display to the end user.

Language Analysis Components

The Oracle Knowledge components that interact to perform language analysis include:
» The Content Store, which stores the application content and associated data

» The Language Analyzer, which performs basic semantic analysis of both user requests and application
content
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» The Dictionary, which contains the Concepts and Rules that set the criteria for the best possible answer

e The Rules Engine, which matches user requests to Rules by comparing request content to business
conditions and language conditions, and generates a list of actions that the application must perform to
generate the best possible response.

» The Evaluator, which scores and ranks the results of the various actions

The Language Analysis Process on page 31 describes the interaction of the language analysis components
during request processing.

The Language Analysis Process

Oracle Knowledge performs language analysis during both content processing and request processing.

During content processing, Oracle Knowledge collects, standardizes, and indexes the application content.
The Language Analyzer analyzes each word in the content and establishes its relationship to:

* The Concept information defined in the Dictionary
» The structure of the document in which it is located

The Language Analyzer stores the resulting semantic information in the Content Store for use during request
processing.

During request processing, the Language Analyzer:

» Analyzes the request using the Concepts stored in the Dictionary
and the Rules Engine:

» Evaluates the request using the Rules stored in the Dictionary

» Compiles the list of actions, which are potential application responses to the request
The Evaluator:

» Evaluates the actions, and ranks the responses based on their scores, as described in The Scoring
Process on page 33

» Formats the responses for display by the User Interface

The Content Store and Indexes

During content processing, the Language Analyzer analyzes each word in the unstructured application
content. The Language Analyzer stores the results of its analysis as a set of indexes.

Analyzing Requests

When a user submits a question or request using Intelligent Search, the User Interface passes the request to
the Rules Engine. The Rules Engine creates a sentence object that contains the user input and additional
user profile and session information.

During sentence object creation, the Rules Engine calls the Language Analyzer. The Language Analyzer
identifies the basic linguistic and semantic components of the user request. This information is used by the
Rules Engine during request evaluation.

The Language Analyzer also resolves the meaning of pronouns and other implicit references to concepts that
occurred in previous requests within the session, as described in Evaluating Anaphora on page 35.
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Evaluating Requests

The Rules Engine evaluates the sentence object against the set of Rules contained in the Dictionary. The
Rules specify language and business conditions that potentially match various aspects of user requests as
described in:

» Language Conditions
» Business Conditions

The evaluation process includes the phases described in:
» Evaluating Spelling on page 32
» Evaluating Business Conditions on page 32
» Evaluating Language Conditions on page 32

EVALUATING SPELLING

The Rules Engine evaluates the spelling of the words in the sentence object using a packaged spelling
checker program. For more information on the spelling checker program, see the Oracle Knowledge
Intelligent Search Administration Guide.

EVALUATING BUSINESS CONDITIONS

Business Conditions are special conditions within Rules that match contextual information about the user or
the current session. During request processing, a component called the Preference Service collects
contextual user and session information from configured sources, and adds this information to the sentence
object.

Note: You must have the Business Rules module installed to use the Preference Service and Business
Conditions within Rules.

The Rules Engine uses the information added by the Preference Service to evaluate Business Conditions,
and matches only Rules whose conditions are met by the information in the request.

The Rules Engine evaluates Rules with matched Business Conditions and Rules that do not specify Business
Conditions for language conditions, and eliminates Rules with Business Conditions that do not match.

See Chapter A, Configuring Access to Business Data for more information on the Preference Service and
accessing session and user context information.

EVALUATING LANGUAGE CONDITIONS

Language Conditions are conditions within a Rule that match the content of the user request.

Note: The Rules Engine evaluates Language Conditions only for Rules having true or no Business
Conditions. See Evaluating Business Conditions on page 32 for more information.

You set Language Conditions within Rules to specify actions based on the language content of the user
request. The content that you can configure to match includes actual words and phrases, as well as, the more
general meaning or intent. You can specify Language Conditions in the form of question patterns specified in
IML, as described in Question Patterns

The Language Analyzer performs additional analysis on various semantic elements (words and phrases) as
requested by the Rules Engine during this phase.
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Defining Response Criteria

The Rules Engine defines response criteria by creating a list of the actions specified by the Rules that are true
for the request. Rules can specify one or more of several types of actions, as described in Types of Actions
on page 33.

The list of actions associated with a particular request constitutes the criteria for determining:
» The information retrieval methods and strategy

» The supplemental responses displayed in the Personalized Response User Interface answer portlets

TYPES OF ACTIONS
Rules can specify both information retrieval actions and actions that affect how the Rules Engine processes
the current Rule or subsequent Rules. Information retrieval actions include:
» Searching the indexed content in the Content Store
» Executing a structured data query
* Displaying custom content
« Displaying glossary definitions
Rule processing actions include:
 Setting an attribute for use in Business Conditions

» Restarting the request-response process with a new question

See Types of Actions on page 33 for more information on the types of information retrieval actions you can
specify.

Evaluating Actions

The Evaluator analyzes the actions in the action list by ranking the responses they produce by their response
scores. The high-scoring results represent the best available responses to the user request, which are
displayed in the appropriate display area of the User Interface.

The Oracle Knowledge Personalized Response User Interface displays responses in the various portlets
based on the answer purpose specified in the Rule that generated the response. See Answer Purposes for
more information on specifying answer purposes in Rules.

The Scoring Process

Response scoring begins when the Evaluator processes the action list associated with a request. The action
list can contain a large number of actions, including Search Components that specify multiple search criteria.

During action evaluation, the Evaluator considers every word in the indexed content as a potential match for
the search criteria contained in the action list. A question generally has multiple responses, and each
response that the Evaluator identifies has an associated document excerpt, which is the compiled text that
the User Interface displays as an answer on the results page.

Note: Frequently accessed index data is maintained in cache memory, as is common practices for
information retrieval systems.
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To determine response scores for results, the Evaluator:

» Matches the search criteria to the words within the indexed content, and generates a score for each
associated excerpt, as described in Access to Preference Data on page 182

» Evaluates document metadata associated with each excerpt to determine document recency and
document relevance scores, as described in The Document Relevance and Recency Scores on
page 34.

» Uses a weighted averaging technique to combine these elements into a final score, as described in
Relative Weights.

Each excerpt that the application generates as a response receives a score. Each response's score is made
up of several score values, which the application combines and weighs to calculate the total response score.
The response score range is from 0 to 1.0, with 1.0 being the highest possible score.

Search Component Scores

Each Search Component has a specified score value, which is an indicator of its value in relation to the
condition with which it is associated.

Each Search Component range is associated with one or more excerpts defined by the Excerpt Service. A
given excerpt can contain multiple search components of varying values.

The Evaluator calculates a score for each excerpt based on:
» The scores of the Search Components that the excerpt contains

» The proximity of the Search Components within the excerpt

Excerpts that contain enough high value search components are considered candidate responses. The
Evaluator then calculates the document relevance and recency scores for the candidate excerpts.

The Document Relevance and Recency Scores

Each excerpt is associated with a document. During content processing, the application indexes information
about:

e Each document's popularity and relevance within the collection.

The relevance value for a document is calculated based on link analysis and density of the search terms.
This value cannot be set manually. You can see a document's relevancy score in the Unstructured
results in Test Drive when it is returned as a search result. Launch Document Search type rules use this
value to set the relative weights of relevance and search components. The default weight for relevance
is 0.000001% in the installed Launch Document Search Rule.

» The last update to the document.

The Evaluator assigns document relevance and recency scores based on this information. The Recency
score relies on the date/time stamp of a file. The relevance and recency scores are combined and weighed
with the Search Component score to determine the total response score. The relative weights for response
sub-scores are determined by global settings in the application configuration, as described in the Oracle
Knowledge Intelligent Search Administration Guide, or by settings specified within Rules that override the
global settings for this response as describe in Add Relative Weights on page 8.
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Note: This relevance weight should always have very low importance since it functions as a tie breaker in
finding default search results. For the size of the content searched on a given site, factors like link analysis
don't indicate relevance as reliably as they do when searching the whole web. The most important factor is
the search components, which match words in the query with words in the content.

Evaluating Anaphora

Oracle Knowledge can process requests in which an important concept that occurred in a previous request is
replaced by a substitute word or phrase. The term anaphora refers to the relationship between the
grammatical substitute (usually a pronoun such as It) and the previously occurring concept.

During language analysis, Oracle Knowledge resolves anaphoric expressions by matching the substitute
word or phrase with the correct concept occurring in a previous request, and annotating the current request
with the concept information for its predecessor.

For example, an initial request:
Where can | buy a <product>?

might be followed by:
Does it come in blue?
The Language Analyzer processes anaphoric expressions by:

« Creating a list of candidate concepts, or salience list, for each user request, as described in Creating
the Salience List on page 35

» Determining that a word or phrase refers to a concept that occurred in a previous question, as described
in Identifying Anaphoric Expressions on page 36

» Matching the referring expression to the correct concept, as described in Resolving Anaphoric
Expressions on page 37

» Annotating the relevant portion of the request for use by the Rules Engine, as described in Annotating
the Anaphoric Expression on page 37

CREATING THE SALIENCE LIST

The Language Analyzer creates a salience list for each request that it processes. The salience list contains
concepts that occur within the question that are potentially useful for resolving anaphoric expressions within
subsequent requests.

Important! The Language Analyzer does not perform anaphora resolution for the first question in a
session, as there is no previous question, and therefore, no salience list.

The Language Analyzer adds Concepts to the salience list if:
» The Concept is part of a noun phrase
» The Concept is not a determiner or a pronoun

Note: Pronoun Concepts are added to the salience list only when the Rules Engine has annotated a
Concept from a previous anaphora resolution. This level of annotation enables the Language Analyzer to
resolve anaphoric expressions within requests that are twice or more removed from the original Concept
occurrence.

» The Concept priority level exceeds a minimum threshold. See Concept Priority Levels for more
information on Concept priority levels.
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The Language Analyzer partially orders the candidate concepts within the salience list using the following
criteria:

» Search Component score. See The Scoring Process on page 33 for more information on search
component scoring.

» Concept priority level
» Sentence position (Concepts having equal Search Component scores and Concept priority levels are
ordered according to their position in the request)
» Range length (concepts associated with a longer range of words within the request are ranked higher)
Note: The primacy of the Search Component score is based on the probability that concepts belonging to

industry and application domains, which usually have higher Search Component scores, are preferred
candidates for anaphora resolution.

The Language Analyzer stores the salience list with the session information so that it is available to the Rules
Engine for processing the next request.

IDENTIFYING ANAPHORIC EXPRESSIONS

The Language Analyzer identifies referring expressions using the InQuira Match Language (see Chapter 4,
IML Reference for more information on IML). The anaphora-specific IML expressions match referring
expressions, and eliminate non-referring pronoun expressions by testing each word in the question against
the following criteria:

Expression Definition Examples

it (pronoun) The word I, except when used existentiall, |Does it come in blue?
as in the phrase iSit true that... or what
does it mean when...

deictics Words that are direct indicators. Currently Where can I buy this?
defined deictic words are:

Are there any cheaper

e this than these?

e that

e these

e those
deictic noun Noun phrases formed from the defined Do you have this
phrases deictics. product type in blue?

When the Language Analyzer identifies a referring expression, it:

» Determines the head of the expression, as described in Determining the Head of the Anaphoric
Expression on page 36

» Tests whether the referring expression can be resolved within the current request, as described in
Testing Referring Expressions Within the Current Request on page 36

DETERMINING THE HEAD OF THE ANAPHORIC EXPRESSION

The Language Analyzer determines the head of the referring expression. For single pronouns, the head of the
expression is the pronoun itself. For noun phrases, for example, the car, the Language Analyzer
determines car to be the head.
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TESTING REFERRING EXPRESSIONS WITHIN THE CURRENT REQUEST

The Language Analyzer checks whether the referring expression can be resolved within the current sentence
by:

» Creating a salience list for the current request
» Checking that each member of the salience list occurs prior to the referring expression (with no overlap)

» Checking that and all semantic constraints apply

If the Language Analyzer locates a valid concept within the current sentence's salience list, it uses that
concept to resolve the referring expression, and anaphora resolution is complete. For example, in the
following request:

In the <product>, does it come with air conditioning standard?

the pronoun it resolves to the concept associated with <product>.

RESOLVING ANAPHORIC EXPRESSIONS

The Language Analyzer resolves anaphoric expressions by checking the previous request's salience list to
locate any concepts that fit semantically with the referring expression. It checks each noun phrase candidate
concept (such as the car or this car) in order, for semantic constraints. If the semantic constraints fail, it
then checks the next list member.

The Language Analyzer locates concepts for anaphora resolution using concept relations defined in the
Ontology. The Language Analyzer uses internally defined methods to locate the appropriate type of or part
of relation for a referring expression. For example, the expression the car refers to a specific type of car,
model name, that occurred in the previous request; and the expression the wheel refers to a part of the
car, model name, that occurred in the previous request. See Oracle Knowledge Language Analysis on
page 30 for more information.

A candidate concept can resolve only one referring expression in a request. The Language Analyzer removes
concepts from the list once they are used to resolve an anaphoric expression.

ANNOTATING THE ANAPHORIC EXPRESSION

The Language Analyzer completes the anaphora resolution process by applying the #ANAPHORA label over
the range of the request that contains the original referring expression. See Language Analysis Labels on
page 168 in the Oracle Knowledge Language Tuning Guide for more information on the types of labels that
the Language Analyzer assigns during language analysis.

ORACLE KNOWLEDGE INTELLIGENT SEARCH OPTIMIZATION GUIDE ORACLE



CHAPTER 2

Process Wizards

Important! Process Wizards functionality has been replaced with the Oracle Knowledge AnswerFlow
application. Please refer to the Oracle Knowledge AnswerFlow Implementation and User’s Guide for more
information.

You can create custom dialogs and implement them as answers that display in response to specified
questions using Oracle Knowledge Process Wizards. A Process Wizard is a decision tree that walks the user
through a series of questions to either find the solution to a problem or to narrow the search for the answer to
their original question. The Process Wizard feature automatically responds to specified user requests by
presenting a sequence of steps that:

* Solicit more specific information from users

» Present the specific information they are seeking

» Optionally perform a search based on the information provided through the dialog
The User Interface presents Process Wizard dialogs as answers to specified questions based on custom
dictionary rules that you define. When users ask questions that match Process Wizard rules, the User
Interface presents a specially formatted answer on the answer page. When users select the process wizard

answer, the User Interface presents the Process Wizard steps, and uses the information in the user's
responses to present the desired information or to refine the initial query and perform an additional search.

For example, you could create a Process Wizard about billing problems consisting of multiple steps designed
to diagnose and present solutions based on additional information provided by the user, and create a
Dictionary rule to present the process as an answer in response to questions about billing problems.

When users submit a request that matches the process rule, for example, a request containing the phrase
retrieve messages:

Find Answers

Type a question or describe what you are looking for below

|H|:|w can I retrieve messages? Ak
Example: "Does Product-% have Feature-v?" Ti

The User Interface displays a special Process Wizard answer at the top of the answer page:
Find Answers

Type a question ar describe what you are looking for belaw

|h|:uw can i retrieve messages Ak
Exarmnple: "Does Product-» have Feature-v?" Tips
Answers

Q Help Retrieving Messages

Hawving problems retrieving messages? Let us quide you throagh it,
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When a user selects the Process Wizard answer, the User Interface displays the initial step of the process
that you have created to diagnose and resolve the user's specific problem related to retrieving messages:

Help Retrieving Messages
Hawving problems retrieving messages? Let us guide you through it,

» Start over

Your Responses
To read e-mail in your online mailbox
What kind of message are you trying
to retrieve?

Email Message 1. Click the Read icon on the toolbar.

2, 0On the Mew tab, double-click the first e-mail item to read it.
From whare are you trying to retrieve
WOUF MEessages?

From your home computer

= Back Finish

Implementing the Process Wizard Feature

You implement Process Wizards within your application by:

 Creating one or more process wizards using the Process Wizard Editor application of the Oracle
Knowledge Language Workbench, as described in Creating Process Wizards on page 85.

» Creating or modifying Dictionary rules to invoke the process wizard in response to user requests, as
described in Creating Dictionary Rules to Invoke Process Wizards on page 103.

The default User Interface contains page templates to display process wizard answers, as described in The
Process Wizard User Interface on page 104; no User Interface customization is required to implement
Process Wizards.

Important! For quick assistance in creating and implementing a basic process wizard, see the tutorial,
Tutorial: Creating a Process Wizard on page 65, which describes in detail how to create a process wizard to
assist users in retrieving messages from a hypothetical email, voice, and instant message system.

Process Wizard Elements

A Process Wizard contains various elements that you create and define using the Process Wizard Editor.
Elements within a process include:

» Process steps, which are the individual modules that are presented to the user in the Process Wizard
User Interface, as described in Process Wizard Steps on page 51.

 Fields within the process steps, which contain the text and user option elements that provide information
and solicit user responses, as described in Process Wizard Fields on page 51.

» Conditions and transitions, which are the logical framework for determining the navigation through the
process based on the options selected by the user, as described in Process Wizard Conditions and
Transitions on page 51.

e The process wizard User Interface components, which include a special answer format, and special
Process Wizard presentation pages, as described in Process Wizard User Interface Elements on
page 52.
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Process Wizard Steps

A Process Wizard consists of any number of process steps that you design and create to:
* Solicit information from end users

» Guide end users to specific information

Process steps are individual components that consist of any number of fields that you can define. Fields
within process steps include text fields to provide information and option fields that display options or accept
input from users as they progress through a process.

See Creating Process Steps on page 87 for more information.

Process Wizard Fields

Fields within process steps include text fields to provide information and option fields that display options or
accept input from users as they progress through a process.

You can define individual fields that are specific to a process as well as shared fields that you can re-use in
multiple processes or use as templates to easily create variants of common types of fields.

See Defining Fields on page 92 and Creating Shared Fields on page 97 for more information.

Process Wizard Conditions and Transitions

You connect process steps to one another by specifying conditions and transitions. Conditions correspond to
the various user options presented within a step, and transitions are the method of connecting to the next
logical step in the process based on a selected condition.

You define conditions and transitions by:
» Creating a condition for each user option in a step

» Associating a transition with each condition

See Defining Conditions on page 101 and Defining Transitions on page 102 for more information.
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Process Wizard User Interface Elements

The process wizard User Interface components include the special answer format that displays in the
standard answer area when a user request matches the process wizard rule, the pages that correspond to the

steps within the process, and a side-bar that summarizes users' responses as they progress through the
process wizard.

See The Process Wizard User Interface on page 104 for more information.

Accessing the Process Wizard Editor

You access the Process Wizard Editor from the Dictionary Manager application of the Oracle Knowledge
Language Workbench, using any of these methods:

1 Select the Process Wizard icon , on the Dictionary Manager toolbar
2 Select Process Wizard Editor from the Dictionary Manager Tools menu
3 Select Display Process Wizard Editor from the Tools menu of a Dictionary rule

If there are no process wizards currently defined, the Process Wizard Editor displays a dialog that prompts
you to create a directory to contain the initial process wizard information:

4  Enter a directory name, or accept the default value (pw_1), and select OK
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The Process Wizard Editor displays a new process wizard, or the most recently accessed process
wizard if any exist.

Process Wizard Editor =] B3 I
File Tools
Process Wizard: I.-'-\ccount Status LI Step: IUsed LI I LI Shared Fields |
Account Status 4 Process Wizard Inspector

Process ID:AccountStatus

Process I"‘a""'E:I.-'-\ccount Status

First Sbep:l 1A (<New Step>) x| MewFirstStep |

‘Wizard Description (HTML)
=

=l
Editl OK | Cancel |
Default Step
Label: IThanks!
Message (HTML)
If vour question was not answered, i’
please call our Customer Support.
=
Editl OK | Cancel |
Preview Default Step in Browser I

[~ Show Conditions [~ Size to Fit Save Process Wizard |

See Using the Process Wizard Editor on page 54 for more information.
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Using the Process Wizard Editor

The Process Wizard Editor displays in a separate window from the Dictionary Manager.

Note: You can close the Process Wizard Editor without affecting the Dictionary Manager; however, closing
the Dictionary Manager also closes the Process Wizard Editor.

The Process Wizard Editor display is divided into two sections:

» The Graphic View, as described in The Graphic View on page 55

e The Inspector View, which initially displays the Process Wizard Inspector, and which you can toggle to
display the Process Step Inspector and the Shared Fields Inspector. (See The Process Wizard
Inspector on page 58, The Process Step Inspector on page 59, and The Shared Fields Inspector on
page 64 for more information.)

You can change the relative sizes of the graphic view and wizard inspector by selecting and dragging the
dividing bar to the left or right as needed. You can expand either of the areas completely by selecting the
appropriate arrow icon located on the divider.

The Process Wizard Editor displays the following functions above the graphic view and wizard inspector:

Process Wizard E ditor

Function

Description

Process Wizard

Use this to select an existing process wizard. The Process Wizard
Editor selects the most recently accessed wizard by default.

New Wizard

Use this to create a new Process Wizard.

Step

Use this field to display any of the defined process steps from the
used and unused steps lists. Used steps are those that are
included in the current process. Unused steps are defined steps
that are not currently included in the process.

Shared Fields

Use this field to view, create, and modify fields that are intended for
use in multiple processes, as described in The Shared Fields
Inspector on page 64 and Creating Shared Fields on page 97

ORACLE KNOWLEDGE INTELLIGENT SEARCH OPTIMIZATION GUIDE ORACLE



55 USING THE PROCESS WIZARD EDITOR

The Graphic View

The Process Wizard Editor graphic view displays the selected process wizard as an arrangement of:
» Labeled boxes representing the process steps

 Lines connecting the steps representing the transitions, for which you can also display labels indicating
the condition associated with each transition.

Process Wizard Editor [_ (O] x|

File Tools

Process Wizard: IReh’ieving Messages vl Mew Wizardl Step: Iused LI I LI Shared Fieldsl

Retrieving Messages

Wik

!ntro Sel Message Type

Email-l_'ocation Eoicemail Location Enstant Message Solution

!DCEH Email Solution emote Email Solution Eocal Yoice Solution emote YWoice Solution

g [ Size toFit Save Process Wizard |

The steps are arranged within the graphic view as a tree, starting with the initial step. The graphic view
arranges the subsequent steps into rows; the row in which a step is displayed is determined by its transition
relationships; each step is displayed below all steps that transition to it.

Note: The layout of the steps and connections within the graphic view is automatically determined by the
data in the process inspector; you cannot directly edit the graphic view.
The Process Wizard does not support loops within solution paths.
The graphic view displays each process step as a rectangle, labeled with:
e The name of the step
e The step ID

1
g%trn Sel Meaﬁage Type
3

You can adjust the display size of the graphic view to fit more process steps into the screen using the Size to
Fit checkbox located near the bottom of the Process Wizard Editor display.
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Step Displays in the Graphic View

When the Process Wizard Inspector is active in the inspector view (see The Process Wizard Inspector on
page 58), the graphic view displays the process steps in cyan (blue-green). If you select a process step, the
inspector view displays the Process Step Inspector (see The Process Step Inspector on page 59) and the
graphic view displays the selected step in yellow.

You can select a step within the graphic view to display its data in the Process Step Inspector:
» Select (click on) a step in the graphic view

Pe

The Process Wizard Editor:
¢ Displays the step in yellow within the graphic view
e ser]
and

¢ Displays the step details in the step inspector

=hewy Steps=

Seect] Ty | Fiekd Name cfor Condtions) | actions

ttnl
[ |

— T —

4+ Replace with step description ***
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Note: You can toggle to the Process Wizard Inspector by selecting (clicking) anywhere in the background
of the graphic view when the Process Step Inspector is active.

PROCESS WIzARD EDITOR STEP IDENTIFICATION

The Process Wizard Editor maintains unique IDs for each process step. The step ID is composed of:
e The row number, which can be in the range of 1-99
A letter that corresponds to the step's column position within the row (A-Z)

For example, the third step in the second row has the ID: 2C.

Note: The step ID is based only on the step's position within the process, not its contents; moving a step
from one position in the process to another changes the step ID. The Process Wizard Editor automatically
arranges the steps within the process as you create or delete steps, conditions, and transitions.

Conditions and Transitions in the Graphic View

The graphic view displays transitions as lines that connect the process steps.

igmail Location el

:@7 3
ocal Email Solution (‘?%emute Email Solution

When you select a step, the Process Wizard Editor displays:

 Bold transition lines from the selected step
 Text that identifies the conditions that apply to each transition

%nice Locs

28 email_location = Aemail_location = remaote

3
(‘?%emote Email Salution

You can display all of the conditions for the process using the Show Conditions field located near the bottom
of the Process Wizard Editor display.

acal Email Salution
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The Process Wizard Inspector

The Process Wizard Inspector displays detailed information about the current process wizard.

=Mewy Process Wizard=
18 [=Mew Step=] |—

If your guestion was not answered,
please call our Customer Support.

The Process Wizard Inspector displays the following fields and functions:

Field Description
Process ID Indicates the internal name of the process wizard.
Process Name Specify the name of the process wizard. The User Interface displays

the contents of this field as the title of the link to the process wizard.

First Step Indicates the current first step in the process, and lists the additional
steps. You can change the first step using the First Step drop-down
menu or the New First Step button, as described in Creating a New
First Step on page 88 and Designating a New First Step on

page 89.

Wizard Description Specify an optional description of the process wizard. The
application displays the contents of this field as additional text in the
link to the process wizard.

The Process Wizard Inspector also displays information about the Default Step, as described in The Default
Step on page 59.
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The Default Step

Each process wizard includes a Default Step, which is a generic step that the Process Wizard displays when:
» There is a gap in the process created by a condition for which no transition is defined

» The user selects Next, without responding in a way that satisfies any of the step's conditions

You can customize the default step by editing the following fields:

If your question was not answered,
please call our Customer Support.

Field Description

Default Step Label Use this field to specify the name to display in the graphic view if this
step is explicitly specified in a transition. The default value is
Thanks!

Default Step Message | Use this field to specify plain text or HTML that the User Interface
displays to the end user. The default value is:

If your question was not answered,
please call our Customer Support

Note: The Default Step does not support user options, conditions, transitions, or the Next button.

You can display a preview of the default step using the Preview Default Step in Browser button. The Default
Step displays in a separate browser window.

The Process Step Inspector

You can view and modify the details of a process step using the Process Step Inspector.

You access the Process Step Inspector by selecting a step:
» From the Graphic View
» From either of the drop-down Steps menus at the top of the Process Wizard Editor
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s
Select|  Tye | FiekiName gor Condions) | actions

kil

u
T ——
=

##** Replace with step description ***

The Process Step Inspector displays the following functions and fields:

Function Description

Step ID Displays the step ID, as described in Process Wizard Editor Step
Identification on page 57.

Step Name Displays the step name, which is used only within the Process
Wizard Editor.

Step Fields tab Displays details for the fields defined for the selected process step,
as described in The Step Fields Tab on page 61.

Step Transitions tab Displays details for the transitions defined for the selected process
step, as described in The Step Transitions Tab on page 62.

Step Preview tab Displays a preview of the selected process step, as described in The
Step Preview Tab on page 63.

Preview Step in Click to display the current step as it is to be displayed in the default

Browser User Interface. The Process Wizard Editor displays the step in a

separate browser window, as described in Previewing Steps within a
Browser on page 91
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The Step Fields Tab

You can view and modify the fields within a process step using the Step Fields tab of the Process Step
Inspector. You can define various types of fields to provide information, present options, and accept input
from users as they progress through the steps in a process.

The Step Fields table displays one field on each line, and the last line of the table is always blank to accept
input to define a new field.

Select] __ Typs | Field Name (ror Condtions) | mctions|

Fitimil

[ |

———————

*#® B eplace with step description ***

You define a field by specifying the following parameters, as described in Defining Fields on page 92:

Field Description

Type Use this field to specify the field type, which can be a unique
instance of a field, or an instance of a shared field. The field type
determines the functionality of the field, as described in Specifying
Field Types on page 94.
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Field Name (For Use this parameter to specify a unique ID to use to refer to the field
Conditions) when specifying Conditions and Transitions, as described in
Defining Conditions on page 101.

Description Use this field to specify:

« markup and text for html fields
« markup and text for user option fields (checkbox, radio, select, text)

The Step Transitions Tab

You can view, create, and edit the transitions defined for a step using the Step Transitions tab. Transitions
determine the steps that are presented to users based on their response to one or more user options.

The Step Transitions table displays one transition on each line, and the last line of the table is always blank to
accept input to define a new transition.

Each transition corresponds to a condition; if you specify a transition that refers to multiple conditions, all of
the conditions must be true for the transition to occur (an AND relationship). You can specify that a transition
occurs based on any of multiple conditions being true (an OR relationship) by adding multiple transitions to
the same step.

You can add transitions to existing steps, or create a new step for a transition.

See Defining Transitions on page 102 for more information on using the Step Transitions fields and
functions.

The Step Transitions table displays the following fields for defining transitions and conditions:

Field or Function Description

Go To Step Use this field to select an existing step as the destination step for
this transition.
Actions Use the action Delete to delete the transition to its left. Use the

action New Step to create a new step as the destination step for
this transition.

You can drag and drop the transitions using the mouse on the Select column, to rearrange the transitions in
the Graphic View.

Conditions for Selected Transition
Field Name Use this field to specify the condition for the transition.

Op (Operator) Use this field to specify the operator to use as the basis of
comparison for the user response and the specified value.
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Value Use this field to specify the value to compare the user response to
evaluate the condition

The Step Preview Tab

You can display a draft view of the current step using the Step Preview tab.

The Step Preview tab displays a general HTML rendering of the step fields; however, it is not as complete as
the preview displayed in a separate browser window, as described in Previewing Steps within a Browser on
page 91.

The Step Preview tab provides an efficient way to verify the text and options of all the steps in a process. For
example, you can select the Step Preview tab, then select each step in the graphic view.

*H* Replace with step description ***
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The Shared Fields Inspector

You can view, create, and manage step fields that can be shared among multiple steps and processes using
the Shared Fields Inspector. Shared fields enable you to create and manage a central library of commonly
used fields and templates for use within process steps.

You can use shared fields:
¢ As standard fields shared among multiple process wizards
* As templates for creating similar fields

You access the Shared Fields Inspector from the Shared Fields button at the top of the Process Wizard Editor

window:
used (= 1o (<tew step=) =]

The Shared Fields Inspector lists all of the shared fields defined within your application. The last row of the
table is always blank to accept new shared field definitions.

about_help_wizards
radio sel_wizard_action

checkbox  [sgEteli e
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The Shared Fields table contains the following fields:

Field Description
Type Use this field to specifying the generic type of the shared Field.
Shared Field Type (for | Use this field to specify a unique ID to use to refer to the field when
Step Inspector) adding the field to a process step.
Description for Selected | Use this field to specify:
Field ,

« markup and text for html fields

« markup and text for user option fields (checkbox, radio, select, text)
Value Name (for Use this field to specify the value name for the option for use in
Conditions) specifying conditions and transitions.
Display Value Use this field to specify the value that displays for the option.
Default Use this checkbox to specify that this option is pre-selected when

this field is displayed to the user.

See Creating Shared Fields on page 97 for more information.

Tutorial: Creating a Process Wizard

This section guides you through the basic steps of creating a process wizard. This tutorial provides:
» Step-by-step instructions to design and implement a process for a hypothetical scenario
» Explanations of the selected options
» References to more detailed information about additional options and features

Scenario: Creating a Process to Assist Message Retrieval
In this scenario, we create a simple process to help end-users retrieve messages from a hypothetical service
that provides:
* Email
» Voice malil

* Instant messaging

In addition, the process also needs to account for the fact that users have the capability to retrieve voice and
email messages from:

» Their home location (computer or telephone)

* A remote location

To assist users in retrieving any type of message, from either location, we create a process consisting of
steps to:

» Determine the type of message the user is trying to retrieve
» Determine the location from which the user is trying to retrieve email or voice mail
» Present the appropriate solution based on the responses to the user options

ORACLE KNOWLEDGE INTELLIGENT SEARCH OPTIMIZATION GUIDE ORACLE



66 TUTORIAL: CREATING A PROCESS WIZARD

Note: Tutorial Review on page 84 contains an image of the completed process wizard as displayed in the
graphic view for your reference.
Designing the Wizard

To begin the process wizard we can design the process by creating a diagram showing the steps and
transitions that we want to include in the process:

Initial Step:
Message Type?
Info Step: Info Step: Solution Step:
Local or Remote Local or Remote
Email? Voice? Instant Msg

Solution Step: Solution Step: Solution Step: Solution Step:

Retreive Local Retreive Remote Retreive Local Retreive Remote
Email Email Yoice Yoice

Note: The process diagrams in this section are similar to, but not intended to represent exactly, the graphic
view displayed within the Process Wizard Editor.

Designing the Process Steps on page 67 describes the types of steps that are included in the process and
their arrangement within the process diagram.
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Designing the Process Steps

The process design diagram shows three types of process steps:

» The initial step, which is the entry point into the process wizard. The initial step is displayed when a user
selects a process wizard answer from the User Interface answer page. See Defining the Initial Step on
page 72 for more information.

« Information steps, which are intermediate steps that prompt the user for required information

 Solution steps, which provide the appropriate information or action in response to the information
entered by the user in previous steps

The process steps are arranged as a set of branching steps, connected to one another by lines that represent
the transitions based on the conditions defined within each step. Each set of connected steps represents a
path from the entry point to a solution.

Since there is a maximum of three steps from the entry point to a solution, we can label the rows of the
diagram 1-3. Within each row, we label the steps alphabetically, as shown in the following diagram:

1 A Initial Step:

Message Type?

=
L

Info Step: Info Step:
A Local or B Local or
Remote Email? Remote Voice?

3 A Solution Step: Solution Step: Solution Step: Solution Step:

Retreive Local Retreive C Retreive Local
Voice

Retreive

Email Remote Email Remote Voice

This labeling scheme is used by the Process Wizard Editor when arranging the steps defined within a
process.

Designing Step Fields on page 67 describes the basic process of designing the text and user options that
you define as fields within the various process steps.

Designing Step Fields

Each process step can contain multiple elements, such as introductory text, lists or menus of available
choices, and prompts for values. We add these elements as individual fields within the process steps that we
create.

For example, we might want our initial step to contain:

« Introductory text about the process wizard and the nature of the problem it is designed to solve
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» Text that prompts the user to specify the type of messages that they need assistance in retrieving
A set of radio buttons from which the user can select the appropriate type of message

The following table shows examples of these elements:

Field Type Example

HTML Text If you are having trouble retrieving your messages, this wizard
guides you to the right solution. Please take a moment to answer a
few questions, so that we can provide the right information to help
you retrieve your messages.

Radio Button Intro Text |What type of message are you trying to retrieve?
Radio Buttons » Email Message

» Voice Message

* Instant Message

The following graphic is an example of the step as we display to the end user:

;I
If you are having trouble retrieving your messages, this
wizard will guide you to the right solution. Please take
a moment to answer a few questions, so that we can
provide the right information to help you retrieve your
messages.
What kind of message are you trying to retrieve?
& Erail Message
O voice Message
O Instant Message

< Back Finish
=

Note: The Back and Finish buttons are automatically included within each step. When we add transition
steps from the initial step, the Next button automatically displays in place of the Finish button.

Designing Step Conditions and Transitions on page 68 describes how to design the conditions, which
correspond to the user options, and transitions, are the destination steps that correspond to each condition.

Designing Step Conditions and Transitions

The steps in our process are connected to one another by conditions, which correspond to the possible user
responses to the prompts within the process steps. Each condition is associated with a transition, which
determines the next step that displays in the process.

The following tables show the conditions and transitions that we create for our process. Each table represents
arow in the process diagram displayed in Designing the Process Steps on page 67. For each step within the
row, the Condition column lists the available user options and their transition steps.
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Note: The steps labeled Solution Step: (2C, 3A, 3B, and 3C) have no conditions and transitions, since they
are the final steps in the process.

Step Description Condition Transition
1A Initial Step: Message Type Email 2A - Local or Remote Email
Voice Mall 2B - Local or Remote Voice
Message
Instant Message | 2C - Instant Message Solution
2A Information Step: Local or Remote | Local 3A - Local Email Solution
Email Remote 3B - Remote Email Solution
2B Information Step: Local or Remote | Local 3C - Local Voice Message
Voice Message Solution
Remote 3D - Remote Voice Message
Solution
2C Solution Step: Instant Message N/A N/A
3A Solution Step: Local Email N/A N/A
3B Solution Step: Remote Email N/A N/A
3C Solution Step: Local Voice Msg N/A N/A
3D Solution Step: Remote Voice Msg | N/A N/A

Defining the Process Using the Process Wizard Editor on page 70 describes how to add the process to our

application.
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Defining the Process Using the Process Wizard Editor

To create the process we perform the following steps using the Process Wizard Editor:
» Define a new process, as described in Defining a New Process on page 70
« Define the initial step, conditions, and transitions, as described in Defining the Initial Step on page 72

 Define the intermediate information steps, conditions, and transitions, as described in Defining
Information Steps on page 76

 Define the solution steps, as described in Defining Information Steps on page 76

See Accessing the Process Wizard Editor on page 52 and Using the Process Wizard Editor on page 54 for
more information on accessing and using the features of the Process Wizard Editor.

Defining a New Process

To define a new process:
1 Start the Process Wizard Editor, as described in Accessing the Process Wizard Editor on page 52

The Process Wizard Editor selects the most recently accessed process wizard. If no process wizards are
currently defined, the Process Wizard Editor prompts you to name the directory for the initial process wizard
data.

2  Enter the directory name and select OK

B
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The Process Wizard Editor displays a new process wizard:

Process Wizard Editor o] x|

S1 Newwas| e fer DI =] srarsaries|

|=Mew Process Wizard=
14 (aew Step=) |

If wour question was not answered,
please call our Customer Support.

If there are existing process wizards, the Process Wizard Editor displays the most recently accessed
wizard. If so, create a new process wizard:

3 Select the New Wizard button

Process Wizard Editor

4 Enter a unique ID and select OK

Fetrieving Messages|

g || conee |

5 Enter the name of the process wizard in the Process Name field:

Fetrieving Messages
14 (<Mew Step=) | ¥

Note: You can save the new process at any time using the Save Process Wizard button located below the
process diagram window.
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Next, we define the initial step in the process definition area, as described in Defining the Initial Step on
page 72.

Defining the Initial Step

In this section, we create the initial step, and define within it the following fields:
* Introductory text about the process wizard and the nature of the problem it is designed to solve
» A set of radio buttons from which the user can select the appropriate message type

To define the initial process step:

1 Select 1A(<New Step>) the graphic view

g

The Process Wizard Editor displays the Process Step Inspector.

2 Enter a new name in the Step Label field:

Intro Sel Message Type|

We can now define the text field for our introductory text, as described in Defining the Introductory Text Field
on page 73.
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DEFINING THE INTRODUCTORY TEXT FIELD

We define the introductory text field using the Step Fields tab of the Process Step Inspector. The introductory
text introduces the wizard to the user.

The Step Fields table contains a default entry for an html field, which we edit for our process. To edit the
default entry:

1 Since this field is informational, there are no conditions to specify. Leave the Name (For
Conditions) column of the default html entry blank:

2 Select the Edit button below the Description field, and enter the introductory text:

Ifyou are having trouble retrieving your messages, this wizard will guide you
tothe right salution. Please take a moament to answer a few guestions, so
thatwe can provide the right infarmation to help yau retrieve your messages.

Note: You can enter any valid text formatting html in the Description field.
We can now define the user options field for the initial step, as described in Defining the User Options for the
Initial Step on page 73.

DEFINING THE USER OPTIONS FOR THE INITIAL STEP

We define the user options field by creating a new field in the Step Fields table. The user options field prompts
users to select the type of message for which they need assistance from a set of radio buttons.

To create a new field for the user options:

1 Select the empty field below the introductory text field by clicking in the Type column, and select
radio from the drop-down list:

] O | N e e e

|

checkhox
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2 Select the Field Name (for Conditions) column and override the default field name by entering a
meaningful field name for the condition, which prompts users to select a message type:

il

radio [JEEEREERE | EEEE

See Defining Conditions on page 101 for more information.

3 Enter the Description for the user options field:

What type of messade are yau trying to retrieve?

4  Enter condition value names and values for the email, voice message, and instant message options

Note: You can use the checkbox in the Default column to specify that an option is selected by default when

the step displays. For this process, we assume that the email option is the most likely user response and
should therefore be selected by default.

Value Name (For Condition) Value Default
email Email Yes
voice Voice No
instant Instant Message No

ermail Email meszage
wvoice Woice message [ _
instant Instant mezsage [ -

We can now display a preview of our initial step, as described in Previewing the Initial Step on page 75, then

continue defining our process by specifying transitions to the various information steps, as described in
Defining Information Steps on page 76.
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PREVIEWING THE INITIAL STEP

We can display a preview of the initial step:
» By selecting the Step Preview tab of the Process Step Inspector:

If vou are having trouble retrieving your messages, this wizard will
guide you to the right solution, Please take a moment to answer a
few guestions, so that we can provide the right information to help
you retrieve your messages.

What type of message are you trying to retrieve?

Ernail message

oice message

uInStant message

By selecting the Preview Step in Browser button near the bottom of the Process Step Inspector
screen:

@ weshlLocal SettingshTempworkbench_ 33652, himl |_

If vou are having trouble retrieving your messages, this
wizard will guide you to the right solution. Please take
a moment to answer a few questions, so that we can
provide the right information to help you retrieve your
messages.

What type of message are you trying to retrieve?
& Erail message

O voice message

O Instant message

<Back | Finish

Note: See Previewing Steps on page 90 for more information on displaying previews of process steps.

We can now continue creating the process by defining information steps, as described in Defining
Information Steps on page 76.
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Defining Information Steps

In this section, we define a step that presents user options to solicit the required information from end-users.
In Defining the Initial Step on page 72, we created our initial step, which asks users to specify the type of
message that they need help retrieving. In order to direct users to the appropriate solution for the type of
message they are interested in, we need to define steps to determine whether users need assistance:

» Retrieving email messages from their home location or from a remote location
 Retrieving voice messages from their home location or from a remote location

Note: Users who select the instant message option transition directly to the instant message solution step,
as described in Defining the Instant Message Solution Step, since there is no distinction between home and
remote locations when receiving instant messages.

For this tutorial we create the email location step, which prompts users to specify whether they are trying to
retrieve messages from their home location or from a remote location.

DEFINING THE EMAIL MESSAGE LOCATION STEP (STEP 2A)

To define a step that prompts users to specify whether they need assistance retrieving email messages from
their home computer (local), or from another computer (remote):

1 Create a new step, as described in Creating the Email Location Step on page 77.

2 Specify the condition that we want to associate with the new step, as described in Specifying the
Condition for the Email Location Step on page 77.

3 Define the fields within the new step, as described in Specifying the Email Location Step Name on
page 78.
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CREATING THE EMAIL LOCATION STEP

We create the email location step using the New Step function of the Process Step Inspector's Step
Transitions tab:

1 Select the initial step (12)

1
g%tm Sel Mesrgage Type |
3

The Process Wizard Editor displays the Process Step Inspector

2 Select the Step Transitions tab and select the New Step button

The Process Wizard Editor creates a new step with the default name 2A (<New Step>).

We specify the conditions for the email location step, as described in Specifying the Condition for the Email
Location Step on page 77.

SPECIFYING THE CONDITION FOR THE EMAIL LOCATION STEP

To define the transition from the initial step to the new email location step, we specify the condition using the
Conditions for Selected Transition table of the Step Transitions tab.

We use the Field Name and Value Names that we defined in Defining the User Options for the Initial Step on
page 73 to specify that the transition to the email location step occurs when users select the email option on
the initial screen.

1 Select the Field Name column of the Conditions for Selected Transition table, then select the field
1A.message_type from the drop-down list
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2 Select the Value column, then select the value email from the drop-down list

Note: The Process Wizard Editor selects the Operator (Op) = by default.
We can now specify the step name, as described in Specifying the Email Location Step Name on page 78,
and define the fields for the email location step.
SPECIFYING THE EMAIL LOCATION STEP NAME

To specify the name of the email location step, we use the Step Name field of the Process Step Wizard. To
define the step name:

1 Select the step 2A(<New Step>) the graphic view

e

The Process Wizard Editor displays the Process Step Inspector.

2  Enter the new name in the Step Label field:

Email Location

We can now define the text field for our introductory text, as described in Defining the Introductory Text Field
for the Email Location Step on page 79.

ORACLE KNOWLEDGE INTELLIGENT SEARCH OPTIMIZATION GUIDE ORACLE



79 TUTORIAL: CREATING A PROCESS WIZARD

DEFINING THE INTRODUCTORY TEXT FIELD FOR THE EMAIL LOCATION STEP

We define the introductory text field for the email location step using the Step Fields tab of the Process Step
Inspector. The introductory text asks the user to specify whether they are trying to retrieve local or remote
messages.

The Step Fields table contains a default entry for an html field, which we edit for our process. To edit the
default entry:

1 Select the default html entry

2 Select the Edit button below the Description field, and enter the introductory text:

Pleaze tell us where you trying to retrieve your email

Note: You can enter any valid text formatting html in the Description field.

We can now define the user options field for the email location step, as described in Defining User Options
for the Email Location Step on page 80.
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DEFINING USER OPTIONS FOR THE EMAIL LOCATION STEP

We define the user options using the same processes described in Defining the User Options for the Initial
Step on page 73. The user options field for this step prompts users to select a radio button that corresponds
to the location from which they are trying to retrieve messages.

To create the user options field:

1 Select the empty field below the introductory text field by clicking in the Type column, and select
radio from the drop-down list:

I—lil—

I

checkbox

2 Select the Field Name column and override the default field name by entering an appropriate field
name for the condition:

radio ermail_location

See Defining Conditions on page 101 for more information.

3 Enter the Description for the user options field:

What type of message are yvou tryving to retrieve?

4  Enter condition value names and values for the local and remote options.

Note: You can specify that an option be selected by default; for this process, we assume that the local
option is the most likely user response and should therefore be selected by default.

Value Name (For Condition) |Value Default
local My regular computer Yes
remote A different computer No

Velue Name (for Conditio.. | vaue | Detaut actions|

local by reqular computer
rermote A different computer (|

You can use the same processes to define the corresponding voice mail location step (2B) and its fields.
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This tutorial continues with an example of a solution step, as described in Defining the Local Email Solution
Step on page 81.

Defining Solution Steps

In this section, we define a step that presents a solution based on selected user options. In Defining
Information Steps on page 76, we created the email location step, which prompts users to specify whether
they are trying to retrieve messages from their home location or from a remote location.

For this tutorial we create the local email solution step, as described in Defining the Local Email Solution
Step on page 81, which provides information about how to retrieve email from the user's regular home or
office computer.

DEFINING THE LOCAL EMAIL SOLUTION STEP

To define a solution step that provides information based on the specified user options in our process, we:
» Create a new step, as described in Creating the Email Location Step on page 77

» Specify the condition that we want to associate with the new step, as described in Specifying the
Condition for the Email Location Step on page 77

 Define the fields within the new step

CREATING THE LOCAL EMAIL SOLUTION STEP

We create the email location step using the same process as used in Creating the Email Location Step on
page 77, except that we create a step in the third row of our process by selecting the New Step function from
the email location step (2A):

1 Select the email location step (22)

%mail Location

The Process Wizard Editor displays the Process Step Inspector.

2 Select the Step Transitions tab and select the New Step button

The Process Wizard Editor creates a new step with the default name 3A (<New Step>).
3 Select the new step in the graphic view and rename it to Local Email Solution
We specify the condition for the local email solution step, as described in Specifying the Condition for the
Local Email Solution Step on page 81.

SPECIFYING THE CONDITION FOR THE LOCAL EMAIL SOLUTION STEP

To define the transition from the email location step, we specify the condition using the Conditions for
Selected Transition table of the Step Transitions tab.
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We use the Field Name and Value Names that we defined in Defining User Options for the Email Location
Step on page 80 to specify that the transition to the local email solution step occurs when users select the
local email option from the email location step.

1 Select the Field Name column of the Conditions for Selected Transition table, then select the field
2A.email_location from the drop-down list

Note: The Process Wizard Editor selects the Operator (Op) = by default. See Specifying Transition
Operators for more information.

We can now define the html field for the local email solution step, as described in Defining the Text Field for
the Local Email Solution Step on page 82.

DEFINING THE TEXT FIELD FOR THE LOCAL EMAIL SOLUTION STEP

The local email solution step contains only one field, an html field that explains how to retrieve email
messages from the user's home computer.

The Step Fields table contains a default entry for an html field, which we edit for our process.
To edit the default entry:
1 Select the default html entry

2 Select the Edit button below the Description field, and enter the solution text:
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Note: The following provides an example of simple html markup.

To retrieve e-mail messages in your online mailbox:
=g|=

=fol=

=li=Click the =b=Read Mail=ib= icon an the mail program toolbar.=/li=
=li=0n the =h=MNew=,=tah, double-click any email iterm to read it.=jli=

When you save the step, the Process Wizard Editor formats the html markup in the field:

To retrieve e-mail messages in your online mailbosx:

1. Click the Read Mail icon on the mail prograrn toolbar.
2. On the New tab, double-click any ermail item to read it.
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Tutorial Review

You have now completed the Process Wizard tutorial; note that we did not provide a detailed description of
creating each sibling step in each row; however, the following illustration provides a view of a completed
Process Wizard based on the scenario described in Scenario: Creating a Process to Assist Message
Retrieval on page 65 for your reference:

Process Wizard Editor =3 x|

rerimngtiossases =] ew Waard | =R <1 sharearies |

o sewesage e
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Creating Process Wizards

You create process wizards for your application using the Process Wizard Editor application in the Oracle
Knowledge Language Workbench to:

» Create a new process wizard that includes the step, field, condition, and transition definitions, as
described in Creating New Process Wizards on page 85.

 Define the individual steps within the process wizard, as described in Creating Process Steps on
page 87.

» Define the fields, conditions, and transitions within the steps, as described in Defining Fields on
page 92, Defining Conditions on page 101, and Defining Transitions on page 102.

Creating New Process Wizards

You can create new process wizards:

» Using the New Wizard button to create an empty process wizard, as described in Defining a New
Process Wizard on page 85

 Using the Save As New Process Wizard function to create a copy of an existing wizard, as described in
Copying an Existing Process Wizard on page 86

Note: The Process Wizard Editor assigns a unique internal ID to each process wizard in the form:
pw_<sequence numbers.

Defining a New Process Wizard

To define a new process wizard:

1 Select the New Wizard button on the Process Wizard Editor screen:

Process Wizard Editor

The Process Wizard Editor creates a new process wizard named New Process Wizard containing only
the default first step, 1A(<New Step>).
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Process Wizard Editor

o Process wizars [ =

e Process Wizard
[aiatow sepe) 21| New Fitstep|

If your gquestion was not answered,
please call our Customer Support.

2 Begin defining steps for your process wizard by overwriting the default step parameters and defining
additional steps, as described in Creating Process Steps on page 87.

Copying an Existing Process Wizard

You can copy an existing process wizard for use as a template to create additional process wizards, or for any
other purpose, using the Save As New Process Wizard function in the Process Wizard Inspector.

The Save As New Process Wizard button is enabled whenever a previously saved wizard is selected.
To copy an existing process wizard:

1 Select the process wizard in the Process Wizard Editor, then select the Save As New Process
Wizard button

N
L3

The Process Wizard Editor displays the New Process Wizard Name dialog:

2 Enter the desired name for the new process wizard and select OK

The Process Wizard Editor displays the new process wizard.
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Creating Process Steps

You can create process steps using the New Step function in the Step Transitions tab of the step inspector.

When you create a new step, the Process Wizard Editor:
¢ Automatically assigns the new step to the level below the step from which it was created
¢ Labels the step according to its level, and the order in which it was created

For example, the first step that you create from the default step is labeled 2A (<New Steps>). The next step
that you create at the second level is labeled 2B (<New Steps>), and the first step that you create at the
third level (child of 2A or 2B) is labeled 3A (<New Step>).

Note: You can also create a new top level step, as described in Creating a New First Step on page 88 or
Designating a New First Step on page 89.

To create a process step:
1 Select an existing step to be the parent of the new step

2 Select the Step Transitions tab, then select the New Step button

The Process Wizard Editor displays the new step, with the default label <New Step>:

Process Wizard Editor =10] x|
i Process wizard |3  2xFetreve tessages) [T

Retrieve Messages

%etrieve Messages
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3 To change the step label, select the new step and edit the Step Label field

Pmcess Wizard Editor = o]
e Proceco vizar =11 Newizad ercaew sy o]

Ernall Location

.
seect |  cotosen | actons]
I |

@mai\ Location

You can define fields, conditions, and transitions for the new step, as described in Defining Fields on
page 92, Defining Conditions on page 101, and Defining Transitions on page 102.

Creating a New First Step

You can create a new initial step for your process wizard using the New First Step function.

Note: When you create a new process wizard, the Process Wizard Editor automatically creates new step in
the initial position of the process, which you then modify, as described in Defining Fields on page 92,
Defining Conditions on page 101, and Defining Transitions on page 102.

The New First Step function is available only from the Process Wizard Inspector.

To create a new first step, select the New First Step button

iacstepty [ N
—

The Process Wizard Editor inserts a new first step above the current first step to the process, and re-labels
the lower level process steps.
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Designating a New First Step

You can designate an existing step as the new first step in a process wizard using the First Step menu of the
Process Wizard Inspector.

Fetrieving Messages
14 (Intro Sel Message Type) |—
AL Message 3] I

34 (Local Email Salution)
2B (oice Location)

2C (Instart Msg Solution]
3B (Remote Ernail Solution)
3C (Local Yoice Solution)
3D (Remote YWoice Solution])

The First Step menu lists all of the steps in the process wizard.

Important! You can specify any step as the first step in the process; however, the steps, conditions, and
transitions above the new first step are excluded from the process, and added to the unused step list.

To assign an existing step as the first step in the process, select the desired step from the First Step drop-
down menu

The Process Wizard Editor re-structures the process wizard, and adds any excluded steps to the unused
steps list.

Deleting a Process Step

You can delete steps from a process using:
» The Delete function of the step inspector
e The Delete Step function within the graphic view

Important! When you delete a step that is the only source of transitions to a subsequent step, the
transition is deleted and the subsequent step becomes an unused step, as described in Unused Steps on
page 90.

To delete a process step, select the Delete Step function of the Step Transitions tab within the Process
Wizard Editor:

24, (Ermnail Location)

Right-click the step within the process diagram area and select Delete Step

%mail Location
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The Process Wizard Editor deletes the selected step, and re-structures the process as necessary.

Unused Steps

The Process Wizard Editor allows you to define and save steps that are not used within the process. The
Process Wizard Editor classifies any step that is not accessible from the initial step by a series of transitions
as an unused step. You can display unused steps using the Steps menu.

Note: The Process Wizard Editor also displays unused steps as candidates for transitions, as described in
Defining Transitions on page 102.

To display an unused step:

1 Select Unused from the Process Wizard Editor Steps menu:

Steps: IUnusedLI IDA (Local Vaoice Solution) LI

0E (Femote Yoice Solution]

3= = == =

The Process Wizard Editor lists the unused steps.

2 Select an unused step to display its details in the Process Step Inspector

Previewing Steps

You can view the steps within a process wizard using:

» The Step Preview tab of the Process Step Inspector, as described in Previewing Steps within the
Process Step Inspector on page 90

e The Preview Step in Browser function, as described in Previewing Steps within a Browser on page 91

Previewing Steps within the Process Step Inspector

You can view the basic content and format of a step using the Step Preview tab of the Process Step Inspector.

The Step Preview tab displays basic formatting for selected steps; however, the HTML rendering is not as
complete as when viewed using the browser preview function.

This preview mode is useful for quickly reviewing a process by selecting the Step Preview tab, then selecting
multiple steps in sequence from the graphic view area.

To display a preview of a selected step, select the Step Preview tab

Step Fields I Step Transitions I Step Regview I

Select | Type | Fietd mame cror ¢... | Actions| Up| onl|
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The Process Wizard Editor displays the formatted contents of the current step:

Please tell us where you trying to retrieve your

amail.
I am trying to retrieve messages from:

My reqular computer

different computer

You can preview other steps in the process by selecting them in the graphic view.

Previewing Steps within a Browser

You can view detailed formatting for a single step using the Preview Step in Browser function of the Step
Inspector. The Preview Step in Browser function displays the current step in a separate browser window using

basic formatting.

To display a preview of a selected step, select Preview Step in Browser

ety Serpsar| Dok oo
_Save & New Process Wizard | Dolete Provess Wizard |
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The Process Wizard Editor displays the current step in a separate browser window:

; C:3\Documents and SettingsADTewesilocal SettingsiTem

EECH q B
@ C:\Documents and Settings D Tewes\Local Setlin

Please tell us where you trying to retrieve your email,

I am trying to retrieve messaqges from:
© My regular computer
O 4 different computer

< Back | | Mext =

Note: The <Back and Next > buttons are not functional in preview mode.

Defining Fields

You can define fields within process steps using the Step Fields tab within the Process Wizard Editor. Step
fields define the components of the step, such as informational text and user options that are displayed in the
User Interface.

The User Interface displays step fields in the order in which they are defined in the Step Fields table. The
bottom row of this table is always empty to accommodate a new option. You can change the order of fields
within a step by selecting the step to be moved using a Mouse Down in its Select column and dragging it to
the desired location then dropping it with a Mouse Up.

Note: When you create a new field, the Process Wizard Editor creates a default html field.
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To define a new field:

1 Select the Type cell in the last row of the Step Fields area, then select the desired Type for the new
field from the drop-down menu

Note: See Specifying Field Types on page 94 for more information on the types of fields you can
define within steps.

The Process Wizard Editor creates the selected field type, for example:

*#* Replace with step description ***

2 Specify the following additional parameters for the field:

Parameter Description

Name (For Conditions) |Use this parameter to specify a unique ID that you used to refer to
the field when specifying Conditions and Transitions, and any type-
specific attributes, as described in Defining Conditions on

page 101.

Description Use this parameter to specify:

« formatted text for html fields

« formatted introductory text for user option fields (checkbox, radio,
select, text)

Additional Attributes See Defining Conditions on page 101 and Defining Transitions on

page 102 for more information on the attributes associated with

each field type.

You can delete or change the order of fields within steps using the Delete and up and down arrows in the Step
Fields tab:

radio ProcessarType
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Specifying Field Types
You specify the Type for a field to determine whether the field is informational (html), or whether it presents
user options for use in setting conditions for subsequent step transitions.
The following table describes the available field types:
Type Description

checkbox Use this field to define a set of options where users can select one or
more options from the set by clicking in empty checkboxes. To specify a
checkbox field, enter:

« An optional heading or introductory text for the checkbox options in the
Description field

 Labels for each checkbox option in the Conditions Value field

« A brief Value Name for use in specifying transitions

« An optional default selection from among the options

See Defining Conditions on page 101 for more information.

Sample Checkbox Field:
Fitem a
Clitem &
Clitem ¢
Back Finish
html Use this field to define an informational field. You specify an html field

by entering any valid html in the Description field of the Step Inspector.
The User Interface displays the formatted html, for example:

Sample HTML Field...

Back Finish
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radio Use this field to define a set of options where users can select only one
option from a list of radio buttons. To specify a radio field, enter:

« An optional heading or introductory text for the radio options in the
Description field

 Labels for each radio option in the Conditions Value field
« A brief Value Name for use in specifying transitions

< An optional default selection from among the options
See Defining Conditions on page 101 for more information.

Sample Radio Button Field:
& item &
Clitem B
Clitem ¢
Back Finish
search Use this field to launch an Oracle Knowledge search based on the user

responses to the fields within the process wizard, as described in
Specifying a Search Action within a Step Field on page 97.

Sample Search Field:

| ]

Back || Finish |

The search option creates a search button on the Process Wizard Ul
which subsequently invokes the search.

select Use this field to define a set of options where users can select only one
option from the set. To specify a select field, enter:

< An optional heading or introductory text for the select listbox in the
Description field

 Labels for each selection option in the Conditions Value field

« A brief Value Name for use in specifying transitions

< An optional default selection from among the selection options
See Defining Conditions on page 101 for more information.

Sample Select List Field:
Iitem A, 'I
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text Use this field to define an area in which users can enter free-form text.
To specify a text field, enter:

« An optional heading or introductory text for the text field in the Description
field

< A label for the text field in the Conditions Value field
« A brief Value Name for use in specifying transitions

< An optional default selection from among the options
See Defining Conditions on page 101 for more information.

Sample Text Field:

Back Finish

Note: This is required for search steps. See search, above.

Note: The Type of CheckBox, Radio, and Select fields can be changed to either of the other two types with
Options without changing the options.
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Specifying a Search Action within a Step Field

To define a search action within a step field, you associate the search field with one or more context variables.
In the Field to Variable Map for selected Field section at the bottom of the Process Step Inspector, enter the
Field Name of each value to be attached to the original question when it is resubmitted and the Variable
Name it is to be assigned to.

Note: You must have context variables defined within your application.

The application resubmits the user's original question, that triggered the display of the Process Wizard, with
the context variables set with the values obtained by the previous Process Wizard steps.

Note: Itisimportant to add a Business Condition to the Rule that triggers the Process Wizard Answer to not
be true if any of the Context Variables, associated with this Process Wizard's Search fields are set;
otherwise the Process Wizard answer displays again.

When you specify a search field type, the Process Wizard User Interface replaces the Next or Finish button
with a button labeled Search.

Important! You can specify the search action only in the steps which have no transitions to other steps.

When an end user invokes search from the Process Wizard User Interface, the application submits a request
containing:

» The original question

» The context variables and their assigned values, specified for the Search Field invoked.

Creating Shared Fields

You can create, view, and modify shared fields for use within multiple Process Wizards. You can use shared
fields:

 As standard fields shared among multiple process wizards

» As templates for creating similar fields

Shared fields enable you to create and manage a collection of commonly used fields and templates for use
within process steps.

For example, you could define a global Yes/No radio button field, which you could use:
* Inits basic form wherever a simple Yes or No response is required
» As a template for defining Yes/No options that require additional information or qualification

You can also create shared fields containing a standard message and set of options for choices that are
presented consistently in multiple processes.

For example, you could create select fields for products, operating systems, or colors.
You define shared fields in the same way that you define basic step fields.

Note: You cannot define a shared field using the search field type; search field definitions require internal
mapping that is specific to the Process Wizard in which it is used.
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To define a shared field:

1 Select the Shared Fields button near the top of the Process Wizard Editor

| o

The Process Wizard Editor displays the Shared Fields Inspector.

2 Select the Type cell in the last row of the Shared Fields area, then select the desired Type for the new
field from the drop-down menu

Note: See Specifying Field Types on page 94 for more information on the types of fields you can
define within shared steps.
The Process Wizard Editor creates the selected field type, and supplies a default field name, for
example:

3 Specify the following parameters for the shared field:

Parameter Description
Shared Field Type (For |Use this parameter to specify a type name for use in the Step
Step Inspector) Inspector. The Step Inspector uses the value of this field to display

this shared field as an option in the Type menu, as described in
Adding a Shared Field to a Process Step on page 99.

Description Use this parameter to specify:

» formatted text for html fields

 formatted introductory text for user option fields (checkbox,
radio, select, text)

Value Name (For Use this field to specify a value name for each option within the set

Conditions of user options defined for this field.

Value Use this field to specify the text to display within the User Interface
for each condition name within the set of user options defined for
this field.

Default Use this field to specify whether this option should be pre-selected
by default.
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4 Save the shared field by selecting the Save Shared Field button.

The Process Wizard Editor saves the new shared field.

Creating a New Shared Field from an Existing Shared Field

You can create a new shared field from an existing shared field by modifying the existing field. To save the
modified field as a new shared field:

1 Selectthe Save as New Shared Field button:

|t g

The Process Wizard Editor displays a dialog that prompts you to specify a name for the new shared
field.

2 Enter the new name and select OK

The Process Wizard Editor adds the new shared field to the list in the Shared Fields Inspector.

Adding a Shared Field to a Process Step

You can add shared fields to a process step by selecting the shared field from the list of fields that display in
the Type column of the step fields tab. The Process Wizard Editor indicates shared fields by prefixing the field
name with the # character, for example:

#about_help_wizards
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To add a shared field to a process step:

1 Select the Step Fields tab for desired step, then select the Type field
The Process Wizard Editor displays the available shared fields in the list of field types:

about_help_wizards
sel_wizard_action sel_wizard_action_1
|§SEI wizard action

2 Select the desired shared field

The Process Wizard Editor adds the shared field to the selected step.

Using a Shared Field as a Template

If you want to use a Shared Field as a template, such as wanting to retain all of the options of the changed
field, but change its Description, you can add the shared field to your Step, as shown in Adding a Shared Field
to a Process Step, above, then clear the Shared Field checkbox, while the field is still selected. This changes
the reference to the Shared Field to a copy of the Shared Field and reverts its Type to the base Type of the
Shared Field. You can then modify the field, as needed, without affecting the Shared Field. Unlike having a
reference to the Shared Field in your step, any future changes to the Shared Field are not reflected in the

copy.

Creating a Shared Field from a non-Shared Field

Often, the first time you create a field in a step, you don't foresee needing a field with the same options,
description, etc. again. Then later, you realize that you need to create a field just like one you already created.

1 Find the original field that you would like to be a Shared Field, even if it is in another Process Wizard.
2 Select the field.

Select the Shared Field checkbox, in the lower-left corner of the Step Fields tab.

This prompts you to enter a Type name for the Shared Field,

Save the original field as a Shared Field.

Replace the original field with a reference to the Shared Field.

N~ o o0~ W

Save the Process Wizard with the original field, if different than the one you were working on, then go
back and create the new field by selecting the new Shared Field Type.

ORACLE KNOWLEDGE INTELLIGENT SEARCH OPTIMIZATION GUIDE ORACLE



101 DEFINING CONDITIONS

Defining Conditions

Conditions are parameters that you define within step fields that offer multiple user options. You use
conditions to specify the transition to the next step in the process for each user option. For example, a step
field that asks a user to select a processor type might specify a transition to a different step for each
possible response.

You specify conditions for the following types of fields:
» Checkbox
* Radio
» Select
You define conditions for the user option fields within process steps by specifying:
» The Field Name (For Conditions) field, as described in Specifying Condition Field Names on page 101

» An operation and a value in the Options for Selected Field table, as described in Specifying Condition
Values on page 101

Specifying Condition Field Names

To specify a field name for a condition:

1 Select the type of condition (checkbox, radio, or select)

The Process Wizard Editor automatically enters a default field name corresponding to the selected
field type:

2 Rename the field name, for example:

radio ProcessarType

3 Specify condition values for each user option in the field, as described in Specifying Condition Values
on page 101

Specifying Condition Values

You specify condition values by specifying:
» The condition value
* The display value
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» Whether an option is selected by default when the step is displayed
in the Options for Selected Field table.

To Specify condition values, enter appropriate values in the fields, for example:

Mot & Pertium

Parameter Description

Value Name (For Use this field to specify a value name for each option within the set of

Conditions) user options defined for this field.

Value Use this field to specify the text to display within the User Interface for
each condition name within the set of user options defined for this
field.

Default Use this field to specify whether this option should be pre-selected by
default.

Defining Transitions

Transitions are the mechanisms that determine the next step to display in the process based on a user-
selected condition. You specify transitions for the condition values (user options) that you define within a step.

Note: If you do not specify a transition for a condition, the Process Wizard displays the default step when a
user selects that condition.

You specify transitions using the Step Transitions tab of the Process Wizard Editor.
To specify a transition for a step:

1 Select the Step Transitions tab

2 Specify the following transition fields:

Field Description

Go to Step Use this field to select or create the step to which you want to
transition.

Actions Use this field to create a new process step for the transition, or to

delete a transition.

Conditions for Selected | This table displays the following fields to specify conditions:
Transition
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Field Name Use this field to specify the condition that applies to the currently
selected transition step (the Go to Step field).

Op (Operator) Use this field to specify an operator to evaluate the condition.

Value Use this field to specify the value that you want to apply to the

currently selected transition step.

Creating Dictionary Rules to Invoke Process Wizards

You configure a process wizard for use by the application by creating a rule that invokes the process wizard
as a response (action) to the appropriate user request and context (condition).

To create process wizard rule:

1 Create arule and define the rule's condition so that it matches the desired request(s) using the
Dictionary Manager, as described in Intelligent Search Language Tuning Guide, Chapter 2: Dictionary
Manager, Working with Rules on page 70 .

If the Process Wizard has any Search fields, you must add a Business Condition that keeps the rule
from firing if any of the Context Variables set by the Search fields are set; otherwise, when the question
is resubmitted, with the added Context Variable settings, the Process Wizard is displayed again.

2 Define the rule's action to invoke the desired process wizard, as described in Assigning the Process
Wizard Action to a Rule on page 103

Assigning the Process Wizard Action to a Rule

You assign the process wizard to a rule by specifying the rule's action using the Answer purpose and the
Process Wizard answer method.

Note: The Answer purpose is the only supported purpose for displaying process wizards in the User
Interface.

To specify the process wizard answer method:
1 Select the Answer purpose from the Purpose drop-down menu

2 Select Process Wizard from the Methods drop-down menu on the rule's Actions tab

Custom Content |—

Custom Content
Specific Excerpt
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The Dictionary Manager displays a drop-down menu of the process wizards currently defined in the
Dictionary.

prswer ] Process wizard [
ighest ]

Fetrieving Messages |—

Retrievin

3 Select the desired process wizard from the drop-down menu

The rule is available to the application when you commit your changes to the Dictionary.

Creating a Process Wizard Intent Response

As an alternative to creating a Rule with a Process Wizard Action, a Process Wizard can be displayed when
an Intent triggers by creating a Process Wizard Intent Response.

To create a Process Wizard Intent Response:

1 Select either the Intent Response Icon on the Dictionary Manager Tool Bar or the File/New Intent
Response menu item.

2 Select yes when prompted Do you want to create a Process Wizard Response.
3 When the Process Wizard Intent Response Editor displays:
Enter a name for the Intent Response.

a
b (Optional) Enter a Description and any Notes.

(o]

Select the Domain for the new Intent Response.
d Select the User Profile option you want to use or leave the default All Users setting.

e Select a language for the Intent Response by selecting the desired language and clicking Add
Selected Language to Response.
When you select the Language for the Response, a tab appears for the selected language, with a
drop-down menu of available Process Wizards.
4  Select the Process Wizard you want to display.

5 Assign the Intent Response to one or more Intents by selecting the names of the Intents, one at a time,
in the Intents Assigned to the Response table at the bottom of the Intent Response Editor.

The Process Wizard User Interface

The Process Wizard User Interface is a set of specific pages designed for use with Process Wizards. When
users select an Process Wizard answer from the standard answer page, the User Interface invokes the
Process Wizard User Interface pages to display the selected Process Wizard.

Note: The Process Wizard User Interface is automatically configured for use within the standard User
Interface.
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The Process Wizard User Interface consists of the following major elements:

e The Process Wizard answer, which displays on the answer page, as described in The Process Wizard
Answer on page 105

» The step display area, which contains the steps defined for the process, as well as the navigation
buttons (Back, Next, Finish), as described in The Step Display Area on page 105

» The process summary column, which displays information about the previous steps that the user has
taken to progress through the wizard, as described in The Step Display Area on page 105

The Process Wizard Answer

When an end-user submits a request to the application that matches a process wizard rule, the User Interface
displays a special Process Wizard answer in the standard answer area, for example:

Find Answers

Type a question or describe what you are looking for below

Ihow can i retrieve messages sk
Example: "Does Product-» have Feature-ve" Tips
Answers

a Help Retrieving Messages

Hawing problems retrieving messages? Let us guide wou through it,

If users select the link in the process wizard answer, the User Interface displays the initial step of the process
wizard.

The Step Display Area

When users select a Process Wizard answer, the application displays the initial step in the Process Wizard
User Interface step display area.

The Process Wizard User Interface displays a summary of the user's previous responses to the left of the
step display area. The summary displays below the heading Your Responses.

Each response is displayed as a link that navigates back to the process step.

Help Retrieving Messages

» Start over Hawving problems retrieving messages? Let us guide you through it,

Your Responses o ) )
To read e-mail in your online mailbox

What kind of message are you trying
to retrieve?
Email Message 1. Click the Read icon on the toolbar,

2, 0On the Mew tab, double-click the first e-mail item to read it.

Fror whare are you trying to retrieve
Your messagqes’?
From your home computer

= Back Finish

ORACLE KNOWLEDGE INTELLIGENT SEARCH OPTIMIZATION GUIDE ORACLE



106 THE PROCESS WIZARD USER INTERFACE

Modifying the Process Wizard User Interface

You can modify Process Wizard User Interface elements to suit the needs of your application by editing the
Process Wizard User Interface files, located in one of the following locations:

<Oracle Knowledge roots>/Search/inquira/webapps/<subdirectorys>

where:
<subdirectory> is one of the following:
. CSS
. Js
« xsl/search
CSS Files Description

gna_wizard style.css |Thisis the style sheet that specifies the style and formatting for the
elements that are specific to the Process Wizard User Interface and are
not part of the standard search.

Java Script Files Description

gna wizard.js This is a JavaScript library that contains Process Wizard User Interface-
specific functionality.

XSL Files Description

wizard.xsl This is the main Process Wizard User Interface file that contains the basic
page definition (similar to the ui_search* .xs1 files) and utilities for the
wizard pages.

wizard fields.xsl This file contains all of the templates used to render any defined wizard
fields such as radio buttons, text boxes, select boxes, HTML areas, etc. on
the UI.

wizard history.xsl This file contains the templates for displaying the user's choice history as

well as the support templates for any actions generated by the history
information such as links back to previous pages.

Note: The file /webapps/xsl/process wizard/step.xsl is used only for previewing steps in the
Process Wizard Editor, and is not used in the Process Wizard User Interface.
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CHAPTER 3

Personalized Navigation Setup

You can implement the Oracle Knowledge Personalized Navigation feature to categorize application content
and display a hierarchy of the results, such as products and models, services, and prices, in the User
Interface. When Personalized Navigation is implemented, users can select among content categories and
other types of classification to restrict the results to the selected areas of interest.

You can also integrate Personalized Navigation with Oracle Knowledge question answering to automatically
generate answers to natural language questions based on the categories of information referenced in users'
questions. For example, users can get results related to a specific price range either by selecting the
appropriate price facet or by referring to a price in their question, once a Rule is setup to automatically restrict
the answers to the desired facet.

Personalized Navigation provides end users with the choice of displaying application content by selecting
classification links within the navigation area of the question page. For example, users can select from
content classifications displayed in the User Interface:

Find Answers | aisk
»» Start over Example: "Does Product-x have Feature-v?" Tips

er Answers By: Answers

Author
O abbey, Lynn (2) ] Available Books
O Acres, Mark {2}

O Adamns, Douglas {15) - - .
O adams, Robert (2) Isaac Asimov 100 Great Science Fiction Short Short $3.95 1985

Stories
O affabee, Eric {1}

more...

Cover Author

Arthur Charles 2001 & Space Odssey £4.95 1932
Year of Publication [®] Clarke

[ 1970-1979 (328)
™ 1980-1989 (1916)
O 1980 (134)

Arthur Charles 2010 $£32.95 1987
O 19581 (155) Clarke
OO 1982 {247)
OO 1983 {279}
0 1984 (155) view entire table (100 rows)

O 1985 (191)

The links in the navigation area (left column) correspond to the content categories (also called facets). Users
can select from the available categories to locate a particular item of interest.

Personalized Navigation can also refer to Dictionary rules so that a user question such as *“What books
do you have between $10 and $207?" automatically selects content categories.

Personalized Navigation includes built-in data classification tools and methods to:

» Define any number of categories and subcategories for classification.

Oracle Knowledge provides a variety of built-in classification methods to classify structured and
unstructured data, including methods to access database fields, site graph, meta-tags, and concept
relations.
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» Classify application data at multiple levels.
You can classify application content at the sentence level, section level, or any other portion of a
document, and create Dictionary rules to restrict results based on classification during question
processing.

» Leverage Dictionary concept definitions to categorize data.
You can use the concept information stored in the Dictionary to create taxonomies, and schedule
taxonomy updates so that any changes to the ontology or content are automatically reflected in the
navigation categories.

 Classify unstructured data based on structured data.

You can use structured data categories to access related unstructured content, so that, for example,
unstructured data consisting of book reviews listed by titles can be categorized by the prices and
publication years contained in a separate database.

Personalized Navigation Presentation

Oracle Knowledge provides delivered User Interface implementation for Personalized Navigation featuring:

» Seamless integration with the standard Oracle Knowledge search implementation.
Personalized Navigation presents results based on selected content categories, enabling users to
select facets that then restrict or expand the scope of their original question.

« Dictionary leveraging of Oracle Knowledge natural language processing.

Dictionary rules can select content categories when concepts are referenced in users' questions,
leveraging the full power of Oracle Knowledge natural language processing. For example, users get
classified results from questions such as:

What books were published in 19927
What books cost around $157?
What books cost between $12 and $187?

» Support for "upward" navigation by selection or by question processing.

Personalized Navigation supports navigation to back out of a selected category to any higher level
category. More importantly, users can expand the scope of a natural language question. For example,
consider a question about car models:

Special deals for Sputniks?
followed by selecting the Sedans facet.
The application expands the scope of the question to mean:

Special deals for (all sedans)?

Personalized Navigation Implementation

You implement Personalized Navigation by creating hierarchies of information categories, called taxonomies.
You define and create the various levels of your taxonomies using the Personalized Navigation application in
the Oracle Knowledge Language Workbench.

The Personalized Navigation application contains tools and methods to:
» Associate your application content with the categories defined in your taxonomy.
» Generate subcategories within the taxonomy based on properties within your application content.
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The basic Personalized Navigation application process uses a simple four step dialog to prompt you for the
information required to build a taxonomy. You can use Personalized Navigation application advanced settings
to explicitly specify content classification, as described in Using Advanced Facet Definition Settings on
page 143.

Note: You can tailor the question answering and presentation aspects of Personalized Navigation by
adding custom Dictionary rules to access classification information, as described in Referring to Facets
from Dictionary Rules on page 138. You can also use classification in question processing without
displaying navigation in the User Interface.

The Personalized Navigation Application

You define and create taxonomies for your application content using the Personalized Navigation application
in the Oracle Knowledge Language Workbench.

The Personalized Navigation application contains tools and methods to:
» Associate your application content with the categories defined in your taxonomy.
» Generate subcategories within the taxonomy based on properties within your application content.

Personalized Navigation Application Classification Components on page 165 describes the components of
the Personalized Navigation application.

Personalized Navigation Application Components

The Personalized Navigation application uses the following components for classifying application data:

» Taxonomies — The classification schemes that organize the units of information, such as documents,
sentences, and database entries, into a hierarchical structure, as described in Taxonomies on
page 109.

» Facets — The individual categories within a taxonomy, as described in Facets on page 110.

 Classifiers — The procedures that associate facets with the relevant data within the application content,
as described in Classifiers on page 111.

» Taxonomy Builders — Procedures that you configure within a classifier to generate additional sub-facets
during the classification process, as described in Taxonomy Builders on page 111.

» Formatters — Procedures that control how facet names are presented in the User Interface, as described
in Formatters on page 111.

» Comparators — Modules that compare values of facet items to determine display order, as described in
Comparators on page 112.

In addition, there are packaged rules within the Dictionary that support Personalized Navigation functions;
you create custom rules to reference specific facets, as described in Referring to Facets from Dictionary
Rules on page 138.

Taxonomies

A taxonomy is a classification of objects. For Personalized Navigation the items classified in the taxonomy are
items of relevant information, such as documents, sentences, and database entries, that belong to defined
categories, such as product model, and price.
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For any given item in the taxonomy, all objects classified in that item are implicitly classified for all parent
items in the taxonomy. For example, in the taxonomy illustrated below, every Fantasy book is also a

Speculative book and also a Fiction book.

Genre SubGenre SubSubGenre
|

Mystery
—{  Fiction FRomance

L Speculative el

Science

Genre [+ Fiction
Eiography
1 Monfiction F Histony
\— Sclence

In Personalized Navigation, the categories created by the classification process (either automatically
generated or manually created) are referred to as facets.

Facets

Facets are the individual information categories within a taxonomy. You define facets that correspond to the
categories of information that you want to make available to end users, either by defining them manually or by
using the Personalized Navigation application classifiers.

For example, you could manually define a set of facets based on fiction book sub-genres, such as Mystery,
Romance, and Speculative, and use the Personalized Navigation application classifiers to generate additional

child facets based on values stored in a database.
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Genre SubGenre SubSubGenre
|
Mystery
—{  Fiction FR@mance
\—Specuiative { rentagy
Science
Genre [ Fiction
Biography
1 MNonfiction F History
L Sclence

Classifiers

Classifiers are Personalized Navigation application procedures that you configure to create taxonomies and
associate application content with the facets within the taxonomies. Oracle Knowledge contains various
classifiers to access both structured and unstructured data sources, as described in Personalized Navigation
Application Classification Components on page 165.

Taxonomy Builders

Taxonomy builders are procedures that you configure within classifiers to create new facets during the
classification process. Taxonomy builders enable you to automate the facet creation process, as well as
automatically update the facets within data repositories that are subject to frequent change. See
Personalized Navigation Application Taxonomy Builders on page 180 for more information on configuring
taxonomy builders within classifiers.

Formatters
Formatters are procedures within taxonomy builders that perform string substitution on facet names so that

you can control their presentation within the User Interface. See Personalized Navigation Application
Formatters on page 187 for information on configuring formatters within classifiers.
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Comparators

Comparators are modules within taxonomy builders that compare two values and determine whether the first
is less than, equal, or greater than the second. See Personalized Navigation Application Comparators on
page 186 for more information on configuring comparators within classifiers.

Implementing Personalized Navigation

You implement Personalized Navigation using the Personalized Navigation application within the Oracle
Knowledge Language Workbench to define content categories, and by configuring the User Interface
presentation elements.

To implement Personalized Navigation:

Activate the Personalized Navigation User Interface template, as described in Activating the
Personalized Navigation User Interface Layout on page 112.

Access the Personalized Navigation application, as described in Accessing the Personalized
Navigation Application on page 112.

Select or define a navigation application, as described in Defining a Navigation Application on
page 113.

Define taxonomies and facets within the navigation application, as described in Defining Taxonomies on
page 115.

Create any necessary Dictionary rules to reference taxonomies, as described in Referring to Facets
from Dictionary Rules on page 138.

Classify the application data, as described in Performing Data Classification on page 137.

Activating the Personalized Navigation User Interface Layout

To implement the Personalized Navigation User Interface elements, you activate the Personalized Navigation
User Interface layout, ui search and browse.xsl, located in:

webapps/xsl/search/main.xsl

The main.xs1 file contains an include statement for the Personalized Navigation User Interface layout.

The following is an example of the include statements within the main.xs1 file, showing the Personalized
Navigation layout enabled:

<!-- Options for Search UI Main Screens -->

<!--xsl:import href="ui_ search basic.xsl"/-->
<xsl:import href="ui search and browse.xsl"/>
<!--xsl:import href="ui search vrep.xsl"/-->

Important! You can enable only one of the include statements for your application.

Accessing the Personalized Navigation Application

You access the Personalized Navigation application:

From the Oracle Knowledge Language Workbench Launcher.
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- Enter a valid User name and password.
- Select Personalized Navigation Setup from the Application drop-down menu.
» From other Oracle Knowledge Language Workbench applications, such as the User Manager.
- Click on the Personalized Navigation application icon &, displayed in the lower right corner of the
main application window.

The Oracle Knowledge Language Workbench displays the Personalized Navigation application screen:

[i& Personalized Navigation Setup
File Edit Tools

| | Personalized Navigation Mew Taxanomy |

5 3| - P

The Personalized Navigation application displays a tree containing the Default navigation application and any
other currently defined applications.

You can select the Default folder to define taxonomies within the Default navigation application, or define
additional navigation applications.

Defining a Navigation Application

Navigation applications are collections of content categories, or taxonomies that you define for your Oracle
Knowledge application. You can define any number of navigation applications in addition to the Default
application.

You configure the navigation application for use with your application using the Advanced Configuration
Facility, as described in Configuring the Navigation Application on page 114.

Note: The Default navigation application is configured by default.
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Each navigation application supports any number of top level taxonomies. The top level taxonomies are the
highest level categories that the User Interface displays to end users.

To create a navigation application:

1 Select Edit from the Menu bar, or right-click on the Personalized Navigation folder and select Add
Application:

r Personalized Mavigation Setup

The New Application dialog displays:

i New Application x|

[ Eidppicaton || cancel |

2 Enter an application name and select Add Application.

Note: The application name does not appear in the User Interface; the top-level taxonomies are the highest
level categories visible in the User Interface.

The new application appears as a sibling of the Default application:

r_ Personahzed Havigation Setup

sonalized Mavigation

Drefault
A Invira

Configuring the Navigation Application

If you define facets within a navigation application other than the default (Default), you must configure the
alternate navigation application for use with the application.

Note: The Personalized Navigation application displays alternate navigation applications as siblings of the
Default application.

You configure a navigation application on the Service Configuration page of the Advanced Configuration
Facility.
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To configure a navigation application:
1 Select Service Configurations from the Advanced Configuration Facility menu.

The Service Configurations page displays the current instance configurations:

Editing: Service Configurations

Service : Default Configuration
Configurations

Distributed Runtime Query Coordinator Configuration
Deryiorker Configuration

Gl gl Gl
B E R

Add Mew Itern

" el |

2 Select the desired instance.

The Service Configurations page displays parameters for the Navigation Service.

Nawvigation Service

Collection : Ina-.ligation |

Directory : Idata,l"na-.ligation |

Default Facet

¢+ |pefault
Collection ID I 2Tsu |

3 Specify the name of the alternate navigation application in the Default Navigation Application ID field,
and select OK to save your configuration changes.

Defining Taxonomies

You define taxonomies (content categories) for a navigation application using the Personalized Navigation
application setup process.

Note: Personalized Navigation includes advanced functions for creating and defining content categories
that you access using the Show Advanced Setup option in the Tools menu, as described in Using Advanced
Facet Definition Settings.

ORACLE KNOWLEDGE INTELLIGENT SEARCH OPTIMIZATION GUIDE ORACLE



116 IMPLEMENTING PERSONALIZED NAVIGATION

To create a top level taxonomy within a navigation application:

1 Select the application folder, then right-click and select Add Taxonomy or select the New Taxonomy
button in the upper right portion of the display:

r_ Personalhzed Mavigation Setup

£ Personalized Navigation

The New Taxonomy dialog displays.

i New Taxonomy x|

i Taronomy | carca |

2 Enter the name for the new taxonomy as you want it to display in the User Interface and select Add
Taxonomy.

The new taxonomy appears as a node under the selected application:

r_ Perzsonahzed Havigation Setup

7 Personalized Mavigation

You can define additional taxonomies as siblings and children of the new taxonomy using the same process.

Defining Taxonomy Display Properties

You can define taxonomies to be displayed in the User Interface, or to be used only internally by the
application's request and response processing.

Note: Personalized Navigation includes advanced functions for creating and defining content categories
that you access using the Show Advanced Setup option in the Tools menu, as described in Using Advanced
Facet Definition Settings. The following description applies to the default, and not to the Advanced Setup.
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To define the display properties of a taxonomy:

1 Select the taxonomy folder for the category:

r_ Personahzed Havigation Setup

£ Personalized MNavigation

The Personalized Navigation application prompts you to specify whether this taxonomy:

- Displays in the User Interface and is available for end users to select.

-or-

- Does not display in the User Interface and is available only for reference by Dictionary Rules

Note: The Advanced setup displays a different screen.
2 Select one of the following display options:

Yes Specifies that this taxonomy displays in the User Interface. The User Interface
displays the Web Interface Settings dialog.

No |Specifies that this taxonomy is used only for reference by Dictionary Rules.

The Personalized Navigation application displays the Web Interface Settings dialog for taxonomies
that are specified to display in the User Interface:

nofacets 7]
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3 Specify the following Navigation Area display options:

Show taxonomy Select this checkbox to specify that the category displays in the
before a question is | Personalized Navigation column of the User Interface.
asked.

For example the categories Price, Year of Publication, and Collections

are set to display in the initial question page before a question has
been asked:

Find Answers

» Start over

Price:

v Under $0
v 30 - 10
v $10 - $20
v $20 - $30
v $30 - $40
v $40 - $50
b Over $50

Year of Publication:
v 1970-1979

v 1950-1959

» 1990-1999

b 2000-present

b Unknown

Collections:
b Reviews

Maximum number of | Specify the maximum number of facets to display in a taxonomy.
subfacets displayed |Additional taxonomies can be displayed by selecting the more... link.

before 'more..."' link: | For example, the following Author taxonomy is limited to five displayed
facets:

Find Answers

» Start over

Author:

v Abbey, Lynn (1)

b Abbott, Tony (1)

¥ Allston, &aron (2)

v Andrews, Michael (2}
v Anthony, Piers (3)
mMore...
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Number of facet tree
levels to initially

Find Answers

» Start over

Price:

v Under $0
FE0 - $10
v £10 - £20
v 520 - £30
b 330 - §40
k340 - $50
b Dver $50

4  Specify the following Answer Area display option:
List <number of

answer
* no facets

« only the first matching facet
« all matching facets

facet of the Collections taxonomy:

ANSWErs

The SF Site Featured Pe

I must admit I approachec
wiorking in the universe of
series; it's one of the top .
of Dune and Chapterhous
narrower structure as sam
line and left the possibilitie
Collections: Reviews

Specifying Automatic Facet Creation

Specify the number of facet levels to display in the initial navigation

area. For example, the following Price taxonomy displays two levels,
display the parent Price, and the first child level of price facets:

Specify the number of facets to include as part of answers belonging to
facets> after each this facet. Select from the following options:

For example, the following answer includes the matching Reviews

The Personalized Navigation application prompts you to specify whether it uses the taxonomy builder feature

to automatically generate a hierarchy of child facets for this taxonomy:
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 Select one of the following options:

Yes Specifies that the Personalized Navigation application generates additional facets
within this taxonomy.

No |Specifies that you assign content to this facet.

Note: We recommend that you specify to automatically classify content that is stored in a repository, such
as a database, that is external to the Content Store.

The Personalized Navigation application prompts you in later steps to specify:
e The source of the content to use.

¢ Additional generation information, depending on the type of content source you select, as described in
Specifying Generation Options for Structured Content on page 121.

Specifying the Content Source for the Taxonomy
The Personalized Navigation application prompts you to specify whether the content for the taxonomy
resides:
* In a database
* In unstructured documents

« Select one of the following options:
Yes Specifies that the content for this taxonomy resides in a database.

Important! The database must be configured as a source of structured data
for your application, as described in the Oracle Knowledge Intelligent Search
Application Development Guide.
The Personalized Navigation application displays the Database Content Settings
dialog.

No Specifies that the content for this taxonomy resides in unstructured content.

For taxonomy content that resides in a database, the Personalized Navigation displays the Database Content
Settings dialog:

« Select a database table from the list of currently configured schema on the Structured Data page of the
Advanced Configuration Facility Instances section

The Personalized Navigation application prompts you to specify generation options.
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Specifying Generation Options for Structured Content

Note: This section discusses the Generation Options when a Database table has been chosen as content
source. There are different options if the content source for classification is unstructured content.

The Personalized Navigation application presents options to:
» Automatically generate facets from database or document content
» Manually assign database or document content to facets

based on the following options, and the selections you specified in Specifying Automatic Facet Creation on
page 119:

If You Chose to.... Go to...

have the Personalized Navigation application | Automatically Generating Facets For
automatically generate facets for database Database Content on page 121
content...

have the Personalized Navigation application | Specifying Generation Options for
automatically generate facets for document | Unstructured Content on page 125

content...

manually assign content to facets for Manually Assigning Database Content to a
database content... Facet on page 128

manually assign content to facets for Manually Assigning Document Content to a
document content... Facet on page 130

enable linking between Information Manager |Enabling Learning-Based Results Ranking on
articles and a CRM applications case page 133

tracking...

Automatically Generating Facets For Database Content

If you chose to automatically generate facets for database content, the Personalized Navigation application
displays the following generation options:

 Select one of the following options:
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- Generate a date taxonomy for a date column, as described in Generating a Date Taxonomy for a
Selected Column on page 122

- Generate a numeric range taxonomy for a numeric column, as described in Generating a Numeric
Range (Price) Taxonomy on page 123

- Generate a taxonomy based on the contents of one table column, as described in Generating a
Facet Based on a Single Column on page 124

- Generate a taxonomy based on the contents of multiple table columns, as described in Generating a
Taxonomy Based on Multiple Columns on page 125

GENERATING A DATE TAXONOMY FOR A SELECTED COLUMN

This option creates a date taxonomy based on the selected date column and additional parameters.

I
I
I
I
[ |

|1

To generate a date taxonomy for a date column, specify the following parameters:

Field Description

Select the date column to Select a column from the list. The Personalized Navigation

use application examines the available fields in the specified database
and provides a list of columns that contain date data.

Generate a 3 level (year/ Select to automatically generate a three level hierarchy consisting

month/day) taxonomy of the facet levels Year, Month, and Day.

Show facet for the current | Select to generate only the specific facets. The Personalized
(day, week, month, year): Navigation application displays a field in which you can specify a
facet label to override the default.

Show facet for all dates: Select to generate a single taxonomy of facets for all dates. The
Personalized Navigation application displays a field in which you
can specify a label to override the default.

See Classifying Content Based on Database Column Values on page 150 for more information on
classifying database content.
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GENERATING A NUMERIC RANGE (PRICE) TAXONOMY

This option creates a numeric range taxonomy, such as a price taxonomy, based on a selected numeric
column and additional parameters:

¢ Specify the following options:

Field Description

Select the numeric column | Select a column from the list. The Personalized Navigation

to use application examines the available fields in the specified
database and provides a list of columns that contain numeric
data.

Currency values Select the checkbox to specify that facets sort by currency in

ascending order.

Show 'less than minimum' | Select this option to create a facet for values less than the
facet: Minimum. The Personalized Navigation application creates a
facet labeled:

Under <minimum value>

for example,

Under $5.00
where 5 is the value of the Minimum parameter.
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Show 'greater than Select this option to create a facet for values greater than the
maximum' facet: Maximum. The Personalized Navigation application creates a
facet labeled:

Over <maximum values>

for example,

Over $50.00
where 50 is the value of the Maximum parameter.

Facet levels: Specify the number of levels for the taxonomy, and the number of
facets within each level. For example, enter 5, 2 to specify that
the top level taxonomy is divided into five facets, and the second
level is divided into two facets.

Generate levels beyond Select the checkbox to create taxonomy levels dynamically at
level n at runtime runtime when specifically selected by the user. Use this setting
when:

¢ The results of conventionally classifying the data are very large.

* The performance loss of accessing the data source at runtime is
acceptable.

See Classifying Content Based on Database Column Values on page 150 for more information on
classifying database content.

GENERATING A FACET BASED ON A SINGLE COLUMN

This option creates a taxonomy based on a selected database column. The taxonomy contains a facet for
each unique value in the selected column.

To generate a taxonomy based on a selected column, select a column from the list.

See Classifying Content Based on Database Column Values on page 150 for more information classifying
database content.
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GENERATING A TAXONOMY BASED ON MULTIPLE COLUMNS

This option creates a taxonomy based on multiple selected columns. The Personalized Navigation application
creates a taxonomy level for each column, in the order specified. You can use the arrows in the Table
Columns field to change the order of the columns.

To generate a numeric range taxonomy for a numeric column, select the columns to use.

See Classifying Content Based on Database Column Values on page 150 for more information classifying
database content.

Specifying Generation Options for Unstructured Content

If you chose to automatically generate facets for document content, the Personalized Navigation application
displays the following generation options:

¢ Select one of the following options:

- generate a taxonomy hierarchy for one or more collections, as described in Generating a Taxonomy
Based on Directory Structure on page 126

- generate a taxonomy of concepts, as described in Generating a Taxonomy from Concepts on
page 126

- generate a taxonomy using HTML meta-tags, as described in Generating a Taxonomy from Meta-
Tags on page 127
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GENERATING A TAXONOMY BASED ON DIRECTORY STRUCTURE

This option creates a taxonomy based on the directory structure of the specified collections.

To generate a taxonomy based on one or more specified collections, select the collections to use.

See Classifying Content by Directory Structure on page 162 for more information.

GENERATING A TAXONOMY FROM CONCEPTS

This option creates a taxonomy based on specified Dictionary concepts. You can specify the following
concept criteria:

¢ Concepts to be automatically discovered by the application:

Specify representative concepts for which you want the system to locate and generate taxonomies for similar
concepts. For example, specify:

<concept name>

to generate a taxonomy based on the hierarchy of noun concepts that are specific to your application.
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» Concepts to include as the basis of the taxonomy:

Specify one or more concepts that you want to use as the root of the taxonomy. Personalized Navigation
includes the "is-a" children of the included concepts unless they are explicitly excluded as separate entries.

» Concepts to exclude from the taxonomy

Specify any concepts that you want to exclude from taxonomies. The Personalized Navigation application
excludes the children of excluded concepts unless they are explicitly included as separate entries.

See Classifying Content Based on Dictionary Concepts on page 161 for more information.

GENERATING A TAXONOMY FROM META-TAGS

This option creates a taxonomy based on the values of specified HTML meta-tags.

The Personalized Navigation application creates multiple levels based on meta-tags of increasing specificity,
for example:

<meta name="Genre" content="Fiction"/>
<meta name="SubGenre" content="Speculative"/>
<meta name="SubSubGenre" content="Fantasy"/>

Within each taxonomy, it creates a facet for each unique content value within a specified tag.
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Important! You must ensure that the meta-tags that you specify for classification are added to the
Preprocessor's HTML converter configuration file (<InQuira-home>\src\prep\html.config).

To generate the taxonomy, enter the desired meta-tags.

See Classifying Content Based on HTML Meta Tags on page 159 for information on the advanced Meta Tag
classifier settings.

The primary way to configure the preprocessor is through the System Manager/Advanced Config/
Preprocessor screens. You can also make manual edits.

Manually Assigning Database Content to a Facet

If you chose to manually assign database content to the new facet, the Personalized Navigation application
displays the following generation options:

« Select one of the following options:

- Assign all table entries to the facet, as described in Assigning All Table Entries to a Facet on
page 129

- Assign selected table entries to the facet, as described in Assigning Selected Tables to a Selected
Facet on page 129
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ASSIGNING ALL TABLE ENTRIES TO A FACET

This option creates a facet (single taxonomy level) containing all table entries for the specified datasource.

See Classifying Content Based on Database Column Values on page 150 for more information on
classifying database content.

ASSIGNING SELECTED TABLES TO A SELECTED FACET

This option creates a taxonomy level containing all entries in the specified data source that match the
specified SQL condition.

To assign selected table entries to a selected facet enter a condition to select table entries using any valid
SQL to construct a where clause, such as:

where <field> <comparisons> <value>

where:
field(s) Specifies one of more fields from which to select.
comparison Specifies how to compare the field value with the specified value, for
example =, <, >.
value Specifies the value to compare against to determine selection, for
example 5.
Example:

where id=5
See Using an SQL Condition to Classify Content on page 149 for more information.
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Manually Assigning Document Content to a Facet

If you chose to manually assign document content to the new facet, the Personalized Navigation application
displays the following generation options:

¢ Select one of the following options:

- Assign document collections to the facet, as described in Assigning Documents to a Facet by
Collection on page 130

- Assign documents to the facet by type, as described in Assigning Documents to a Facet by Type on
page 131

- Assign documents to the facet by language, as described in Assigning Documents to a Facet by
Language on page 132

- Assign documents to the facet by content, as described in Assigning Documents to a Taxonomy by
Content on page 132

- Assign documents to the facet by URL, as described in Assigning Documents to a Facet by URL on
page 133

ASSIGNING DOCUMENTS TO A FACET BY COLLECTION

This option assigns all documents within the specified collections to this facet (single taxonomy level).

To assign document collections to a selected facet, enter one or more collections. The order in which you list
the collections does not affect composition of the taxonomy level.

See Classifying Content by Collection on page 156 for more information.
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ASSIGNING DOCUMENTS TO A FACET BY TYPE
This option creates a taxonomy consisting of facets for each selected document type. You can select one or
more of the following document types:

¢ HTML

* IQXML

e MS-EXCEL

* MS-POWERPOINT
* MS-WORD

* PDF

* RTF

« TEXT

¢ UNKNOWN

« XML

To assign document collections to a selected facet, specify one or more document types.

See Classifying Content by Document Type on page 157 for more information.
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ASSIGNING DOCUMENTS TO A FACET BY LANGUAGE

This option creates a taxonomy containing facets for each specified language. Each facet contains only
documents identified as belonging to the specified language.

To assign documents to the facet by language, add one or more languages.

See Classifying Content Based on Language on page 158 for more information.

ASSIGNING DOCUMENTS TO A TAXONOMY BY CONTENT

This option assigns content to this taxonomy based on InQuira Match Language (IML) expressions. See
Chapter 4, IML Reference for more information on using IML.

To assign documents to the facet by content:
1 Specify an IML expression to match the desired content.

2 Select document scope you want to apply the expression to.
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For example, you could specify the IML expression cat OR dog and the Document scope to match all
documents that contain the words cat or dog.

Similarly, you could specify the Sentence scope to match only sentences that contain the words cat or
dog. Or, you could specify Title scope to match only documents that contain the words cat or dog in their
title.

See Using IML Expressions to Classify Content on page 158 for information on the advanced IML classifier
settings.

ASSIGNING DOCUMENTS TO A FACET BY URL

This option assigns content to this taxonomy based on regular expression matches to a document URL. See
Specifying Regular Expression Substitutions on page 186 for more information on specifying regular
expressions to match document URLSs.

To assign documents to a taxonomy by URL, specify a regular expression to match the desired URL.

See Classifying Content by URL on page 162 for more information.

Enabling Learning-Based Results Ranking

When enabled, Learning-based Results Ranking assists Intelligent Search in determining which IM articles
have been linked to a CRM case and uses that information as a basis for ranking the displayed results from a
search.

Search results that come from Linked Knowledge IM Articles are given a preference in the ordering of search
results on the Search Results page. The ranking preference is assigned by the dictionary rule, Linked
Knowledge SC.

When an agent uses an article to solve an incident or case, on the next content processing cycle that article
appears higher on the search results page, and is visually marked as assigned to the facet Linked
Knowledge.

Linking an IM article to a case in one locale automatically links translations of the same IM article in other
languages and locales.

Linked Knowledge can be visually emphasized in the search results in two ways. The Linked Knowledge
navigation header, with facet IM Articles, provides the basic visual emphasis, on the left side of the Find
Answers / Search Results page in InfoCenter, as shown in the following graphic:
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If the agent/user clicks on the IM Articles facet, this filters out search results that are not from Linked
Knowledge IM Articles, so that the agent/user can focus on the Linked Knowledge results, as shown in the

following graphic.

ORACLE Information Center
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A second way to provide visual emphasis for Linked Knowledge is to set the search results to include a

breadcrumb, as in the following graphic.
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page, you can specify the settings for synchronizing calendar and to-do entries. For more informatian, see

IM articles that are marked as Linked Knowledge are ranked above IM articles that provide comparable
matches for the search query, but are not linked to the resolution of a case or incident. Note that in the
preceding graphic the Linked Knowledge IM Articles are the top 2 search results.

Note: This feature is limited to IM Articles. Non-IM content, IM Attachments, and IM Container Records are
excluded.

ENABLING LINKED KNOWLEDGE

Learning-based Result Ranking requires activation by the Search Administrator. The top facet Linked
Knowledge and sub-facet IM Articles are not enabled at install.

To enable the facets,

1 Access the Personalize Navigation Setup.
Make sure that the Show advanced setup checkbox under Tools menu is selected.

Select the KNOWLEDGE_PROPERTIES facet under DEFAULT.
Select Enabled.
Select the LINKED_CONTENT facet.

a A W N

Select Enabled.
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6 To display the Linked Knowledge: IM Articles breadcrumb under each applicable search result,
select Classify Unstructured Results. You should accept any other pre-selected options.
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Note: For Learning-based Ranking to be enabled, the IMWS (InfoManager Web-Service) must be
configured in the Search application. This is part of the basic Search configuration, and is not specific to
Learning-based Result Ranking. See the Intelligent Search Administration Guide to configure IMWS.
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Performing Data Classification

Once you have configured data classification, you operate the classification process to build the taxonomies
for your application using the Personalized Navigation application.

The classification process associates the configured taxonomies with the actual application content, and
stores the classification information in the application index.

To perform the classification operation:

1 Select the navigation application configured for your application

[ Personalized Mavigation Setup

r Personalized Mavigation

2 Select Classify on the Classify tab

Classify

When the Classify operation is complete, the system automatically displays the Generated Taxonomy tab,
showing the results as a tree.

You can also operate the classification process by:

¢ Configuring a scheduled task, as described in the Oracle Knowledge Intelligent Search Administration
Guide

« Executing the following command on the command line:

[}

% scheduler run Navigation -f <navigation application list>

where <navigation application list> specifies one or more navigation applications to
classify. For example, you could execute the command

scheduler (.sh/.bat) run Navigation -f Default.

Important! You must execute the Key Map command prior to classification if you have taxonomies that
reference structured data sources, the referenced data sources are not configured for hybrid search, and the
data source has changed since the last classification process.

scheduler run KeyMap -d <datasource list>

The Key Map command is also available as a scheduled task in the Advanced Configuration Facility.
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Referring to Facets from Dictionary Rules

You can configure a rule to select one or more content categories during request processing using the
Advanced Add Facet Restriction function:

o o 1 e st T E S

'zerire  Fiction"

"] Default
£ | Content Source Type
# Information Manager Channel
-] M Channel Refkey
& CMS GUID

The Facet Restriction tab displays the currently configured navigation application.

Referring to Facets by Name

You refer to facets within rules by their full facet names. A full facet name is a string constructed from the

names of the facets that compose the path to the desired facet from the root of the taxonomy. Each facet
name within the string is separated by a period. For example, the string:

Genre.Fiction.Mystery
refers to the facet My stery within Fiction, within the root taxonomy, Genre.
Note: You must use an escape character (\) to denote a period within a category name.

You can use the wildcard character (*) to refer to content categories. For example, the reference:

Genre.*.Fantasy

matches the first category in the taxonomy Genre that has the name Fantasy using a standard breadth first

search (the first, shallowest possible match). If there is no match, the category is removed from the
expression.
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Selecting Multiple Facets from the Tree Display

You can select multiple facets in the tree display using the Shift and Control (Ctrl) keys to specify:

* The intersection of the taxonomies

and

» A union of the facets within the taxonomies

For example, selecting the facets Mystery, Fantasy, and Biography:

Genre

produces the expression:

("Genre.Fiction.Mystery" OR "Genre.Fiction.Speculative.Fantasy")
"Genre.Non Fiction"

Genre SubGenre SubSubGenre

Mystery
Fiction ’7 Romance

\— Speculative L

science

Fiction
Biography
Nonfiction F History
L Science

Selecting Multiple Facets using IML

OVERLAP

You can use IML to select multiple facets within a single action. For example, you can specify to select two
facets, or only results belonging to multiple facets.

To select two facets, facet a and facet b, specify:

"facet_a" OR "facet b"

To select results that belong to both facet a and facet b, specify:

"facet_a" OVERLAP "facet b"

Note: The expression "facet a"

_ IS "facet b" returns only exact matches for document scope.
For example, it correctly returns all documents that were classified as facet a and category b;

however, it does not return a document classified as category a and containing a section classified as
category b, as does the OVERLAP operator.
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Using VIL in Rules that Select Content Categories

You can use VIL within expressions that refer to specific values within numeric or range-based facets, such as
individual prices within a price range facet.

For example, a rule that matches prices and creates a category restriction using VIL similar to:
Price.*.{price}.

instantiates based on the individual price in the question, but never matches category names expressed as
ranges, such as $5-$9.99.

To match a specific value with the appropriate range category, specify:
Price.<>*.{price}

Note: This specification requires that the content category have defined minimum and maximum values
and a comparator. Some classifiers automatically specify these parameters.

Restricting the Display for Facets Above a Selected Facet

You can specify additional facet restriction within rules to override the default User Interface behavior, which
displays the higher level facets of selected facets, so that users can expand the scope of the results.

To restrict users from accessing higher level facets, use the RESTRICTION parameter:
"RESTRICTION (facet name)"

Important! RESTRICTION is special syntax within the Personalized Navigation functionality, and is not
an IML operator.

Preventing a Facet from Displaying

You can specify a rule to remove a facet from the display using the ISNT operator in the form:
"<facet parent>" ISNT "<facet parent.facet child>"
For example, to prevent the Non Fiction facet from displaying, specify:

"Genre" ISNT "Genre.Non Fiction"

Specifying Approximate Facet Matching

You can specify to match facets based on an approximate value in the question using the ~* wildcard. The
wildcard specifies to first search for a facet that completely contains the value referred to in the question. If no
containing facet is matched, the wildcard specifies to match the parent facet.

For example, the question:
Show me books published around 1998
might match a date facet selection rule:
Year.<>*.1998
to return the facet:

1998
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You can use the wildcard to specify:
Year.~*.1998

to return the facet:
1990 - 1999

Note: This function requires that the facets have minimum and maximum values, and a comparator
specified, as described in The Range Taxonomy Builder on page 184 and The Personalized Navigation
Application on page 109.

Selecting a Range of Content Categories

You can specify to select a range of facets within a single rule using the * IML operator in the format:
"Price.<>*.$0" * "Price.<>*.322"

For example, the question:
What books cost between $0 and $22

matches the following restriction:
"Price.<>*.$0" * "Price.<>*.322"

to select the facets:

$0-59.99
$10-$19.99
$20-%$29.99

Note: This function requires that the facets have minimum and maximum values, and a comparator
specified, as described in The Range Taxonomy Builder on page 184 and The Personalized Navigation
Application on page 109

Responding to Requests for Non-Existent Content Categories

You can specify to select the best possible facet for questions that request non-existent data using the
greater-than (>*) and less-than (<*) wildcards.

For example, the request:
Show me books published after 1945

does not match any facets for data starting at 1960. You can use the wildcard:
<*

to match the closest facet greater than the requested value.

Facet expansion in addition to restriction

Personalized Navigation supports navigation to back out of a selected category to any higher level category.
More importantly, users can expand the scope of a natural language question. For example, given the
question:

What books were published in 19927

You can select a facet to expand your scope to 1990-1999.
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You can also expand the scope of unstructured searches. For example, consider a question about car
models:

Special deals for Civics?

followed by selecting the Sedans facet.

The application expands the scope of the question to mean:
Special deals for (all sedans)?

even though the original question text still references Civics.

Understanding Facet Counts

The facet counts are how many documents match the facet, determined by the classifiers in the taxonomy.xml
set up in the Personalized Navigation Tool in Workbench, for the candidate set of the question asked. Facet
counts include all structured and unstructured answers for all purposes, by default, but does not include
managed answers.

The facets are intended to help the user see what other results are available so they can better filter their
results. They are not intended as a navigation tool, to see all results matching a facet for any question.

The number in the parentheses next to a facet shows the minimum number of results that could be a match
when the facet is selected. This number is based on the candidate set for a question asked, rather than the
number of search results shown to the user, referred to here as the result set. The candidate set is the set of
documents that the system determines are a match for the question, which is most often larger than the result
set displayed to the user. In fact, the candidate set is a superset of the result set.

Note: The user may not see all results depending upon the maximum answers displayed. Also, there may
be more results depending upon the search algorithm that builds matches.

The candidate set of documents is based on the search component rules in the system. Using the search
component rules, the system populates the candidate set with at least as many answers as the result set,
assuming there are that many matching answers. The system starts at the top importance level and proceeds
down the other importance levels until it fills up the result set. Once the result set size is met, the engine does
not proceed to the next search component importance level. So, if the result set size is met with just Required
importance level matches, the candidate set is populated with all the Required matches and it does not pull
the Very Important, Important, etc. importance level matches. This assumes that the facet setting guarantee-
max-results is set to false, the default setting.

If a document is not in this candidate set, it is impossible for it to be returned by the search algorithm as an
answer; all possible answers must come from the candidate set. It is this candidate set that is used to create
the facet counts. Changing the minimum threshold does not change the candidate set, and therefore not
change the facet counts.

ORACLE KNOWLEDGE INTELLIGENT SEARCH OPTIMIZATION GUIDE ORACLE



143 IMPLEMENTING PERSONALIZED NAVIGATION

Using Advanced Facet Definition Settings

The Personalized Navigation application provides additional advanced settings for defining and creating
taxonomies. You can display the advanced settings for new or existing taxonomies by selecting the Show
Advanced Setup option of the Personalized Navigation application tools menu.

Note: Selecting the Show Advanced Setup option at any point in the simple Personalized Navigation dialog
process displays the corresponding advanced setup. You can toggle between the dialog and the advanced
setup at any time.For example, selecting the Show Advanced Setup option immediately after creating a new
taxonomy displays the Basic Options in a forms format instead of the simple dialog format, and makes

available the Advanced settings.
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In the following graphic, Basic Options are noted with B).
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Specifying Advanced Facet Display Settings

The Advanced Facet Display Settings tab provides advanced options to control whether and how each facet
that you create displays in the User Interface.

Basic Display Option

Description

Enabled

Use this setting to specify whether this facet is used to classify data.
Facets are enabled by default. Deselect the checkbox to exclude this
facet from the classification process.

For Initial Browse

Use this setting to specify whether this facet displays on the initial page
before users ask a question or select a facet. Facets are included in the
initial browse by default. Deselect the checkbox to specify that the facet
does not display on the initial page.

Hidden

Use this setting to specify whether this facet and its children are
excluded from the User Interface display and available only to Dictionary
rules. Select the checkbox to exclude the facet and its children from the
User Interface.

Classify Structured Results

Use this setting to specify whether structured results include the most
specific facet matched by that excerpt in this taxonomy. Select the
checkbox to include the most specific facet matched for this excerpt in
the answer display.

Classify Unstructured Results

Use this setting to specify whether unstructured results include the most
specific facet matched by that excerpt in this taxonomy. Select the
checkbox to include the most specific facet matched for this excerpt in
the answer display. The facet displays in the form of a breadcrumb
under each applicable search result.

Classify Results (All Possible)

Use this setting to specify whether results include all the most specific
facets in this taxonomy. Select the checkbox to include all specific facets
matched for this excerpt in the answer display.

Max Children

Use this setting to specify the maximum number of children of this facet
to display before the end user must explicitly request more by selecting
a more... link. The default is 20.

Specify an integer as the maximum number of children to display.

Display Depth

Use this setting to specify the number of levels in the taxonomy that
should be displayed to the end user. The default is 2.

Specify an integer as the number of taxonomy levels to display.

Label

Use this setting to specify the label to display in the User Interface for
this facet.

Note: You can specify language-dependent labels using the Language-based
Label advanced setting.
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The Advanced Options provide greater control for facet display.

Advanced Display Option

Description

Show Empty Children

Use this setting to specify whether to display the children of this facet
when no results are available. The default is to exclude empty children
from the display. Select the checkbox to display empty child facets.

Show Siblings

Use this setting to specify whether to display siblings of this facet when it
is selected. The default is to include the sibling facets in the display.
Deselect the checkbox to exclude sibling facets from the display.

Show Sibling Counts

Use this setting to specify whether siblings of this facet display with item
counts. The default is to include these counts.

Note: These counts only display when browse mode (no user question) is in
effect. Clear the checkbox to exclude sibling counts from the display.

Document Level Count

Use this setting to count a document only once if it contains more than
one answer in the document. The default is to count each answer.
Deselect the checkbox to count multiple answers in a document as a
single value.

Stop at One

Use this setting to specify whether users can drill down by selecting this
facet even if there is only one result. The default is to prevent drilling into
a single result. Deselect the checkbox to enable users to drill into this
facet when it displays only one result.

Include Parent's Rules

Use this setting to specify whether rules associated with the parent facet
are evaluated in addition to this facet's rules. The default is to evaluate
the parent facet's rules. Deselect the checkbox to restrict evaluation to
the current facet.

Ignore Unknown Facets

Select to have unknown facets ignored by language rules while
processing searches. This prevents broken logic from returning zero
search results.

Note: This value is required only for facets that are referenced by Dictionary
rules that perform approximate matching.

Allow Facet Expansion

Select to have the navigation facet expanded in the Ul. When a user
performs a search and a matching rule contains a facet restriction,
selecting this option allows for the taxonomy to be expanded to the level
of the facet restriction in the Ul navigation.

If in taxonomy T, there is a facet Y and a facet X such that Y is a parent
of X (Y -> X) and there is a facet restriction rule that restricts results to
facet X, clicking on Facet Y in navigation removes the restriction to X.

This feature works for cases where the rule based restriction is on a sub-
facet and a higher facet is selected in the Ul. For example, if Product A
facet has defined subfacets A1 and A2 with facet restriction rules on Al.
If Allow Facet Expansion on Product A is turned on, then clicking on
Product A will remove the facet restriction rule on Al and both the sub
facets Al and A2 will be displayed.

Classify Results (Only
Subselected)

Select this to perform facet-level excerpting for the lowest level facet.

Automatic

When selected, this indicates that Information Manager created the facet
and dynamically populates it.
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Advanced Display Option

Description (Continued)

Include generic higher level
facets

Select this to add a _GENERIC facet under each of the parent nodes.
The generic facet includes all the documents of the children. Results
from generic facets are included in search results.

Display generic higher level
facets

Related to the preceding option, in addition to being included in search
results, this allows the generic facets to display in the Ul as well.

For example, if you restrict to something like Software.Oracle
Knowledge . 8x, by default, only results that are classified that way
display. However, there may be a support document that applies to all
versions of Oracle Knowledge, but if you restrict to Software.Oracle
Knowledge. 8x, then it does not display, because it is not as specific.
By including the generic facets, results that are applicable to all Oracle
Knowledge, and all Software items display. But results that apply to
Software.Windows do not display, because these are not on the same
set of branches that you have followed.

Classify Results (all generic
facets)

Select to display all generic facets in the UI.

Maximum Count Per
Classification

Use this setting to specify the maximum number of results to be counted
for a particular piece of classified unstructured data. The default is the
maximum number of results allowed to be returned for a document.

Minimal parent depth for
unknown generic facets

Enter the minimum parent depth for creating generic facets if Include
generic higher level facets is selected. The higher the number, the
deeper into the taxonomy generic facets are created. Default is 1.

Arbitrary Data

Use this to send any static XML data for use on the UI.

Minimum Value

Use this setting to specify the smallest value for this facet.

Note: This setting is required only for facets that are referenced by Dictionary
rules that perform approximate matching.

You can specify any type of value that can be compared, such as
numbers, currencies, names, etc.

Note: Some taxonomy builders set these values automatically. If they are not
set, then Personalized Navigation uses the facet name for both values.

Maximum Value

Use this setting to specify the maximum value for this facet.

Note: This setting is required only for facets that are referenced by Dictionary
rules that perform approximate matching.

You can specify any type of value that can be compared, such as
numbers, currencies, names, etc.

Note: Some taxonomy builders set these values automatically. If they are not
set, then Personalized Navigation uses the facet name for both values.
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Advanced Display Option

Description (Continued)

Comparators

Use this setting to specify the comparison method to determine the basis
on which the facet items are ordered in the display. Personalized
Navigation uses the comparator to compare the requested value with the
minimum and maximum settings.

Note: This value is required only for facets that are referenced by Dictionary
rules that perform approximate matching.

Select one of the following comparators to specify the basis on which the
facets are ordered in the display:

Alphabetical

* Number

e Currency

* Dimension

» Last Name

* Month

See Personalized Navigation Application Comparators on page 186 for
more information on Comparators.

Not for Counting

Use this setting to specify data sources that should not contribute to
facet item counts, which are displayed within parentheses after the facet
name. Enter each data source name in the New Value field, and select
Add.

Language Based Label

Use this setting to specify labels to display for this facet in languages
other than the default application language. Select a supported language
from the list, enter the corresponding label, and select Add.

Rules

Use this setting to specify Dictionary rules whose actions are evaluated if
this facet is selected. Select the Domain to filter the list of rules, then
drag and drop the desired rule into the Rule / Domain field.

Using Advanced Data Classification

The Classifiers tab in the Personalized Navigation application advanced settings displays options for
specifying data classification. You specify classification for a selected facet by configuring one or more

classifiers to:

« Identify the properties of the data that you want to include in the current facet

« Identify the properties of the data that you want to include in generated facets that are the children and
sub-children of the current facet
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The Personalized Navigation application contains classifiers to access data from structured and unstructured
application content.

Using an SQL Condition to Classify Content

You can use the SQL classifier to classify content based on an SQL condition. This classifier selects all
entries in the specified data source that match the specified SQL condition.

Note: This classifier does not generate child facets. There is no taxonomy builder associated with this
classifier.

You specify the SQL condition using any valid SQL to construct a where clause, such as:

where <field> <comparisons> <values>

where:
field(s) Specifies one of more fields from which to select.
comparison Specifies how to compare the field value with the specified value, for

example: =, <, >
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value Specifies the value to compare against to determine selection, for
example 5.

Example:
where id=5

This classifier formats the column values as specified in the default database column formatter, so that they
match the corresponding display in the results table. You can achieve more control over formatting structured
facets using the Structured Column classifier

See The SQL Classifier on page 165 for detailed descriptions of the SQL classifier settings.

Classifying Content Based on Database Column Values

The Structured Column classifier creates a taxonomy based on the entries of one or more columns in a
structured datasource.

You can use this classifier to create multiple taxonomy levels of increasing specificity, for example, Country
-> State -> City,orSector -> Industry -> Company.

You can also use this classifier with the appropriate taxonomy builder to create taxonomies for dates, prices,
and URLs.

oMz _RESOURCES [

You configure a column classifier by specifying the data source name and the column names that you want to
capture. The Structured Column classifier creates a facet for each unique value within the specified column,
for example, each unique model name in the model name column. It also creates a separate level for each
column that you specify.

Note: You may receive SQL errors if one or more of the columns you specified does not exist in the
specified schema or table.

You can use additional Structured Column classifier features to:
¢ Configure multiple taxonomy levels from structured columns
¢ Configure the appearance of the child facet names
¢ Specify an optional View for the database

See The Structured Column Classifier on page 166 for detailed descriptions of the Structured Column
classifier settings.
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Configuring Multiple Taxonomy levels from Structured Columns

You can configure multiple taxonomy levels by specifying multiple column names. The column classifier uses
each column in the list to create child facets of the preceding column, so that specifying three columns results
in three taxonomy levels.

city_hae

Note: You may receive SQL errors if one or more of the columns you specified does not exist in the
specified schema or table.

Configuring the Appearance of Structured Column Child Facet Names

You can configure the appearance of the child facet names by specifying regular expressions to perform
operations on the column values, such as capitalizing names and removing unwanted characters. See
Specifying Regular Expression Substitutions on page 186 for more information on using regular expression
replacement.

Example: Creating a Taxonomy from Database Categories

In this example, we create a taxonomy from data stored in a database using the structured column classifier.
Consider a database of information about books that contains following categories, or columns:

Genre
SubGenre
SubSubGenre

Assume that we have defined a navigation application Books, and added a Genre taxonomy:

To configure the structured column classifier for the Genre taxonomy:

1 Select Genre, and select the Classifiers tab
The Personalized Navigation application interface displays the Classifiers screen.

2 Select the Structured Column classifier type from the Structured Classifier group, and select Add
Classifier

The Structured Column classifier tab displays.
3 Configure the structured column classifier as follows:

Parameter Configuration

Datasource Name Select the desired data source from the list of data sources configured
for your application.
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Fields Use the New Value field to enter the field names in the order in which
they occur in the taxonomy:

Genre
SubGenre
SubSubGenre

Taxonomy Builder The Column classifier uses the default String taxonomy builder to
create child facets from the values contained in the specified columns.

oMS_RESOURCES )

Genre
SubGente

SubSubGenre

[

The generated taxonomy contains facets that correspond to the values of the various field names associated
with the configured columns, for example:

Genre SubGenre SubSubGenre
|
Mystery
—  Fiction |_Romance
I—Speculative ~|: renlasy
Science
Genre | Fiction
Biography
— Nonfiction |_ Histaory
I— Science
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Note: The facets are ordered within the taxonomy in alphabetical order by default. You can change the
order of the facets within a taxonomy using a comparator, as described in The Personalized Navigation
Application on page 109.

Example: Creating a Taxonomy from Dates in a Database

In this example, we create a taxonomy from dates stored in a database using the structured column classifier.

Assume that we have defined taxonomy called Date:

r Personalized Mavigation

To configure the structured column classifier for the Date taxonomy:

1 Select Date, then select the Classifiers tab
The Personalized Navigation application interface displays the Classifiers screen.

2 Select the Structured Column classifier type from the Structured Classifier group, and select Add
Classifier

The Structured Column classifier tab displays.

3 Configure the basic structured column classifier settings as follows:

Parameter Configuration
Datasource Name | Select from the list of data sources configured for your application.
Fields Use the New Value field to enter the name of the date column.

%

cMs_RESOURCES &

4 Select Show Advanced Settings, and select Date Taxonomy Builder from the Taxonomy Builder
drop-down menu

The Structured Column screen displays the Date Taxonomy Builder settings.

5 Accept the default (Create Standard) or configure additional Date classification options

Date Taxonomy Buider |
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The generated taxonomy contains standard date facets that correspond to the values of the date fields names
associated with the configured columns, for example:

January

2001 February

March

BNENEEE

January

2002 February

tarch

11311

Example: Creating a Price Taxonomy from a Database

In this example, we use the Structured Column classifier to create a taxonomy based on price.
To configure the Structured Column classifier for the Price taxonomy:

1 Create and select the facet named Price, then select the Facet Settings tab

2 Select the Currency comparator from the Advanced Facet Settings

3 Select the Classifiers tab, add the Structured Column classifier, and configure the basic settings as

follows:
Parameter Configuration
Datasource Name Select the desired data source from the list of data sources configured
for your application.
Fields Use the New Value field to enter the name of the price column.

4  Select the Range taxonomy builder from the Advanced Classifiers setting, and specify the following

values:
Parameter Configuration
Minimum Value Specify 0 to set the minimum price value to include in the facet. This
value sets the lower boundary of the range of the facet.
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Maximum Value Specify 50 to set the maximum price value to include in the facet. This
value sets the upper boundary of the range of the facet.

Depth Specify 2 to set the number of levels of the taxonomy.

Branching Factor Enter 5,2 to specify that the first level of the facet is divided into five

equal partitions, and that the second level facets is divided into two.

Tolerance Enter .01 to specify that values differing by this amount are treated as
separate entries in the taxonomy, such that items priced at $3.99 are
selectable separately from item priced at $3.98.

The resulting taxonomy contains the facets:

$0- §4.99

$10 - $9.99 — $5- $2.99
$10- $14.99
0 - %1993 = 15 - $19.99
$20 - $24.99
$20-52999 | — | 53552900

Price ==
$30 - §34.99
$3|:| - 53999 = 35 - $39.99
$40 - $44 93
F40 - $4909 | — $45 - $49.99
Ahove $50

Note: Thereis no Below $0 facet be cause no prices are below zero.

Classifying Large Taxonomies by Accessing the Data at Runtime

You can use the Ad Hoc Column classifier to create a numeric range-based taxonomy, such as prices or
years, dynamically at runtime when specifically selected by the user.

You should use the Ad Hoc Column classifier when:
» The results of conventionally classifying the data are very large.
» The performance loss of accessing the data source at runtime is acceptable.
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You can also use the Ad Hoc Column classifier in combination with the Structured Column classifier to create
a taxonomy that is partially pre-calculated and partially created at runtime.

s _RESOURCES P

You configure the Ad Hoc Column classifier by specifying the data source and column name that you want to
classify. Specify minimum and maximum values for the specified field to include in the facet.

Specify a Branching Factor, which is the number of parts into which the specified range should be divided.
The default value is 5, which specifies that a range of 0 - 50 is divided as:

0 - 10
10 - 20
20 - 30
30 - 40
40 - 50

Specify the Tolerance, which is maximum difference between two values that is significant. For example, for
US currency, the tolerance is .01 (1 cent). The default is 0.

You can specify additional parameters to control the appearance of the generated facets, as described in
Configuring the Appearance of Structured Column Child Facet Names on page 151.

See The Ad Hoc Column Classifier on page 167 for detailed descriptions of the Ad Hoc Column classifier
settings.

Classifying Content by Collection

The Collection classifier classifies all documents in the specified collections. You can use this classifier to
define a taxonomy that matches all content in the specified collections at the document level.

When end users select a collection-based facet, the application restricts results to only documents from the
associated collections.

You configure the Collection classifier by specifying a list of the collections that you want to include in the
facet definition. Specify collections by selecting from the list of collections configured for your application in
the New Value field. The order in which you list the collections does not affect the facet.
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Note: This classifier does not create child facets. There is no taxonomy builder associated with this
classifier.

You can specify an advanced Collection facet setting to specify that document information for each matching
document is stored explicitly in the application's index.

The Collection classifier matches every document in the specified collections; however by default it does not
explicitly store the document information in the index; instead it uses a more economical method of
associating the collection facet with the specified collection content.

There are some cases, such as when using Dictionary rules to perform advanced content restriction, in which
the system requires that the document information is explicitly contained in the index.

You specify explicit classification using the Explicit Classification setting in the advanced settings. Select the
checkbox to specify explicit classification.

See The Collection Classifier on page 169 for detailed descriptions of the Collection classifier settings.

Classifying Content by Document Type
The Document Type classifier creates a taxonomy based on document type. It generates a facet for each
selected document type:

« HTML

« IQXML

¢ MS-EXCEL

¢ MS-POWERPOINT
¢ MS-WORD

* PDF

* RTF

o TEXT

¢ UNKNOWN

* XML

When end users select a document type facet, the application restricts results to only documents of the
specified types.

i =-POVVERPOINT

RS- WORD

See The Document Type Classifier on page 170 for detailed descriptions of the Document Type classifier
settings.

ORACLE KNOWLEDGE INTELLIGENT SEARCH OPTIMIZATION GUIDE ORACLE



158 IMPLEMENTING PERSONALIZED NAVIGATION

Using IML Expressions to Classify Content

The IML classifier classifies unstructured content based on InQuira Match Language (IML) expressions. See
Chapter 4, IML Reference for more information on using IML.

You can use this classifier to define a facet that matches all content that matches the specified IML. When
end users select an IML-based facet, the application restricts results to only content that matches the
specified IML.

Note: This classifier does not create child facets. There is no taxonomy builder associated with this
classifier.

You configure an IML classifier by specifying:
» The IML expression
» The scope you want to apply the expression to

For example, you could specify the expression cat or dog and the Document scope to match all
documents that contain the words cat or dog.

Similarly, you could specify the Tit1le scope to match only Titles that contain the words cat or dog.

See The IML Classifier on page 175 for detailed descriptions of the IML classifier settings.

Classifying Content Based on Language
The Language classifier creates a taxonomy based on document language. It generates a facet for each
selected document type:

» English

e French

* German

« ltalian

» Japanese

» Korean

» Spanish
 Traditional Chinese
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When end users select a language-based facet, the application restricts results to documents identified as
being in the specified languages.

This classifier can generate facets both for base languages (as listed above) and for localized languages,
such as English:US or English:GB.

See The Language Classifier on page 176 for detailed descriptions of the Language classifier settings.

Classifying Content Based on HTML Meta Tags

The Meta Tag classifier generates a taxonomy based on the values of specified meta-tags within HTML
documents. Meta-tags are mark-up that specify information about a document that is not meant to be
displayed by the browser.

You can use this classifier to create multiple levels of facets based on the specified meta-tags of increasing
specificity, for example:

<meta name="Genre" content="Fiction"/>
<meta name="SubGenre" content="Speculative"/>
<meta name="SubSubGenre" content="Fantasy"/>

You configure a meta-tag classifier by specifying the meta tag name for each level in your taxonomy. The
Meta Tag classifier creates a facet for each unique content value within the specified tag, for example, each
unique content value (Fiction, Nonfiction, etc.) associated with a Genre meta-tag. It creates a
separate level for each meta-tag that you specify, in the order listed.

Important! You must ensure that the meta-tags that you specify for classification are added to the
Preprocessor configuration file.

You can use advanced Meta Tag classifier features to configure child facet creation by specifying and
configuring a taxonomy builder.

See Personalized Navigation Application Classification Components on page 165 for detailed descriptions
of the Meta Tag classifier settings.
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Example: Creating a Taxonomy from Document Metadata

In this example, we classify documents based on the content of metadata tags using the Meta Tag classifier.
Consider a collection of documents that contain meta-data that define the following content categories:

<meta name="Genre" content="Fiction"/>
<meta name="SubGenre" content="Speculative"/>
<meta name="SubSubGenre" content="Fantasy"/>

To configure the metadata classifier for the Genre facet:

1 Select the Genre facet, and select the Classifiers tab
The Personalized Navigation interface displays the Classifiers screen.

2 Select the Meta Tag classifier type from the Unstructured Classifier group, and select Add Classifier
The Meta Tag classifier tab displays.

3 Configure the meta tag classifier as follows:

Genre
SubGenre
SubSubGenre

[
Parameter Configuration
Meta Tags Use the New Value field to enter the field names in the order in which

they occur in the taxonomy:

Genre
SubGenre
SubSubGenre

Taxonomy Builder Use the default String taxonomy builder. You configure the taxonomy
builder in the Advanced Settings. The String taxonomy builder sorts
sibling facets alphabetically by default. You can configure a comparator
to sort the facets differently, as described in The Personalized
Navigation Application on page 109.
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The generated taxonomy contains facets that correspond to the values of the various field names associated
with the configured columns, for example:

Genre SubGenre SubSubGenre
|
Mystery
—  Fiction FRGI‘HEHCQ
LSp:ua--::Lﬂative { raiesy
Science
Genre | Fiction
Biography
— Nonfiction F History
\— Sclence

Classifying Content Based on Dictionary Concepts

The Ontology classifier generates a taxonomy from specified Dictionary concepts.

The Ontology classifier creates facets from the specified concepts, and creates additional levels of the
taxonomy from the children of the specified concepts.

You can specify IML to restrict the content that matches the generated facets so that, for example, only
documents that contain the facet label concept in the title match when the facet is selected.You use the
Ontology classifier by specifying one or more entries to match:

» Concepts that you want the system to identify
» Concepts that you specify, either explicitly or by using the wildcard character
The Ontology classifier creates concept facet names in the form:
<concept description>
if the concept's description is short enough, or
<concept name>

without part of speech and domain information.

You specify IML to restrict the content match by specifying any valid IML, and selecting the desired result
scope from the listbox.

See The Ontology Classifier on page 171 for detailed descriptions of the Ontology classifier settings.
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Classifying Content by Directory Structure

The Site Graph classifier generates a taxonomy based on a specified directory structure. This produces a
taxonomy that resembles a file explorer.

You can specify to classify content based on the URL of the document as it was crawled, rather than the URL
that is displayed in the User Interface using the Fetch URL setting.

You can also modify directory names using the Prefix field to globally remove a specified prefix string from the
URL, or by configuring the Directory taxonomy builder.

See The Site Graph Classifier on page 173 for detailed descriptions of the Site Graph classifier settings.

Classifying Content by URL

This classifier assigns content to the facet based on regular expression matches to document URLSs.
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Note: This classifier does not generate child facets. There is no taxonomy builder associated with this
classifier.

You use the URL classifier by specifying a regular expression to match relevant characteristics of URL names
within your application content.

Note: The URL classifier processes regular expressions according to the rules and standards defined for
using regular expressions within Java applications.

Useful symbols in regular expressions include:

Symbol! |Function
matches any character

* causes the previous character or expression to match zero or more times
+ causes the previous character or expression to match one or more times
(?) added to the beginning of a string, causes the following string to match regardless of case.

1. +indicates an obligatory match; * indicates an optional match.

Examples:

The regular expression:
"ab+c"

matches all strings that:
* start with "a"

* end with "c"
and

¢ have any number of "b"s in between
The regular expression:

"abc.*"
matches all strings that

¢ start with "abc"
and

« are followed by anything

See The URL Classifier on page 174 for detailed descriptions of the URL classifier settings.
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Using the Unstructured Content Classifier

This classifier classifies data within unstructured content that matches specified IML expressions. Each IML
expression matches (or sets a variable on) data that generates one level in the taxonomy.

See Chapter 4, IML Reference for more information about IML.

You use the Unstructured Content classifier by specifying one or more document collections, and one or more
IML expressions to match.

[=tring Tacconormey Builder l_

2 Iphabetical r [Database Column Furmaﬂer

You can also configure the taxonomy builder to determine child facet creation. The String taxonomy builder is
the default.

See The Unstructured Content Classifier on page 174 for detailed descriptions of the Unstructured Content
classifier settings.
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Personalized Navigation Application Classification Components

The Personalized Navigation application provides access to the following content classification components:
 Structured data classifiers, as described in Structured Data Classifiers on page 165
» Unstructured data classifiers, as described in Unstructured Data Classifiers on page 168
* Structured or unstructured data classifier, as described in Advanced Data Classifier on page 176

» Taxonomy builders, as described in Personalized Navigation Application Taxonomy Builders on
page 180

» Comparators, as described in The Personalized Navigation Application on page 109
» Formatters, as described in Personalized Navigation Application Formatters on page 187

Structured Data Classifiers

Personalized Navigation provides the following classifiers for structured data.

Basic Classifiers |Description

SQL Classifier This classifier selects all entries in the specified data source that
match a specified SQL condition, as described in The SQL Classifier
on page 165.

Structured Column | This classifier creates a taxonomy based on the entries of one ore
Classifier more columns in a structured source, as described in The Structured
Column Classifier on page 166.

Advanced
Classifiers Description
Ad Hoc Column This classifier creates a numerical range-based taxonomy, such as
Classifier prices or years, at run time when specifically selected by a user, as
described in The Ad Hoc Column Classifier on page 167.
The SQL Classifier

This classifier selects all entries in the specified data source that match a specified SQL condition.

Note: This classifier does not generate child facets. There is no taxonomy builder associated with this
classifier.

Basic Setting ‘Description
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Datasource Name Select the desired data source from the structured data sources
configured for your application.

SQL Condition Specify an SQL condition that selects the appropriate values from the
specified table for this facet. You use this classifier by specifying one
or more conditions that include the contents of the WHERE clause, for
example, 1d=5.

The Structured Column Classifier

This classifier creates taxonomies based on the entries of one or more columns in a structured datasource.

You can use this classifier to create multiple levels of facets of increasing specificity, for example, Country
-> State -> City,orSector -> Industry -> Company.

You can also use this classifier for structured data such as dates, prices, and URLs by selecting the
appropriate taxonomy builder in the advanced settings.

cMs_RESOURCES ¥

Basic Setting Description

Datasource Name Select the desired data source from the structured data sources
configured for your application.

Fields Specify one or more columns to use to create facets using the New
Value field. The structured column classifier creates a separate level for
each column that you specify.

[

“f'ou can drag an itern ko change its position within the list

String Taconormy Builder r
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Advanced Setting |Description

Regular expressions | Specify one or more optional regular expressions to match features of
the column names that you want to replace. Use the New Value field to
add regular expressions to the list. See Specifying Regular Expression
Substitutions on page 186 for more information.

Regular expression | Specify a corresponding replacement value for each regular
replacements expression. Use the New Value field to add replacement expressions.
See Specifying Regular Expression Substitutions on page 186 for
more information.

SQL View Specify an optional view of the data source. This is generally required
only when you need to perform a table join.

Taxonomy Builder Select and configure an optional taxonomy builder to generate child
facets for this facet, as described in Personalized Navigation
Application Taxonomy Builders on page 180. The default is to use the
String taxonomy builder to create facets at all levels for which you have
specified columns in the Fields setting.

The Ad Hoc Column Classifier

You can use the Ad Hoc Column classifier to create a numeric range-based taxonomy, such as prices or
years, dynamically at runtime when specifically selected by the user.

You should use the Ad Hoc Column classifier when:
» The results of conventionally classifying the data are very large.
» The performance loss of accessing the data source at runtime is acceptable.

You can also use the Ad Hoc Column classifier in combination with the Structured Column classifier to create
a taxonomy that is partially pre-calculated and partially created at runtime.

AD Hoc COLUMN CLASSIFIER SETTINGS

cMs_RESOURCES &

Basic Setting Description

Datasource Name Select the desired data source from the structured data sources
configured for your application.

Field name Specify the column to use to create the facet.
Minimum Value Specify the smallest value to include in the facet. The default is 0.0.
Maximum Value Specify the largest value to include in the facet. The default is 0.0.
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Branching Factor Specify the number of parts into which the specified range should be
divided. The default value is 5, which specifies that the range of values is
divided into five facets.

For example, the range 0 - 50 is divided into:

0 - 10
10 - 20
20 - 30
30 - 40
40 - 50
Tolerance Specify the maximum difference between two values that is significant.

For example, for US currency, setting the tolerance to .01 (1 cent),
generates facets in the form $10.00 - $19.99.

You can use the advanced Display Tolerance setting to round off facet
values as described below.

i |
Database Colurmn Formstter )

Dat: nh Formatter

Advanced Setting |Description

Display Tolerance Select this checkbox to subtract the Tolerance value from the range
when displayed in the User Interface. For example, if the Tolerance
value is set to .01 (1 cent), the range $10.00 - $15.00 is displayed as
$10.00 - $14.99.

Formatter Specify the formatter to generate the display name for the facet, as
described in Personalized Navigation Application Formatters on
page 187. The default is the Database Column formatter, which
displays the value of the column as the facet name.

Unstructured Data Classifiers

Personalized Navigation provides the following basic and advanced classifiers for unstructured data.

Basic Classifier Description

Collection This classifier classifies all documents in the specified collections, as
described in The Collection Classifier on page 169.

Document Type This classifier classifies documents based on their format types, for
example HTML or PDF, as described in The Document Type Classifier
on page 170.

Meta Tag Classifier | This classifier generates a taxonomy based on the values of specified
HTML meta-tags, as described in The Meta Tag Classifier on page 170.
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Basic Classifier Description (Continued)

Ontology Classifier | This classifier generates a taxonomy from specified Dictionary concepts,
as described in The Ontology Classifier on page 171.

Site Graph Classifier |This classifier generates a taxonomy based on directory structure, as
described in The Site Graph Classifier on page 173.

URL Classifier This classifier classifies based on regular expression matches against
the document URL, as described in The URL Classifier on page 174.

Unstructured This classifier classifies data within unstructured content by executing a
Content list of IML expressions, as described in The Unstructured Content
Classifier on page 174.

IML Classifier This classifier classifies unstructured content based on IML expression
matches, as described in The IML Classifier on page 175.

Language Classifier | This classifier classifies a document based on the language in which it is
written, as described in The Language Classifier on page 176.

The Collection Classifier

The Collection classifier classifies all documents in the specified collections. Only the facets for the collections
are displayed.

Note: This classifier does not generate child facets. There is no taxonomy builder associated with this
classifier.

Basic Setting ‘Description

Collections Specify one or more collections to classify by selecting from the list of

configured collections for the application.
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Advanced Setting |Description

Explicit Select to specify that all documents be explicitly stored in the facet.
Classification

Note: This is only necessary to support advanced restriction of collections in
the Dictionary rules. See Referring to Facets from Dictionary Rules on
page 138 for more information.

The Document Type Classifier

This classifier classifies documents based on their format types, such as HTML, PDF, or IQXML.

Note: This classifier does not generate child facets. There is no taxonomy builder associated with this
classifier.

M=-POWERPOINT
S AORD

Basic Setting ‘Description
Document Types

Select the document types that you want to classify from this list. Use
the Shift and Ctrl keys to select multiple document types.

The Meta Tag Classifier

This classifier generates a taxonomy based on the values of specified meta-tags.

Basic Setting Description

Meta Tags Specify one or more meta tags to use to create facets using the New
Values field. The Meta Tag classifier creates a new taxonomy level for
each meta tag in the order specified.
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String Taxonomy Builder |—

aiphabetical | Database Colurn Farmatter |7

Advanced Setting |Description

Taxonomy Builder Select a taxonomy builder to use for this facet, as described in Personalized
Navigation Application Taxonomy Builders on page 180. The String Taxonomy
Builder is the default.

The Ontology Classifier

This classifier generates a taxonomy from specified Dictionary concepts and their children.

Taxonomy Facet: testal
Structured Unstructured Other
Classifier Group: ® @ ® Classifier TYW:W] Add Classifier Advanced Classifiers
ontolegy |
|Finalry, any concepts that should not be included in the taxonomies can be specified in the "Exclude Concepts” list. -

~Ontology -- Settings

Auto Detect Concepts Indude Concepts

Values: Values: L

Mew Value: |M Delete ||Replace Mew Value: |M Delete ||Replace

rExdude Concepts

Values:

Mew Value: |M Delete ||Replace
Maximum Name Size: IEI

IML: |Eng|ish Customerhelp
Comparators: | Alphabetical -

m

rIML

IML — Settings

IML Expression: [] |

Desired Result Scope:

L

Values:

New Value:

a [ 1
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Basic Setting

Description

Auto Detect
Concepts

Specify representative concepts for which you want the system to locate and generate
taxonomies for similar concepts.

Include Concepts

Specify one or more concepts that you want to use as the basis of the taxonomy.

Exclude Concepts

Specify any concepts that you want to exclude from taxonomies. The Ontology classifier
excludes the children of excluded concepts unless they are explicitly included as separate
entries.

IML Settings

Description

IML Expression

Specify an optional IML expression to evaluate to determine which documents are
matched by this facet. Use [] to designate the concept within the IML expression.

The [] by itself just means to look for the concept. The [] represents the concept in the IML
pattern. The default is to match documents with the concept; but, you can modify the IML
to make it more precise:

e TITLE ([]) means only match if the title contains the concept,

e DOC([] * []) means only match documents that have the concept at least twice,

¢ SENT(, [instruction manual]) means only match a document that has a

sentence with the concept and the user guide concept.
You only need to change [] to something more intricate if you're trying to prevent over-

matching.

Desired Result
Scope

The IML expression is searched for only within the specified scope:
¢« Document

« Title

* Reference

¢ Section

« Subtitle

* Sentence

e Any

Document is the default scope.

The same documents match no matter which scope you use; however, different portions of
the document are classified.

For example, you have a document with 100 tokens (0 through 99), your IML was SENT( ,
[, and the document tokens 25 through 31 corresponded to the sentence "The new user
guide for this concept". The IML matches this sentence. If the scope is set to Document,
then tokens 0 through 99 get added to the facet.

However, if the scope is set to Sentence, then only tokens 25 through 31 are added to the
facet. Whenever you reference that facet in a rule (e.g. facet restriction), it uses a different
set of tokens.

You see this in the service browser if you look at the facet tables. The scope is used to
determine how much of the document gets classified into the facets. For instance, if the
IML matches a single sentence and your scope is set to Sentence, then only that
sentence is added to the facet (e.g. if you then restrict to that facet, then only the sentence
is returned rather than the entire document). Similarly, if you set the scope to Document,
the entire contents of the document is added to the facet.

The Document/Sentence scope only matters when you perform a restriction. If you set it
to Sentence scope, only the specific sentence that matched [] has the facet annotation. If
you set it to Document scope, the entire document has that facet annotation. The
sentence level matches are counted as one document that matches so they do not affect
the facet counts.

Titles have a separate setting to ensure that titles of documents are not excluded from
matching because of sub-document-level facets. This is configurable.

Collections

The collections specified tell which collections to pass through the ontology classifier. If no
collections are specified all collections are processed.
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The Site Graph Classifier

This classifier generates a taxonomy based on a specified directory structure.

Basic Setting Description

Collections Select one or more collections to classify from the list of configured
collections for the application. Use the New Value field to add
collections to the list.

Advanced Setting |Description

Fetch URL Select to classify based on the URL of the document as it was crawled,
rather than the URL that is displayed in the User Interface.

Directory Taxonomy | Specify settings for the Directory taxonomy builder, as described in The
Builder Directory Taxonomy Builder on page 183.
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The URL Classifier

This classifier classifies based on regular expression matches against the document URL.

Note: This classifier does not generate child facets. There is no taxonomy builder associated with this
classifier.

Setting Description
URL Regular Specify one or more regular expressions to match the URLSs.
Expression

Setting ‘ Description
Fetch URL

Select to classify based on the URL of the document as it was crawled,
rather than the URL that is displayed in the User Interface.

The Unstructured Content Classifier

This classifier classifies data within unstructured content that matches specified IML expressions. Each IML
expression matches (or sets a variable on) data that generates one level in the taxonomy.

See Chapter 4, IML Reference for more information about IML.

Basic Setting Description
Collections Specify one or more collections use for this facet.
IML Expressions Specify one or more IML expressions to evaluate to determine which

documents are matched by this facet. Each IML expression generates
a new level in the taxonomy.

ORACLE KNOWLEDGE INTELLIGENT SEARCH OPTIMIZATION GUIDE DRACLE'



175 PERSONALIZED NAVIGATION APPLICATION

String Taxonommy Builder r

sinhabetical |7 Database Column Formatter [

Advanced Setting |Description

Taxonomy Builder Specify settings for a taxonomy builder, as described in Personalized
Navigation Application Taxonomy Builders on page 180. The String
taxonomy builder is the default.

The IML Classifier

This classifier classifies unstructured content based on matching specified IML expressions.
Refer to the Chapter 4, IML Reference for more information on IML.

Note: This classifier does not generate any child facets. There is no taxonomy builder associated with this
classifier.

Setting Description

IML Expression Specify an IML expression to evaluate to determine which documents are
matched by this facet.

Desired Result Select the scope to restrict matching of the IML expression:
Scope

¢ Document
« Title

* Reference
« Section

e Subtitle

« Sentence
* Any
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The Language Classifier

This classifier classifies documents based on their encoded language.

Basic Setting ‘Description
Language

Select one or more languages to include in this taxonomy. Each
selected language creates an separate facet.

Advanced Data Classifier

Personalized Navigation provides the Template advanced classifier for structured or unstructured data.

The Template Classifier

The Template classifier adds further classification to an existing taxonomy. For every element of the
taxonomy, this classifier attempts to apply the template and, if the template successfully creates a new
classifier, it is added to that element.

This is particularly useful in creating a taxonomy for both unstructured and structured data. The taxonomy
could, for example, be initially created with the Structured Column classifier and then a Template classifier
could be used to add IML classifiers for the unstructured data.

To access the Template classifier:
1 On the Classifiers tab, select Classifier Group: Other.

2 Select Advanced Classifiers.
Template displays in the Classifier Type field.

3 Click Add Classifier to define the Template classifier.

The Personalized Navigation window displays the Template Settings section.
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Basic Setting Description
Template Select a classifier template to use for this facet. The options are:
* IML

¢ On-the-fly Range

« Structured To Unstructured

* URL

Additional settings must be defined for each type of template. See the following
sections for details.

IML TEMPLATE SETTINGS

Classifies unstructured content based on IML expressions. This does not create a taxonomy but simply finds
documents to be included in the current facet.

IML is a powerful text matching language that functions on the word level. The Oracle Knowledge
documentation contains a detailed description of IML.

Basic Setting Description

IML Expression Specify an IML expression to evaluate to determine which documents
are matched by this facet.

Desired Result Scope | Select the scope to restrict matching of the IML expression:

e Document

« Title

* Reference

« Section

¢ Subtitle

¢ Sentence

* Any

Collections Select one or more collections to classify from the list of configured
collections. Use the New Value field to add collections to the list.

ON-THE-FLY RANGE TEMPLATE SETTINGS

This classifier creates a numerical range based taxonomy, such as prices or years, at run time when
specifically selected by a user. This should be done when the taxonomy would be too big if created prior to
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run time by the Structured Column classifier and the performance loss of continually accessing the data

source is unimportant.

This classifier can also be used in combination with the Structured Column classifier to create a taxonomy
that is partially precomputed and partially created at run time.

E

Basic Setting

po |

Description

Datasource Name

Field Name
Display Tolerance

Minimum/
Maximum Value

Branching Factor

Tolerance

Formatter

Select the desired data source from the structured data sources
configured for your application.

Specify the column to use to create the facet.

Select to subtract the Tolerance value from the range when displayed in
the User Interface. For example, if the Tolerance value is set to .01 (1
cent), the range $10.00 - $15.00 is displayed as $10.00 - $14.99.

See Tolerance below for more information.

Specify the smallest and largest value to include in the facet. The default
is 0.0.

Specify the number of parts into which the specified range should be
divided. The default value is 5, which specifies that the range of values
are divided into five facets. For example, the range 0 - 50 is divided
into:

0-10
10-20
20-30
30-40
40 - 50

Specify the maximum difference between two values that is significant.
For example, for US currency, setting the tolerance to .01 (1 cent),
generates facets in the form $10.00 - $19.99.

Use the Display Tolerance setting to round off facet values in the Ul.

Specify the formatter to generate the display name for the facet, as
described in Personalized Navigation Application Formatters on
page 187. The default is the Database Column Formatter, which
displays the value of the column as the facet name.
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STRUCTURED To UNSTRUCTURED TEMPLATE SETTINGS

Structured To Unstruckured =

Basic Setting Description
Bridge Column Specify the column to use to create the facet.
Template Options are:

¢ IML — See IML Template Settings on page 177.
¢ URL — See URL Template Settings on page 179.

URL TEMPLATE SETTINGS

Classifies based on regular expression matches against the document URL. This does not generate a
taxonomy but merely selects matching documents to be classified in this facet.

Regular expressions are a powerful method for matching text. Three particularly useful symbols in regular
expressions are:

Symbol  Description
(Dot) In the default mode, this matches any character except a newline.

* (Asterisk) Causes the previous symbol to match zero or more times. ab* matches a, ab,
or a followed by any number of b's.
+ (Plus) Causes the previous symbol to match one or more times. ab+ will match ‘a’

followed by any non-zero number of 'b's; it will not match just 'a’.

For example, if you want to match all strings starting with a, ending with ¢, and containing any number of bs in
between, you would use the regular expression ab+c. If you want to match abc followed by anything at all,

you would use abc*.
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Basic Setting Description

URL Regular Specify one or more regular expressions to match the URLSs.

Expression

Case Sensitive Select to indicate that the URL expression is case sensitive.

Fetch URL Select to classify based on the URL of the document as it was crawled,
rather than the URL that is displayed in the User Interface.

Personalized Navigation Application Taxonomy Builders
Taxonomy Builders are procedures that you configure within classifiers to create new facets during the
classification process. Taxonomy builders enable you to:
» Generate facets in your taxonomy programmatically
» Automatically update facets within data repositories that are subject to frequent change

Taxonomy builders provide a convenient method of automating the classification process, which in many
cases can be difficult or impossible to perform manually.

For example, to classify a database having category and subcategory fields, we could create each
facet by hand, and configure a structured column classifier to select the appropriate row for each facet.
However, this be an impractical approach for data containing hundreds of facets, especially if the structure is
subject to frequent change.

Taxonomy builders use the data from the classifier in which they are configured to construct new taxonomy
sub-facets. Each time the data is classified, the classifier reconstructs the taxonomy to correspond to any
changes to the referenced data.

You can use taxonomy builders with the following classifiers:
» The Structured Column classifier
e The Meta Tag classifier

e The Site Graph classifier (only the Directory taxonomy builder is available)

You configure taxonomy builders by specifying values for various parameters that correspond to properties of
the data that you want to classify. You can configure taxonomy builders to classify data based on directory
structures, dates, text strings, and ranges of values, as described in:

e The String Taxonomy Builder

» The Date Taxonomy Builder

» The Directory Taxonomy Builder
* The Range Taxonomy Builder
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The String Taxonomy Builder

The String taxonomy builder generates taxonomy entries based on the text strings contained within the target
data.

You configure the String taxonomy builder by specifying various optional and required parameters. The
Directory Taxonomy Builder screen displays the configuration settings:

String Taxonomy Builder |—

| lphabetical l_ atabase Column Formatter |—

The following table describes the String Taxonomy Builder settings.

Advanced

Parameter Description

Combine Levels Select this parameter to specify to combine any non-branching paths
into a single facet.

Comparators Use this field to specify optional comparators to determine the order of
the facets. See The Personalized Navigation Application on page 109
for more information on using Comparators within Taxonomy Builders.

Formatters Use this field to specify optional formatters to determine the labels of
facets within the User Interface. See Personalized Navigation
Application Formatters on page 187 for more information on using
Formatters within Taxonomy Builders.

The Date Taxonomy Builder

The Date taxonomy builder generates taxonomy entries based on date values within the target data. The
Date taxonomy builder also contains settings to create facets for dynamically defined dates, such as Today
and This Week.
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You configure the Date taxonomy builder by specifying various optional and required parameters. The Date

Taxonomy Builder screen displays the basic and advanced configuration settings:

Date Taconormy Builder |—

Basic Parameters

Mumber

hiorth
Mumber o
slphabetical |7

A list of comparatars which detemning how facets should be ordered

Description

Create Standard

Use this field to specify a basic taxonomy that includes years, months,
and days.

Create Today

Use this field to create a facet for items occurring today. For example,
to categorize news articles by their posting date.

Note: This facet requires classification on a daily basis.

Create This Week

Use this field to create a facet for items occurring this week. Weeks are
defined as Sunday - Saturday.

Note: This facet requires classification on a daily basis.

Create This Month

Use this field to create a facet for items occurring this month.

Note: This facet requires classification on a daily basis.

Create This Year

Use this field to create a facet for items occurring this year. For
example, to categorize books by their publication date.

Note: This facet requires classification on a daily basis.

Create All Dates

Use this field to create a facet containing all dates.

Combine Levels

Select this parameter to specify to combine any non-branching paths
into a single facet.

Today Label

Use this field to specify the text for the Today facet, for example,
Today's Articles.

This Week Label

Use this field to specify the text for the This Week facet.

This Month Label

Use this field to specify the text for the This Month facet.

This Year Label

Use this field to specify the text for the This Year facet.

All Dates Label

Use this field to specify the text for the All Dates facet.

Language

Use this field to specify the language in which the dates should be
rendered. Supported languages include any that java supports.
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Comparators

Use this field to specify optional comparators to determine the order of
the facets. See The Personalized Navigation Application on page 109
for more information on using Comparators within Taxonomy Builders.

Formatters

Use this field to specify optional formatters to determine the
presentation of facets within the User Interface. See Personalized
Navigation Application Formatters on page 187 for more information
on using Formatters within Taxonomy Builders.

The Directory Taxonomy Builder

The Directory taxonomy builder generates taxonomy entries based on directory paths within a file system.
The result resembles a file browser.

You configure the Directory taxonomy builder by specifying various optional and required parameters. The
Directory Taxonomy Builder screen displays the basic and advanced configuration settings:

[Directory Taxonomy Builder r

Basic Parameter

ciphapetical |

Description

Prefixes

Advanced
Parameter

Use this optional parameter to remove a specified common prefix in the directory
names from the facet names.

Note: To remove multiple prefixes, use the Regular Expressions field in the Advanced
section.

Description

Combine Levels

Select this parameter to specify to combine any non-branching paths into a single
facet.

Comparators

Use this field to specify optional comparators to determine the order of the facets.
See The Personalized Navigation Application on page 109 for more information
on using Comparators within Taxonomy Builders.
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Formatters

Use this field to specify optional formatters to determine the presentation of facets
within the User Interface. See Personalized Navigation Application Formatters
on page 187 for more information on using Formatters within Taxonomy Builders.

Regular Expressions

Use this field to specify optional regular expressions to transform matching strings
to the corresponding expressions specified in the Regular Expressions
replacements field. See Specifying Regular Expression Substitutions on

page 186 for more information on using regular expression substitution within
Taxonomy Builders.

Regular expression
replacements

Use this field to specify optional regular expression replacements for strings that
match the corresponding expressions specified in the Regular Expressions field.
See Specifying Regular Expression Substitutions on page 186 for more
information on using regular expression substitution within Taxonomy Builders.

The Range Taxonomy Builder

You can use the Range taxonomy builder to generate taxonomy entries that subdivide a range of values. The
resulting taxonomy is a subdivided range of values. The Range Taxonomy Builder screen displays following
basic and advanced settings.

range Taxonomy Buicer [

Basic Parameter

Crver

Uncier

Catabese Colunn Formetter r

Description

Do Above Use this field to create a facet containing all items whose value is greater than the
Maximum Value setting, for example Over $50.00.
Do Below Use this field to create a facet containing all items whose value is less than the

Minimum Value setting, for example Under $5.00.

Minimum Value

Use this field to specify the minimum value to use as a range boundary, for
example, $5.00.

Maximum Value

Use this field to specify the maximum value to use as a range boundary, for
example, $50.00.

Depth

Use this field to specify the number of levels for the taxonomy. For example,
specify a depth of 2 to create top level facets and second level facets such that
selecting the top level facet displays the second level facets.
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Tolerance

Use this field to specify the maximum difference between two values that is
significant, such as .01 (one cent) for currency.

Branching Factors

Advanced
Parameter

Use this field to specify a list of values to divide the taxonomy ranges into. For
example, enter 5, 2 to specify that the top level taxonomy is divided into five
facets, and the second level is divided into two facets. If there are more levels
(specified by the Depth parameter) than branching entries, the lower levels use
the last entry in the list.

Description

Display Tolerance

Use this field to specify a value to subtract from the range when
displaying, so that the range $10-$15 displays as $10-$14.99.

Above Label

Use this field to specify the name of the facet showing values more
than the Maximum. You can use the characters [] which are replaced by
the maximum value. For example, specify:

Over []

to display

Over $50.00

where 50 is the value of the Maximum parameter.

Below Label

Use this field to specify the name of the facet showing values less than
the Minimum. You can use the characters [] which are replaced by the
minimum value. For example, specify:

Under []

to display

Under $50.00

where 50 is the value of the Minimum parameter.

Formatters

Use this field to specify optional formatters to determine the
presentation of facets within the User Interface. See Personalized
Navigation Application Formatters on page 187 for more information
on using Formatters within Taxonomy Builders.
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Specifying Regular Expression Substitutions

The Structured Column classifier and the Directory taxonomy builder provide fields in which you can specify
regular expressions and corresponding replacement expressions to capture and replace strings to use as
facet names.

You specify regular expression replacements as two separate lists of corresponding values.

Parameter Description

Regular Expression | Specify one or more regular expressions to match some characteristic of the field
or directory name.

Each entry must be paired with a corresponding replacement entry.

Regular Expression | Specify one or more strings as replacements for the characteristics of the field or
replacements directory names that match the specified regular expressions.

Replacements can include grouping syntax. For example, specifying:
([0-91+)

and the replacement expression
ngm

results in all numbers being quoted.

Personalized Navigation Application Comparators

Comparators are modules that compare two values and determine whether the first is less than, equal, or
greater than the second. You use Comparators to determine the order in which the facets are displayed in the
User Interface. You use Comparators within the String, Date, and Directory taxonomy builders.

You specify Comparators as a list of one or more items. Each entry in the list applies to the corresponding
level of the taxonomy. If there are more levels than comparator entries, the lower levels use the last entry in
the list.

For example, to specify a top level of a taxonomy level sorted alphabetically, followed by a second level
sorted by date, enter:

Alphabetical
Number

The resulting taxonomy might resemble:

Fiction
Mystery
Romance
Speculative

Nonfiction
Biography
History
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2lphabetical |

The Personalized Navigation application provides the following comparators:

Comparator Description

Alphabetical Use this comparator to specify that facets be sorted alphabetically.

Number Use this comparator to specify that facets be sorted numerically.

Currency Use this comparator to specify that facets be sorted by currency in
ascending order.

Dimension Use this comparator to sort facets based on dimensions that include
regular numbers (1, 3, 29, etc.), fractions (1/4, 3/8, etc.), and fractions
combined with numbers (e.g. 1-1/4, 1 1/4, 19-3/8, etc.).

Last Name Use this comparator to specify that facets be sorted alphabetically by
last name.

Month Use this comparator to specify that facets be sorted in calendar order

by month name.

Personalized Navigation Application Formatters

Formatters are procedures that perform string substitution on facet names as they are created by taxonomy
builders, so that you can control their presentation within the User Interface.

You use Formatters within the String, Date, Directory, and Range taxonomy builders.

You specify Formatters as a list of one or more items. Each entry in the list applies to the corresponding level
of the taxonomy. If there are more levels than formatter entries, the lower levels use the last entry in the list.

Diatabase Column Formatter |_

The Personalized Navigation application provides the following formatters:

Formatter

Description

Database Column
Formatter

Use this formatter to specify that the User Interface displays the value of the
configured column as closely as possible to the corresponding value on the
answer page.

Name Formatter

Use this formatter to specify that the User Interface displays person name values
in the form <surname>, <names.
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User Manager

The Oracle Knowledge User Manager is a component accessed from within the Language Workbench that

allows you to create and set permissions for Language Workbench users. To access User Manager please
see Intelligent Search Language Tuning Guide.

This Chapter explains:
» Using User Manager on page 189
» Add New User on page 190
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Using User Manager

Upon opening User Manager the following screen displays:

I % Uszer Accounts

Adriniskrator

The following installed Users appear in addition to any custom created user accounts.:

User Login Default Password
Administrator This is the password setup

Permissions

Dictionary Manager
User Manager

Test Drive

Quality Monitor

Edit Base, Industry data

DOMAIN_GROUPS
PERMISSIONS

Add Company Layer Domains
Personalized Navigation Setup
Administration Console
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Add New User

You can add Language Workbench Users by selecting Add new user from the User Manager screen. The
New user entry screen displays:

Note: Only Language Workbench Users with the User Manager permission set are able to create and
modify user accounts

-
22 New uzer entry

| |
| |
| |
| |
| |
| |
L
u
| |
| |

1 Enter the name of the User in the Full name field.
2 Enter the name to be used for logging into the Language Workbench in the Login field.
3 Enter the password to be used with the Login in the New password field.
Note: The password must be at least eight characters long, and contain both letters and numbers.
4 Reenter the password in the Confirm new password field.
5 Select the Permissions to be associated with the User. For more information, please see Permissions.

6 Click Save new user to save the newly created user. Upon saving, the Username appears in the User
Accounts screen.
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User Permissions

The following are the permissions available to each user:

Dictionary Manager

User Manager
Test Drive
Quality Monitor

Edit Base, Industry
data

DOMAIN_GROUPS
PERMISSIONS

Add Company Layer
Domains

Personalized Navigation
Setup

Administration
Console

View only
Administration Console

Allows the User to access Dictionary Manager.You can assign the
following advanced Dictionary Manager permissions described
below:

 Edit Base, Industry Data

e Add Company Layer Domains
Allows the User to access User Manager.
Allows the User to access Test Drive.
Allows the User to access Quality Monitor.

Allows the User to create and modify Dictionary Objects that belong
to Base and Industry level domains in Dictionary Manager.

Allows the User to create and modify Domains and Domain Lists
used in Dictionary Manager.

Allows the User to create Company Layer Domains used in
Dictionary Manager.

Allows the User to access Personalized Navigation Setup.

Allows the User to access System Manager to configure Oracle
Knowledge Intelligent Search.

Allows the User to view but not modify configurations in System
Manager.

Modify a User Account

To modify a User Account;

1 Double-click the Username you want to modify from the User Accounts screen.

2 After you make modifications, select Save new user. The changes take effect automatically.

Delete a User Account

To delete a user account: highlight the username and select Delete. The user name deletes.
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Configuring Access to Business Data

Oracle Knowledge accesses business data through the Preference Service, which accesses and stores
business data items that it obtains from configured data sources. The data sources that the Preference
Service accesses are called providers, and the data items that it uses are called preferences.

You can configure Oracle Knowledge to access business data from the following types of Providers:
» The current Oracle Knowledge session

» External sources, such as CRM packages

You access business data for use by the Business Rules module, which is a separate component that enables
you to:

» Configure the Preference Service to access Preference data from Providers

» Set Business Conditions within Rules based on user, session, and other context information
Business Conditions within Rules enable you to tailor application response based on various aspects of:

» User identity and activity

» Session activity

The Rules Engine evaluates Business Conditions within Rules by comparing the values obtained by the
Preference Service to the values specified within the Business Condition.

The Preference Service

The Preference Service manages the business data preferences obtained by the configured data providers.

Oracle Knowledge includes a session provider that is installed and configured with the application. The
session provider is designed to access only preference data for a given session; it does not store persistent
preference data for use in multiple sessions. See The Session Provider on page 193 for more information.

Access to Preference Data

The Preference Service uses a key to obtain preference values from configured providers. Keys take the form
of multiple strings concatenated by the period (.) character, for example:

string.string.string

The concatenated parts enable namespace traversal for data retrieval, as described in Hierarchical
Namespace Traversal on page 193.
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Hierarchical Namespace Traversal

The multi-part key format that the Preference Service uses to access preference data supports hierarchical
name space traversal for data retrieval.

The Preference Service locates the value of keys by attempting to match a complete key name, for example,
color.car.ext. If it fails to locate the required key, it can create and use progressively smaller sub-keys,
for example color. car, then color.

You can configure a preference to require exact key matching rather than hierarchical name space traversal
using the exactMatch parameter, as described in Configuring Preferences on page 196.

Preference Types

You can configure Oracle Knowledge to access the following types of business data:

» User context data: User context data includes user profile information, such as user name and IP
address.

» Session context data: Session context data includes session-dependent information, such as URLs
and pages visited.

» Question context data: Question context enables the Rules Engine to dynamically set the value of a
configured preference based on information in the user's question.

You can access data using Oracle Knowledge's configured session provider, or using a custom provider that
you configure using the process described in Creating Custom Preferences on page 195.

Session Provider Preferences on page 194 describes the user and session context preferences that are
configured for the Oracle Knowledge Session Provider.

Business Data Providers

Providers are the means of accessing various sources of business data, which can include the web- or
application server hosting the Oracle Knowledge session, as well as external sources of business data, such
as CRM applications.

The Oracle Knowledge session provider is installed and configured with the product. Session Provider
Preferences on page 194 describes the individual preferences that are configured for the session provider.

You can define and configure additional providers using the process described in Creating Custom
Preferences on page 195.

The Context Variables page in the Advanced Configuration Facility allows selection of the following providers,
in addition to Session: Request Attribute, Request Header, and Request Parameter.

The Session Provider

Oracle Knowledge includes a session provider that is installed and configured with the application. The
session provider is designed to access only preference data for a given session; it does not store persistent
preference data for use in multiple sessions.
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Session Provider Preferences on page 194 describes the individual preferences that are configured for
these providers.

Session Provider Preferences

The Session provider is installed and configured with the Oracle Knowledge product. The Session provider
defines the following Preferences that you can include in business conditions:

Preference Description

Request Base URL The Preference Service obtains user data from a Principal object
Request Referer Page | (javax.security.Principal)in the request. The principal
User Host object can be created by:

User IPAddress

User Name e auser agent, as in JSP and ASP pages

« the HTTP request headers, as are present for standard login message
boxes in web browsers

¢ alogin request

« a custom preference handler, as described in Creating Custom
Preferences on page 195

Time (Now) The Preference Service obtains time and date data from the current
Today's Date system time. This data is not stored in the Preference Service.

Creating Custom Providers

You can define and configure custom Providers for the application by:
 Creating a custom provider that implements the Provider application programming interface (API)

* Defining the custom provider to the application, as described in Defining a Provider in the Application
on page 195

» Configuring Preferences to use the provider, as described in Configuring Preferences on page 196
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Defining a Provider in the Application

You define a Provider using the providers map in the application configuration file. The providers map
includes an entry for each provider defined for the application. Providers that are defined in the map are then
available to individual preferences, as described in Configuring Preferences on page 196.

The following example shows the default Session provider configuration in the providers map:

<map name="providers" type="PreferenceProvider" />
<entry name="sessionProvider" type="PreferenceProvider" />

where:

providers Specifies the map that defines the Preference providers. You must
have at least one session provider entry in this list. The Session
provider is defined by default for the application.

sessionProvider Is an entry that refers to the default sessionProvider. Each defined
provider must be specified as an entry in this map.

Creating Custom Preferences

You can define and configure custom business data preferences for the application by:

» Creating a custom Preference that implements the Preference application programming interface (API),
as described in The Provider APl on page 204.

» Adding the Preference to the application, as described in Configuring Preferences on page 196.
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Configuring Preferences

You can configure Preferences for the Preference Service using the Advanced Configuration Facility. The
Preferences page of the Advanced Configuration Facility accesses a preferences map within the application
configuration file that specifies parameters for each defined Preference.

The following example shows the format of the preferences map:

<map name="preferences"
controller="com.inquira.preference.PreferenceController">
<entry name="key" type="string" />

<entry name="traversalType" type="integer" />

<entry name="exactMatch" type="boolean" />

<list name="providers" type="PreferenceProvider" />
<entry name="purpose" type="string" />

<entry name="dataTypeClass" type="string" />

</map>

The Preference parameter elements correspond to the used Preference parameters in the Advanced
Configuration Facility, as described in Adding and Modifying Context Variable Preference Parameters on
page 198.

where:

Key Specifies the key required to access this Preference, for example,
color.car.ext

Traversal Type Specifies how to traverse the hierarchical name space for keys that
contain multiple parts when multiple providers are defined for this
preference. Valid values are:

Names First

Exhaust the name space in the first provider before asking the next
provider

Providers First
Try the full key on all providers before processing sub-keys

Exact Match Is a Boolean value that specifies whether the full key is required to find
the Preference. Valid values are:

¢ On- the full key is required
« Off - the full key is not required

Purpose Specifies whether the Preference is accessible from the Business Rules
module. Specify BusinessCondition to make the Preference
available to the Business Rules module.

Data Type Class Specifies the data type for this Preference, as defined in the Business
Name Condition module. Valid values are:

e Date

e Facet

e Integer
e Real

e String
« Time
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Modifiable by Specifies that the value of the parameter can be changed dynamically by
Search System the Business Condition module. See Chapter A, Configuring Access to
Business Data for more information on creating Business Conditions
that set Preference values based on question context information.

Providers Specifies the Providers that the application can use to access data for
this Preference. You must specify at least one provider to configure a
Preference. The Preference Service processes the list of providers in
the order specified.

Editing Preferences

Create and modify preferences using the Context Variables section of the Advanced Configuration Facility.

To edit preferences, select Context Variables from the Advanced Configuration Facility menu.

The Context Variables Page

The Context Variables page displays the currently defined context variables available to the Business
Condition module. Each context variable corresponds to a configured preference that has a defined purpose
of BusinessCondition.

Displaying the Editable Context Variable List
To display context variables as selectable items, select the Edit button on the Context Variables page.

ORACI_E' Advanced Configuration HELF 2

Editing: Context Variables
0K ! | Cancel |

Variables :

date:today

facet:selected

formevent. COMMON USER SESSION ID
formevent.DEVICE ID
formevent.FIELD ID
formevent.FORM ID
formevent.FORM PAGE INSTAMNCE ID
formevent.FORM VERSION
formevent.PAGE ID

formevent. SECTION ID

formevent. SESSION ID
request.baseURL

request.refererURL

result language

site

time:now

user.address
user.host
user.name
user.segment

Add New Itemn

G o) ol o o) o i i o G G o G G G G G w el o
EEEEEEEEEEEEEEEERERERERE
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The Editing:Context Variables page displays the list of defined context variables as hypertext links, and
displays an Add New Item link. You can select an existing context variable to modify its preference criteria, or
define a new context variable.

Selecting a Context Variable for Editing

You can select an existing context variable to modify its preference criteria, or define a new context variable.
To modify an existing preference, select the corresponding context variable from the list.

To define a new preference and context variable, select Add New Item from the list.

ORACI_E' Advanced Configuration HELP )

Editing: Context Variables > Variables

Item Name b formevent.BAGE_ID

Key b |formevent.PAGE_ID
Traversal Type p | Nzmes First
ExactMatch : @on Cioff

Purpose : |Business Condition

K El

Data Type Class :

Naie String

Modifiable by : -
Search System Don ®Off

Providers :
1. Providers : | Request Parameter El

Add New Itemn

The Editing:Context Variables:Variables page displays fields that define the preference for the selected
variable.

Adding and Modifying Context Variable Preference Parameters

You can use the fields on the Editing:Context Variables:Variables page to add or modify preference
parameters for the selected context variable.

1 Specify values for the parameters, as described in Configuring Preferences on page 196.

2 Click OK to update the application configuration.
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The Preference API

You can create a preference handler by implementing the Preference API. The Preference API is defined in
com. inquira.preference.PreferenceService. Itincludes the following methods:

e The getPreference Method on page 199

The getExternalString Method on page 199

The getExternalCode Method on page 200

The getPreferenceValue Method on page 200

The SetPreferenceValue Methods on page 200

The rundown Method on page 202

The getPreferences Method on page 203

The getPreferenceKeys Method on page 203

The getPreference Method

Method: getPreference

Syntax: public Preference
getPreference(java.lang.String key)

where:

key Specifies the preference name

Description: This method retrieves the preference definition for a key from the
configuration service. If the preference has not been defined, a dynamic
preference object is created and returned.

Returns: The Preference object that corresponds to the requested key

The getExternalString Method

Method: getExternalString

Syntax: public java.lang.String
getExternalString(java.lang.String key)

where:

key Specifies the preference name

Description: This method returns the string representation of the preference value as
defined by an external provider.

Returns: Returns the string value for the specified preference
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The getExternalCode Method

Method: getExternalCode

Syntax: public java.io.Serializable
getExternalCode (java.lang.String key)

where:

key Specifies the preference name

Description: This method returns the native form of the preference value as defined by
the provider. This can be null if no key access using this preference value is
required that is based not on the external string.

Returns: The code value for specified preference

The getPreferenceValue Method

Method: getPreferenceValue

Syntax: public PreferenceValue
getPreferencevValue (java.lang.String key)

where:

key Specifies the preference name

Description: This method returns the PreferenceValue object that corresponds to
this key.

Returns: The preference value

The SetPreferenceValue Methods

There are several setPreferenceValue methods within the Preference API. The various
setPreferenceValue methods use various combinations of key, value, code, string, and
preference parameters.

Method: setPreferenceValue

Syntax: public PreferenceValue
setPreferenceValue (java.lang.String key,
java.lang.String value)

where:

key Specifies the preference name

value Specifies the string value

Description: This method returns the PreferenceValue object that corresponds to
this key.

Returns: The updated PreferenceValue object
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Method: setPreferenceValue

Syntax: public PreferenceValue
setPreferenceValue (java.lang.String key,
java.io.Serializable code)

where:

key Specifies the preference name

Description: This method sets the code for the preference to the code argument, the
string value to code . toString ( ) with the given key, and returns the
updated PreferenceValue object. If no preference with this key exists, it
creates a new preference using only the session preferences.

Returns: The updated PreferenceValue object

Method: setPreferenceValue

Full Name: public PreferenceValue
setPreferenceValue (Preference preference,
java.lang.String value)

where:

key Specifies the key value

value Specifies the string value

Description: This method sets the value for the preference with the given key and returns
the updated PreferenceValue object. If no preference with this key
exists, it creates a new preference using only the session preferences.

Returns: The updated PreferenceValue object

Method: setPreferenceValue

Syntax: public PreferenceValue
setPreferenceValue (Preference preference,
java.lang.String value, java.io.Serializable code)

where:

preference Specifies the preference

value Specifies the string value

code Specifies the code value

Description: This method sets the value and code for the preference with the given
preference and returns the updated PreferenceValue object. If no
preference with this key exists, it creates a new preference using only the
session preferences.

Returns: The updated PreferenceValue object

Method: setPreferenceValue
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Syntax: public PreferenceValue
setPreferenceValue (java.lang.String key,
java.lang.String value, java.io.Serializable code)

where:

value Specifies the string value

code Specifies the code value

Description: This method sets the value and code for the preference with the given key
and returns the updated PreferenceValue object. If no preference with
this key exists, it creates a new preference using only the session
preferences.

Returns: The updated PreferenceValue object

Method: setPreferenceValue

Syntax: public PreferenceValue
setPreferenceValue (PreferenceValue value)

where:

value Specifies the preference value

Description: This method sets the value for the preference with the given key and returns
the passed PreferenceValue object. If no preference with this key
exists, it creates a new preference using only the session preferences.

Returns: The updated PreferenceValue object

The rundown Method

Method: rundown

Syntax: public void rundown () throws TransportException

Description: The rundown method is called after every completion of a request from the
Execution.rundown () method.

Throws: TransportException

Refer to rundown() in the JavaDoc documentation for more information.
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The getPreferences Method

Method: getPreferences
Syntax: public java.util.Collection getPreferences /()
Description: This method retrieve a list of all defined preferences. The returned list

contains Preference objects.

Returns: A list of all Preference objects.

The getPreferenceKeys Method

Method: getPreferenceKeys
Syntax: public java.util.Collection getPreferenceKeys ()
Description: This method retrieve a list of all defined preference keys. The returned list

contains String objects.

Returns: A list of all String objects

ORACLE KNOWLEDGE INTELLIGENT SEARCH OPTIMIZATION GUIDE ORACLE



204 THE PROVIDER API

The Provider API

You can create a custom provider to access business data by implementing the Provider API. Providers must
extend the class com. inquira.preference.AbstractProvider, which includes the following
methods:

e The Provider Default Constructor on page 204
» The getType Method on page 204

» The get Methods on page 205

» The set Method on page 206

» The toString Method on page 206

e The Provider rundown Method on page 206

The Provider Default Constructor

Method: AbstractProvider

Syntax: public AbstractProvider ()

Description: Specifies the default constructor. A default constructor is required so that
the class can be loaded dynamically.

The getType Method
Method: getType
Description: This method should not be overridden. The static String variable type
should be initialized in a static initializing code block. For example:
static {type = ‘my type’}
Returns: The provider type as a string
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The get Methods

There are two get methods within the Provider API; a namespace hierarchy traversal method, and a non-

traversal method.

Name: get

Syntax: public PreferenceValue get (java.lang.Stringkey, byte
depth, byte traversalDepth)

where:

key Specifies the preference name

depth Specifies the number of elements in the key

traversalDepth

Specifies the number of elements that can be removed from the key to
create sub-keys

Description:

This method retrieves the value that corresponds to the key argument within
this provider. The number of key elements is specified by the depth
parameter.

This function traverses the namespace hierarchy for the key by attempting
to locate sub-keys if the full key location fails. Sub-keys are created by
removing the final key element; for example:

color.car.ext -> color.car -> color

You can limit namespace traversal by specifying a traversal depth argument.
This argument specifies the number of key elements that can be removed to
create sub-keys. For example:

key = color.car.ext
depth = 3
traversalDepth = 1

specifies that the only valid keys are color.car.ext and color.car.

get is dependent on the get (String) method, which must be
implemented by all subclasses. This method does not have to be overridden
in custom providers unless the functionality is not required.

Returns:

Method:

a PreferenceValue object with the appropriate values set

null if no match is found

get

Syntax:

protected abstract PreferenceValue
get (java.lang.String key)

where:

key

Specifies an exact key name
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Description: This abstract method is called by get (String, byte, byte) to find the
value for a given key. This method does not create and match sub-keys to
traverse the key namespace; it only checks for an exact key match. This
method must be defined by all provider classes and must implement the
specific functionality for this provider.

Returns: » the PreferenceValue object, if it locates the exact key

* null, if it does not locate the exact key
The set Method

Method: set

Syntax: protected abstract boolean
set (java.lang.String key, PreferenceValue value)

where:

value Specifies the preference value

Description: This abstract method sets the value for the implied preference of the value
object.

Returns: The preference value

The toString Method

Method: toString

Syntax: public java.lang.String toString()

Description: This method returns information about the provider that can be useful for
debugging.

Overrides: toStringinthe class java.lang.Object

Returns: Information about the provider

The Provider rundown Method

Method: rundown
Syntax: public abstract void rundown ()
Description: This method is called when the preference services’ rundown method is

called. This method should store and retain preference values for this
provider.
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